EPIC™ MV

IP Multiviewer

1.1

June 2017
Publication Information

© 2017 Imagine Communications Corp.
Proprietary and Confidential.

Imagine Communications considers this document and its contents to be proprietary and confidential. Except for making a reasonable number of copies for your own internal use, you may not reproduce this publication, or any part thereof, in any form, by any method, for any purpose, or in any language other than English without the written consent of Imagine Communications. All other uses are illegal.

This publication is designed to assist in the use of the product as it exists on the date of publication of this manual, and may not reflect the product at the current time or an unknown time in the future. This publication does not in any way warrant description accuracy or guarantee the use for the product to which it refers. Imagine Communications reserves the right, without notice to make such changes in equipment, design, specifications, components, or documentation as progress may warrant to improve the performance of the product.

Trademarks

Platinum™ and EPIC™ MV are trademarks or trade names of Imagine Communications or its subsidiaries.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation. All other trademarks and trade names are the property of their respective companies.

HPE Copyright

ii. Hewlett Packard Enterprise Company, L.P. makes no warranty as to the accuracy or completeness of the foregoing material and hereby disclaims any responsibility therefore.

Contact Information

Imagine Communications has office locations around the world. For domestic and international location and contact information, visit our Contact page (http://www.imaginecommunications.com/how-buy/contact-us).

Support Contact Information

For domestic and international support contact information see:

- Support Contacts (http://www.imaginecommunications.com/how-buy/contact-us)
- Worldwide Support e-mail (mailto: service@imaginecommunications.com)
- Customer Community Portal (http://app.imaginecommunications.com/customercommunity)
- Warranty & Contract Information (http://www.imaginecommunications.com/services/customer-care)
- MyImagine Academy Training (http://www.imaginecommunications-academy.com)
- Product Manuals (http://www.imaginecommunications.com/services/product-manuals)
Contents

Preface ................................................................................................................................. 10
  Manual Information ........................................................................................................... 10
  Purpose ............................................................................................................................... 10
  Audience ............................................................................................................................ 10
  Obtaining Documents ....................................................................................................... 10

Unpacking/Shipping Information ...................................................................................... 10

Safety Standards and Compliances .................................................................................. 11
  Safety Terms and Symbols ............................................................................................... 11
  Restriction on Hazardous Substances (RoHS) Directive ................................................... 11
  Waste from Electrical and Electronic Equipment (WEEE) Directive ............................... 12

Safety Guidelines ............................................................................................................... 12
  Electrical Safety Guidelines ............................................................................................. 13
  General Safety Guidelines ............................................................................................... 14
  Electrostatic Discharge ..................................................................................................... 14

Introduction ....................................................................................................................... 16
  Features ............................................................................................................................. 16
    PIP Sharing ....................................................................................................................... 17

Hardware ............................................................................................................................. 17
  Front Panel ......................................................................................................................... 17
  Back Panel ......................................................................................................................... 19

Packing List ......................................................................................................................... 21
  Purchasing Options .......................................................................................................... 21

Required and Recommended Hardware and Software Control Options ......................... 28
  Magellan™ SDN Orchestrator (SDNO) ........................................................................... 28
  Layout Designer ............................................................................................................... 28
  CCS Navigator and Magellan Remote Control Systems ................................................... 29
  Open API .......................................................................................................................... 29

Installation ........................................................................................................................... 30
  System Setup ..................................................................................................................... 30
  Optimum Environment ...................................................................................................... 30
  Rack Mounting EPIC™ MV .............................................................................................. 32
Install the Server into the Rack .................................................................................. 33
Extend the Server from the Rack ................................................................................ 34
Remove the Server from the Rack ............................................................................. 34
Adding and Removing Hardware Components ............................................................ 35
Remove the Access Panel .......................................................................................... 35
Install the Access Panel ............................................................................................. 35
Remove the Hot-plug Fan .......................................................................................... 35
Riser Cage Assemblies .............................................................................................. 36
Input and Display Board Installation to EPIC™ MV Chassis ...................................... 39
Hot-plug Hard Drives ................................................................................................ 47
Install a Hot-plug SAS or SATA Drive ........................................................................ 47
Remove a Hot-plug SAS or SATA Drive ...................................................................... 48
Making System Connections ..................................................................................... 49
SFP Removal ................................................................................................................ 49
Connecting Multiple EPIC™ MVs ............................................................................. 51
Connecting to the PIP Sharing Network .................................................................... 51
Making SDI Connections ........................................................................................... 54
Using Compressed Video ........................................................................................... 54

HPE Server Configuration and Operation ..................................................................... 57
Power Up the Server ................................................................................................... 57
Power Down the Server .............................................................................................. 57
Join a Domain .............................................................................................................. 58
System Recovery .......................................................................................................... 59
Capture the WIM Image .............................................................................................. 59
Prevent Damage and Malfunction ............................................................................ 60
Anti-Virus, Monitoring, & Third-Party Software ......................................................... 60
Operating System Updates ......................................................................................... 61
Automatic Updates ...................................................................................................... 61
BIOS Settings .............................................................................................................. 62
iLO Setup .................................................................................................................... 62
Server Management Network ..................................................................................... 63
Logging into iLO (Server Management Network) ......................................................... 63
Using the iLO Web Interface ....................................................................................... 64

EPIC™ MV Configuration and Control ...................................................................... 76
Starting and Stopping the EPIC MV ........................................................................... 76
Updating Software and Firmware ................................................................................ 77
Determining Software and Firmware Versions ............................................................ 77
Updating Multiviewer Software and Firmware .......................................................... 77
Update Layout Designer Software ................................................................. 78
NVIDIA Display Configuration ........................................................................ 79
OS View ........................................................................................................ 79
Updating nVidia Drivers ............................................................................... 79
Forcing VGA on EPIC™ MV with no VGA Cable Connected ....................... 80
SDN Orchestrator Configuration and Control ............................................... 81
Adding a Switch as a Device ......................................................................... 82
Adding Destinations ..................................................................................... 83
Adding Sources for your Channels ............................................................... 84
Switching Sources to Destination PIPs ......................................................... 85
Adding Multiviewers to a Router Database ................................................ 87
Adding Output Modules by Polling ............................................................... 87
Configuring Multiviewers in Database Editor ............................................. 88
Configuring Salvos for use in Layout Designer ........................................... 89
Configuring Multiviewers in a Local Area Network .................................... 90
Discovering EPIC™ MV Using Layout Designer ......................................... 90
Connecting to SDNO ................................................................................... 92
Controlling Your Multiviewer on a Network ................................................ 93
Parameters and Alarms ................................................................................ 93
Configuring JLCooper eBOX in Layout Designer ......................................... 99
Configuring the Multiviewer to share JLCooper eBoxes ............................. 100
Configuring Multiple Multiviewers to Multiple JLCooper eBoxes.............. 101
Assigning Input and Output Triggers in Layout Designer ............................ 101

Software Installation ................................................................................... 103
Layout Designer Minimum System Requirements ..................................... 103
Installing Layout Designer .......................................................................... 103
To install the Layout Designer software .................................................... 103
Closing Layout Designer ............................................................................. 104

Initial Layout Designer Configuration ....................................................... 106
When No Multiviewers are Connected ....................................................... 106
Device Manager Dialog Box ........................................................................ 106
Adding Devices Manually ......................................................................... 107
Advanced Configuration ............................................................................. 108
Configuring EPIC MV Output Display Devices .......................................... 109
Connecting to SDNO Controller ................................................................. 111
Setting Up External Devices ...................................................................... 111
Getting Version Information .................................................................... 114
Configuring Network Time Protocol (NTP) ................................................ 114
Enabling Alarm Logging ................................................................. 115
Performance Meters ...................................................................... 115

Layout Designer Workspace .......................................................... 116
Application Menus .......................................................................... 117
Layout Designer Application Toolbar .............................................. 123
Tools Palette .................................................................................. 125
Layout Canvas ................................................................................ 127
Multividers Panel ........................................................................... 127
  Multividers Panel Context Menu and Toolbar ............................... 128
Library Panel .................................................................................. 129
Properties Pane .............................................................................. 130
About Layout Objects ...................................................................... 131
Layout Designer Context Menu ....................................................... 133
Customizing the Layout Designer Workspace .................................... 136
  Setting Panels and Panes Viewing Options .................................. 136
  Panning and Zooming in the Canvas Workspace .......................... 137
  Saving and Loading Configuration Files ...................................... 138
Setting Your Layout Designer Preferences ....................................... 138
  Setting General Preferences ....................................................... 139
  Setting Default Layout Properties .............................................. 140
  Setting Default Window Properties ............................................ 142
  Setting Default PIP Properties ................................................... 143
  Setting Default Label Properties .............................................. 146
Using the Layout Designer Library Panel ....................................... 147
  Adding Objects to the Library Panel .......................................... 147
  Using Objects from the Library Panel ........................................ 148

Working with Layouts .................................................................... 150
Creating New Layouts .................................................................... 151
  Layout Creation Workflows ...................................................... 152
  Creating a New Layout Using the Layout Creation Wizard .......... 152
  Creating a New Layout from a Blank Layout .............................. 158
Locking and Unlocking Layouts ...................................................... 159
Saving Layouts ............................................................................ 159
Opening Layouts .......................................................................... 160
Viewing Layouts .......................................................................... 160
Connecting Layout Designer to a Multiviewer ............................... 162
  Disconnecting Layout Designer from a Multiviewer ................. 162
Displaying and Publishing Layouts ............................................... 163

© 2017 Imagine Communications Corp. Proprietary and Confidential.
Displaying and Opening Layouts Stored on the Multiviewer .............................................. 163
Publishing Modified Layouts ............................................................................................ 164
Publishing Layouts From Layout Files ............................................................................ 164
Layout Properties ........................................................................................................... 165
Viewing Layout Properties ............................................................................................. 165
Modifying Layout Properties ......................................................................................... 165

Working with Layout Objects ......................................................................................... 169
Layout Object Properties .............................................................................................. 171
Adding Layout Objects to a Layout ................................................................................ 171
Formatting Layout Objects in the Canvas ...................................................................... 174
  Copying and Pasting Layout Object Properties ............................................................ 174
  Cloning Layout Objects ............................................................................................... 175
  Resizing and Moving Layout Objects Using a Mouse .................................................. 175
Working With Groups of Objects .................................................................................. 176
  Setting Like Objects’ Properties ................................................................................... 177
  Removing Like Objects from Control for a Group of Windows ................................. 177
  Aligning and Distributing Objects in a Layout ............................................................ 177
Creating Layout Windows ............................................................................................. 179
  Creating New Windows ............................................................................................... 180
  Breaking Apart a Window ........................................................................................... 181
  Consolidating a Window ............................................................................................. 181
  Modifying Window Properties Using the Properties Pane ......................................... 181
Modifying Border Properties ......................................................................................... 183
  Selecting a Border for Modification Within a Window ................................................. 183
  Applying Borders Using the Properties Pane ............................................................... 183
  Modifying Borders Using the Properties Pane ............................................................ 184
  Creating New Border Styles ......................................................................................... 185

Working with PiPs ........................................................................................................... 188
Adding PiPs to a Layout ................................................................................................. 189
Modifying PiPs Using the Properties Pane .................................................................... 189
  Modifying PiP Size and Aspect Ratio ......................................................................... 190
  Setting PiP Cropping Values ....................................................................................... 192
  Selecting a PiP’s Input Source ..................................................................................... 192
  Moving a PiP Using the Properties Pane ..................................................................... 198
  Defining PiP Names ..................................................................................................... 198

On-Screen Data Tools .................................................................................................... 200
Creating Audio Meters ................................................................................................. 201
Adding Audio Meters to a Layout ................................................................. 202
Mapping Audio Meters ........................................................................... 202
Setting Audio Meter Appearance Properties ......................................... 203
Creating Tally Indicators ....................................................................... 204
Adding Tally Indicators to a Layout ........................................................ 205
Modifying Tally Indicator Properties ....................................................... 205
About Labels ............................................................................................. 208
Setting the Label Text Source .................................................................. 208
Modifying Label Appearance Properties ................................................ 210
Modifying Label Size and Position Properties ........................................ 211
Activating and Modifying Scrolling Properties ........................................ 211
About Layout Clocks ................................................................................ 212
Adding Clocks to a Layout ...................................................................... 212
Modifying Clock Properties .................................................................... 212
About Up/Down Counters ...................................................................... 215
Adding Counters to a Layout .................................................................. 216
Modifying Counter Properties ................................................................ 216
Manually Controlling a Counter ............................................................... 218
Controlling a Counter Using SNMP or Magellan Control Panel .......... 218

Alarms and Info Panels ........................................................................... 219
Monitoring Tools .................................................................................... 219
Alarms and the Events that Trigger Them ................................................ 220
Configuring Global Alarms ...................................................................... 235
Configuring Layout Events and Global Events ....................................... 238
Info Panels .............................................................................................. 240
Adding Info Panels to a Layout ............................................................... 240
Modifying Info Panel Properties ............................................................. 241
Using the Scoreboard Option .................................................................. 246
Setting Info Panel Metadata Options ...................................................... 247
Configuring Audio Monitoring ................................................................. 254
Configuring Dolby E Monitoring .............................................................. 254

FAQs .......................................................................................................... 261
How Do I Access the Components Within my PiP? .............................. 261
Can I Store and Recall PiP Properties? ..................................................... 261
Why Can’t I Close All the Layouts? ........................................................... 261
What is the Behavior of the Undo Feature? .............................................. 262

Using the Multiviewer Web Interface ...................................................... 263
Starting the Multiviewer Web Interface........................................................................ 263
Controlling User Access to the Multiviewer Web Interface............................................... 264
Choosing a Layout.............................................................................................................. 266
Changing PiP Sources in a Layout.................................................................................... 266
Importing and Editing Label Text.................................................................................... 267
Editing Label Text Manually............................................................................................ 268

**UMD/Tally Option** ........................................................................................................ 269
Requirements for Optional UMD Support....................................................................... 269
Configuring UMD Data ..................................................................................................... 269
Configuring TSL ASCII UMD Protocol........................................................................... 270
Configuring Image Video UMD Protocol.......................................................................... 271
Configuring TSL v3, v4, and v5 over TCP/IP................................................................... 272

**Troubleshooting** .......................................................................................................... 273
Making a Snapshot of your Outputs................................................................................ 273
Network Adapter Shows DHCP....................................................................................... 273
Performance Issues While Remote Monitoring iLO.......................................................... 274
Could not Set Process Affinity Mask Error....................................................................... 274

**Specifications** ............................................................................................................. 275
Environmental Specifications .......................................................................................... 275
EPIC-MV-DISP Specifications ......................................................................................... 276
Server Specifications ...................................................................................................... 276
Power Supply Specifications............................................................................................ 277
  HPE 800W Flex Slot Platinum Hot-plug Power Supply .................................................. 277
  Hot-plug Power Supply Calculations ............................................................................ 277
EPIC-MV-UCIP Specifications ........................................................................................ 278
SFP Interfaces .................................................................................................................. 278
  OP+SFP+TRSM+10G .................................................................................................... 278
  OP+SFP+TRMM+10G .................................................................................................. 279
  SEL+AOC+10G ............................................................................................................ 280
EPIC-MV-3G Specification ............................................................................................. 281

**Index** .......................................................................................................................... 282
Preface

Manual Information

Purpose

This manual details the features, operations, and specifications of your EPIC MV system.

Audience

This manual is written for engineers, technicians, and operators responsible for the system setup.

Obtaining Documents

Imagine Communications EPIC™ MV systems are based on Hewlett Packard Enterprise's ProLiant DL380 Gen9 server. To obtain documentation for your system, please note the following.

- Documentation specific to your Imagine Communications configured product is provided by Imagine Communications, such as detailed quick specs and this hardware manual.
  To access this documentation, go to https://imaginecommunications.box.com/s/rwzbgbhw3suhf8o2e30dmfk1xicdbr.
- Standard documentation for the base unit is available from Hewlett Packard Enterprise, such as rack mounting steps and system service and maintenance information.
- Imagine Communications documents can be viewed or downloaded from the Imagine Communications website at http://support.imaginecommunications.com. Alternatively, contact your customer service representative to request a document.

Unpacking/Shipping Information

Your system has been carefully inspected, tested, and calibrated prior to shipment to ensure years of stable and trouble free service.

Before you setup your EPIC MV system, follow these steps:

1. Check equipment for any visible damage that may have occurred during transit.
2. Confirm that you have received all items listed on the packing list.
3. Contact your sales representative if any parts are missing.
4. Contact the carrier if any item is damaged.
5. Remove all packaging material from the product and its associated components before you install the unit.

Keep at least one set of original packaging, in the event that you need to return a product for servicing. If the original packaging is not available, you can purchase replacement packaging at a modest cost or supply your own packaging as long as it meets the following criteria:

- The packaging must be able to withstand the weight of the product.
- The product must be held rigid within the packaging.
- There must be at least two inches (5 cm) of space between the product and the container.
- The corners of the product must be protected.

## Safety Standards and Compliances

### Safety Terms and Symbols

This manual uses the following safety terms and symbols to identify certain conditions or practices.

#### Safety Terms and Symbols

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td><strong>WARNING:</strong> Identifies conditions or practices that can result in personal injury or loss of life—high voltage is present. Uninsulated dangerous voltage within the product’s enclosure may be sufficient to constitute a risk of electric shock to persons.</td>
</tr>
</tbody>
</table>

| 🚨 | **CAUTION:** Identifies conditions or practices that can result in damage to the equipment or other property. Important operating and maintenance (servicing) instructions are included in the literature accompanying the product. |

### Restriction on Hazardous Substances (RoHS) Directive

Directive 2002/95/EC – commonly known as the European Union (EU) Restriction on Hazardous Substances (RoHS)—sets limits on the use of certain substances found in electrical and electronic equipment. The Directive took effect on July 1, 2006, and it refers to the following hazardous substances:

- Lead (Pb)
- Mercury (Hg)
- Cadmium (Cd)
- Hexavalent Chromium (Cr-V1)
- Polybrominated Biphenyls (PBB)
- Polybrominated Diphenyl Ethers (PBDE)
All relevant Imagine Communications products either comply with the legislation or are exempt. For example, spare parts supplied for the repair and upgrade of equipment sold before July 1, 2006 are exempt from the legislation.

---

**Waste from Electrical and Electronic Equipment (WEEE) Directive**

The European Union (EU) Directive 2002/96/EC on Waste from Electrical and Electronic Equipment (WEEE) deals with the collection, treatment, recovery, and recycling of electrical and electronic waste products. The objective of the WEEE Directive is to assign the responsibility for the disposal of associated hazardous waste to either the producers or users of these products. Producers or users are required to recycle electrical and electronic equipment at end of its useful life, and must not dispose of the equipment in landfills or by using other unapproved methods.

In accordance with this EU Directive, Imagine Communications has affixed labels indicating that such products must be properly recycled. Contact your local Imagine Communications sales representative for information on returning these products for recycling. Imagine Communications equipment that complies with the EU directive will be marked with a WEEE-compliant symbol, as shown below.

---

**Safety Guidelines**

This unit is for use in restricted access only. Adhere to the following safety guidelines to avoid personal injury or damage to your system.
Electrical Safety Guidelines

Power Cords

WARNING
To avoid electrical shock, check the power cords properly.

• Use the exact type of power cords as required.
• Be sure to use power cord(s) that came with safety certifications.
• The power cord(s) must be compliant with the AC voltage requirements in your region.
• The power cord plug cap must have an electrical current rating that is at least 125% of the electrical current rating of this product.
• The power cord plug cap that plugs into the AC receptacle on the power supply must be an IEC 320, sheet C13, type female connector.
• Be sure to disconnect the power supply before accessing the EPIC MV chassis or its components.
• Plug the Power cord(s) into a socket that is properly grounded before turning on the power.

General Electrical Safety Guidelines

WARNING
Adhere to the following Electrical Safety Guidelines to avoid possible damages to the system or injury to yourself.

• Be aware of the locations of the power switches on the chassis and in the room, so you can disconnect the power supply if an accident occurs.
• Take extra precautionary measures when working with high voltage components. It is not recommended to work alone.
• Before removing or installing main system components, be sure to disconnect the power first. Turn off the system before you disconnect the power supply.
• Use only one hand when working with powered-on electrical equipment to avoid possible electrical shock.
• Use rubber mats specifically designed as electrical insulators when working with computer systems.
• The power supply or power cord must include a grounding plug and must be plugged into grounded outlets.
• Motherboard Battery: CAUTION – Make sure not to install the onboard battery upside down to avoid possible explosion. Make sure that the positive side should be facing up on the motherboard. This battery must be replaced only with the same or an equivalent type recommended by the manufacturer. Dispose of used batteries according to the manufacturer's instructions.
General Safety Guidelines

**WARNING**
Adhere to the following General Safety Guidelines to ensure your personal safety.

- Keep the area around the EPIC MV chassis clean and free of clutter.
- To avoid injuries to the back, be sure to use your leg muscles, keep your back straight, and bend your knees, when lifting the system.
- Avoid wearing loose clothing to prevent it from coming into contact with power circuits.
- After removing the components or chassis covers from the system, place them on a table for safeguard.
- Be sure to remove any jewelry or metal objects before working on the chassis to avoid short circuits should these objects come into contact with power circuits.
- After accessing the interior of the chassis, be sure to close the chassis with chassis covers and secure the chassis to the racks with screws.

Electrostatic Discharge

Preventing Electrostatic Discharge

**WARNING**
To prevent damaging the system, be aware of the precautions you need to follow when setting up the system or handling parts. A discharge of static electricity from a finger or other conductor may damage system boards or other static-sensitive devices. This type of damage may reduce the life expectancy of the device.

To prevent electrostatic damage:

- Avoid hand contact by transporting and storing products in static-safe containers.
- Keep electrostatic-sensitive parts in their containers until they arrive at static-free workstations.
- Place parts on a grounded surface before removing them from their containers.
- Avoid touching pins, leads, or circuitry.
- Always be properly grounded when touching a static-sensitive component or assembly.

Grounding Methods to Prevent Electrostatic Discharge

Several methods are used for grounding. Use one or more of the following methods when handling or installing electrostatic-sensitive parts:

- Use a wrist strap connected by a ground cord to a grounded workstation or computer chassis. Wrist straps are flexible straps with a minimum of 1 megohm ±10 percent resistance in the ground cords. To provide proper ground, wear the strap snug against the skin.
- Use heel straps, toe straps, or boot straps at standing workstations. Wear the straps on both feet when standing on conductive floors or dissipating floor mats.
• Use conductive field service tools.
• Use a portable field service kit with a folding static-dissipating work mat.

If you do not have any of the suggested equipment for proper grounding, have an authorized reseller install the part.
Introduction

EPIC™ MV is a software-based, UHD-ready multiviewer that provides broadcasters with a single canvas for mixed IP/Baseband signal types with a seamless transition path to an all-IP future. Based on Imagine Communications’ open and extensible Zenium™ platform, EPIC MV is scalable to thousands of PIPs and hundreds of displays, providing a high-quality, low-TCO monitoring solution.

EPIC™ MV is a complete multiviewer solution that offers the full features of a class-leading multi-image display system including exceptional video quality, rich graphics, tally, UMD, timers, clocks and interfaces to a variety of third-party systems. EPIC MV delivers all the capabilities expected for monitoring and monetizing content in high value production environments.

Designed to simplify monitoring environments as broadcasters migrate to IP, EPIC MV is a true hybrid solution that natively supports high-bandwidth uncompressed content as well as low-bandwidth compressed streaming formats, including MPEG-2 and H.264/AVC. Option cards provide for 2022-6/7 reception as well as high-capacity baseband 3G/HD/SD.

Features

EPIC™ MV has the following features:

- 48x SD/HD ST 2022-6/7 inputs (option)
- 48x SD/HD channels over SDI input, alternatively 24x 3G channels over SDI input (option)
- 1x UHD or 4 HD displays (independent control with landscape, portrait and cloning support)
- MPEG-2/H.264 distribution decode (option)
- MPEG, AAC, and AC3 metering and Dolby metadata (limit 3 services per channel -- standard)
- Strong tally/UMD support
- Advanced rules engine and alarming
- Inter-device PIP sharing: up to 24x receive and 24x transmit per host)
- Clock and timer support
- Advanced metadata decoding including captioning, AFD/WSS
- GPIO (option)
- VNC client in a PIP
- Open 3rd party API
- Magellan control panel support
- SDNO control of both UCIP and CIP (compressed) EPIC PiP destinations
- Control and status monitoring over a web API
- AC-3/E-AC3 metering
- Mixed workflows
**PIP Sharing**

When an input is used multiple times within a screen or series of screens output by a single EPIC-MV, this is referred to as a PIP copy and is local to a specific multiviewer. When one multiviewer is configured to send some of its inputs to the sharing network, this is referred to as a PIP share.

PIP sharing allows other EPIC™ MV units to display signals without needing local optional input boards. PIP sharing uses the integrated 10 Gbe NICs and allows you to aggregate PIPs from other remote units.

To configure PIP sharing, see [Connecting to the PIP Sharing Network](on page 51).

---

**Hardware**

**Front Panel**

The following information describes the front panel components for EPIC MV systems.

**Front View**

![Front View of EPIC MV System]

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>quick removal access panel</td>
</tr>
<tr>
<td>2</td>
<td>top-to-bottom:</td>
</tr>
<tr>
<td></td>
<td>• power on/standby button and system power LED button</td>
</tr>
<tr>
<td></td>
<td>• health LED</td>
</tr>
<tr>
<td></td>
<td>• NIC status</td>
</tr>
<tr>
<td></td>
<td>• UID LED</td>
</tr>
<tr>
<td>3</td>
<td>OS drives formatted as RAID 1 (mirrored)</td>
</tr>
<tr>
<td>4</td>
<td>serial label pull tab</td>
</tr>
<tr>
<td>5</td>
<td>USB 3.0 connector</td>
</tr>
</tbody>
</table>
Front LEDs and Buttons

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power On/Standby button and system power LED*</td>
<td>Solid green = System on&lt;br&gt;Flashing green (1 Hz/cycle per sec) = Performing power on sequence&lt;br&gt;Solid amber = System in standby&lt;br&gt;Off = No power present**</td>
</tr>
<tr>
<td>2</td>
<td>Health LED*</td>
<td>Solid green = Normal&lt;br&gt;Flashing green (1 Hz/cycle per sec) = iLO is rebooting.&lt;br&gt;Flashing amber = System degraded&lt;br&gt;Flashing red (1 Hz/cycle per sec) = System critical†</td>
</tr>
<tr>
<td>3</td>
<td>NIC status LED*</td>
<td>Solid green = Link to network&lt;br&gt;Flashing green (1 Hz/cycle per sec) = Network active&lt;br&gt;Off = No network activity</td>
</tr>
<tr>
<td>4</td>
<td>UID button/LED*</td>
<td>Solid blue = Activated&lt;br&gt;Flashing blue:&lt;br&gt;• 1 Hz/cycle per sec = Remote management or firmware upgrade in progress&lt;br&gt;• 4 Hz/cycle per sec = iLO manual reboot sequence initiated&lt;br&gt;• 8 Hz/cycle per sec = iLO manual reboot sequence in progress&lt;br&gt;Off = Deactivated</td>
</tr>
</tbody>
</table>

*When all four LEDs described in this table flash simultaneously, a power fault has occurred. For more information, see Power Fault LEDs (on page 18).

**Facility power is not present, power cord is not attached, no power supplies are installed, power supply failure has occurred, or the power button cable is disconnected.

†If the health LED indicates a degraded or critical state, review the system IML or use iLO to review the system health status.

Power Fault LEDs

The following table provides a list of power fault LEDs, and the subsystems that are affected. Not all power faults are used by all servers.
### Back Panel

The following information details the back panel components for a maximum configuration system. For information on the options shown, see [Purchase Options](#).

### Back View

The following back panel components that are marked with an asterisks (*) are purchase options. These options are not included with all system models. Back panel views will vary depending on the model and options purchased.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1*, 2*, 3*, 6*</td>
<td>These four slots can contain either EPIC-MV-UCIP input card or EPIC-MV-3G input card. See <a href="#">Input Cards</a> (on page 22).</td>
</tr>
<tr>
<td>4</td>
<td>EPIC-MV-DISP, connectors numbered from right to left 1/2/3/4. Connectors 1 and 2 are UHD-capable, while connectors 3 and 4 can deliver video up to 1080p. See <a href="#">EPIC-MV-DISP Display Output Card</a> (on page 26).</td>
</tr>
<tr>
<td>5</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>7</td>
<td>Local RS-232 for serial tally connections.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>8, 9</td>
<td>Power supply LEDs.</td>
</tr>
<tr>
<td>10 *</td>
<td>LAN on Motherboard (reserved)</td>
</tr>
<tr>
<td>11</td>
<td>unit ID LED</td>
</tr>
<tr>
<td>12</td>
<td>USB 3.0 connectors x 2 for keyboard, mouse, etc. as required</td>
</tr>
<tr>
<td>13</td>
<td>Dedicated iLO connector for integrated remote KVM over IP, where you can go into the BIOS for Server Management Network which controls interface, fans, etc. See HPE Server Configuration and Operation (on page 57)</td>
</tr>
<tr>
<td>14</td>
<td>Embedded 4 x 1GbE copper network adapter (left to right: NIC connector 1, 2, 3, 4). The first is primary management NIC, which will provide Layout Designer, SDNO etc., GPIO from eBOX, and possibly some tally and other network data. Connectors 2, 3, and 4 can provide low-end stream reception (i.e., compressed video), tally, UMD, Selenio content, and other third-party data. See Configuring JLCooper eBOX in Layout Designer (on page 99) and UMD/Tally Option (on page 269).</td>
</tr>
<tr>
<td>15</td>
<td>VGA connector for console display</td>
</tr>
<tr>
<td>16</td>
<td>Power supply 1</td>
</tr>
<tr>
<td>17, 19</td>
<td>Power supply connections</td>
</tr>
<tr>
<td>18</td>
<td>Power supply 2</td>
</tr>
</tbody>
</table>

### Back Panel LEDs

Note that back panel views will vary depending on the options purchased. For details see Back View.

The LEDs labeled in the following image are available on all EPIC™ MV models.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>UID LED</td>
<td>Solid blue = Identification is activated. Flashing blue = System is being managed remotely. Off = Identification is deactivated.</td>
</tr>
<tr>
<td>2L</td>
<td>NIC link LED</td>
<td>Solid green = Link exists. Off = No link exists.</td>
</tr>
</tbody>
</table>
### Item Description Status

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>2R</td>
<td>NIC activity LED</td>
<td>Solid green = Link to network. Flashing green = Activity exists. Off = No activity exists.</td>
</tr>
</tbody>
</table>
| 3    | Power supply 2 LED | Solid green = Normal Off = One or more of the following conditions exists:  
- AC power unavailable  
- Power supply failed  
- Power supply in standby mode  
- Power supply exceeded current limit |
| 4    | Power supply 1 LED | Solid green = Normal Off = One or more of the following conditions exists:  
- AC power unavailable  
- Power supply failed  
- Power supply in standby mode  
- Power supply exceeded current limit |

## Packing List

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Quantity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPIC-MV-2PRO-HW</td>
<td>1</td>
<td>EPIC™ MV hardware consisting of 2RU Platform, 4 Input slots, dual PSUs, 4 HD/1 UHD displays, 4 GBE. Dual 10 GBE (sharing). SFPs and option cards sold separately. All EPIC-MV-2PRO-HW devices are shipped with one EPIC-MV-DISP board. See Purchasing Options (on page 21) for descriptions of input board options.</td>
</tr>
<tr>
<td>139-000117Q00</td>
<td>4</td>
<td>CBL* CAT 6 X 10 FEET</td>
</tr>
<tr>
<td>103-100005Q00</td>
<td>4</td>
<td>FILTER<em>CABLE</em>SNAP FERRITE<em>LOW FREQUENCY</em>10R @300KHZ<em>35R @ 1MHZ W/1 TURN</em>PLASTIC CASE*35X18X22MM</td>
</tr>
<tr>
<td>EPIC-MV-2PRO-SW</td>
<td>1</td>
<td>EPIC™ MV software bundle with up to 48 unique sources, limited copy, optional MPEG2 and H.264/AVC CODEC support. Up to UHD 60 fps output, requires SDNO.</td>
</tr>
</tbody>
</table>

## Purchasing Options

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Description</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPIC-MV-2PRO-HW</td>
<td>EPIC™ MV hardware consisting of 2RU Platform, 4 Input slots, dual PSUs, 4 HD/1 UHD displays, 4 GBE. Dual 10 GBE reserved. SFPs and option cards sold separately.</td>
<td>Required</td>
</tr>
<tr>
<td>Item Number</td>
<td>Description</td>
<td>Required?</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>EPIC-MV-2PRO-SW</td>
<td>EPIC™ MV software bundle with up to 48 unique sources, limited copy, MPEG2 and H.264/AVC CODEC support. Up to UHD 60 fps output.</td>
<td>Required</td>
</tr>
<tr>
<td>EPIC-MV-UCIP</td>
<td>EPIC™ MV Uncompressed-over-IP ST 2022-6/7 via quad 10 GBE SFP+ interfaces. Supports 6x 3G/12x HD channels with redundancy. Limit four per platform. Limited to four (4) input modules per platform.</td>
<td>Option</td>
</tr>
<tr>
<td>EPIC-MV-3G</td>
<td>EPIC™ MV module provides support for 12 channels of 3G/HD/SD video using HD-BNC with conversion to BNC. Limited to four (4) input modules per platform.</td>
<td>Option</td>
</tr>
<tr>
<td>EPIC-MV-COMPRESSED</td>
<td>EPIC™ MV software license to support up to 12 channels of H264-AVC/MPEG-2 video software decoding with MPEG Layer-2 audio.</td>
<td>Option</td>
</tr>
<tr>
<td>OP+SFP+TRMM+10G</td>
<td>10BASE-SR Fiber Enhanced Small Form Factor Pluggable SFP+ transceiver. 10-Gigabit Ethernet links over multimode fiber. Maximum link length of 300m on 2000 MHz-km MMF.</td>
<td>Required</td>
</tr>
<tr>
<td>OP+SFP+TRSM+10G</td>
<td>10GBASE-LR fiber-enhanced small form factor pluggable SFP+ transceiver, capable of 10GbE links, up to a maximum length of 6.2 miles (10 km) over single mode fiber.</td>
<td>Required</td>
</tr>
<tr>
<td>SEL+AOC+10G</td>
<td>10GbE Small Form Factor Pluggable SFP+ transceiver Direct Attach Active Optical Cable, designed for high speed, short range data link.</td>
<td>Option</td>
</tr>
<tr>
<td>HV-GPIO-24E</td>
<td>GPIO interface for EPIC MV multiviewer.</td>
<td>Option</td>
</tr>
<tr>
<td>MSDNO-EPIC-MV</td>
<td>Magellan SDN Orchestrator EPIC™ MV License. One per EPIC™ MV platform when using SDNO.</td>
<td>Required</td>
</tr>
<tr>
<td>MAG-SVR</td>
<td>1RU Magellan Controller with redundant, hot-swappable power supplies and 6 Ethernet ports.</td>
<td>Required</td>
</tr>
</tbody>
</table>
Input Cards

Two input cards are available for EPIC™ MV:

- **EPIC-MV-UCIP** (on page 24)
- **EPIC-MV-3G** (on page 25)

You can have up to four input cards, total. EPIC-MV-3G and EPIC-MV-UCIP cards can be installed together in the same system.

As described in the chart below, if you have a single input card, it should be installed in slot 1, and any subsequent input cards should be installed sequentially.

<table>
<thead>
<tr>
<th># of Installed Cards</th>
<th>Preferred Installation Slot #'s</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>1, 2</td>
</tr>
<tr>
<td>3</td>
<td>1, 2, 3</td>
</tr>
<tr>
<td>4</td>
<td>1, 2, 3, 6</td>
</tr>
</tbody>
</table>

In a hybrid system with both EPIC-MV-UCIP and EPIC-MV-3G cards, cards of the same type should be installed beside each other. While the system will still operate correctly regardless of what order cards are installed, configuration will be easier if you install the EPIC-MV-UCIP cards in the first slots, followed by the EPIC-MV-3G cards. For installation instructions, see Input and Display Board Installation to EPIC™ MV Chassis (on page 39).
**EPIC-MV-UCIP**

The EPIC-MV-UCIP is a SMPTE 2022-6/7 Uncompressed Video over IP (UCIP) input card. Each EPIC-MV-UCIP card supports six channels of 3G using dual SFPs, or twelve channels of 1.5 Gb/s over IP using those same 2 SFP connections. Redundant SFP connections can be added for SMPTE 2022-7 hitless switching for redundancy. You can have up to four EPIC-MV-UCIP cards per EPIC™ MV. The maximum capacity in a single EPIC™ MV is either twenty-four (24) 3G or forty-eight (48) 1.5G signals per platform when filling all four high bandwidth input slots with EPIC-MV-UCIP input cards.

**EPIC-MV-UCIP Card: Top View**

If there is a single EPIC-MV-UCIP card installed in your EPIC™ MV, it should be installed in Slot 1.

The SFP connections for each EPIC-MV-UCIP card are numbered from right to left, with #1 being the main (primary) SFP connection.
The default configuration with four EPIC-MV-UCIP cards would be, from left to right, as follows:

<table>
<thead>
<tr>
<th>Slot</th>
<th>SFP 4</th>
<th>SFP 3</th>
<th>SFP 2</th>
<th>SFP 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot 1</td>
<td>Redundant input 2</td>
<td>Main input 2</td>
<td>Redundant input 1</td>
<td>Main input 1</td>
</tr>
<tr>
<td>Slot 2</td>
<td>Redundant input 4</td>
<td>Main input 4</td>
<td>Redundant input 3</td>
<td>Main input 3</td>
</tr>
<tr>
<td>Slot 3</td>
<td>Redundant input 6</td>
<td>Main input 6</td>
<td>Redundant input 5</td>
<td>Main input 5</td>
</tr>
<tr>
<td>Slot 6</td>
<td>Redundant input 8</td>
<td>Main input 8</td>
<td>Redundant input 7</td>
<td>Main input 7</td>
</tr>
</tbody>
</table>

If you are not using redundant inputs, you will only use the main inputs.

For installation instructions, see Input and Display Board Installation to EPIC™ MV Chassis (on page 39).

**EPIC-MV-3G**

The EPIC-MV-3G is a direct 3G / HD / SD-SDI input card. It provides monitoring for baseband signals with dynamic switching between formats and no visual disruption on the monitored source. Each EPIC-MV-3G card supports 12 SDI inputs over HD-BNC. Those SDI inputs can support 525, 625, 720i/p, 1080i/p at various frame rates. Each card ships with 13 HD-BNC to BNC cables.

You can have up to four EPIC-MV-3G cards per EPIC™ MV. The maximum capacity in a single EPIC™ MV is 48 inputs per platform when filling all four high bandwidth input slots with EPIC-MV-3G input cards.

If there is a single EPIC-MV-3G card installed in your EPIC™ MV and it is the only input card installed in the frame, it should be installed in Slot 1. Otherwise, install it in the slot following the last EPIC-MV-UCIP
card (slot 2, 3, or 6). For installation instructions, see Input and Display Board Installation to EPIC™ MV Chassis (on page 39).

EPIC-MV-3G Card: External Connectors

The connectors are labeled from left to right 1 - 12, with the right-most connector (#13) providing Genlock input (not currently used).

See EPIC-MV-3G Specification (on page 281).

Ethernet Connections

Each EPIC™ MV has quad 1 Gbe ports for control and low-bandwidth stream reception. Dual 10 Gbe NICs are reserved for sharing PIPs. If additional quad 1 Gbe or dual 10 Gbe network interfaces are required, these can be accommodated via any of the four option slots.

EPIC-MV-DISP Display Output Card

The standard EPIC™ MV comes with one EPIC-MV-DISP installed in Slot 4.

EPIC-MV-DISP provides up to four DisplayPort outputs. Labeled 1/2/3/4 from right to left, ports 1 and 2 are both UHD capable, and ports 3 and 4 can provide 1080p video. All display outputs will be delivered as DisplayPort 1.2 interface.

If either port 1 or 2 is used for UHD then do not use ports 3 and 4. You can run either quad 1080p (or lower) display outputs, or you can run 1 UHD head.

You must use proper DP 1.2a to HDMI conversion adapters if HDMI is the desired interface to the monitor, video conversion gear, display extender or other display endpoint type. For 1080p or lower displays, a passive converter is required. To support UHD bandwidth an adapter is required.
### Output Format  |  Cable Type                                      |  Cable Length  
---                |  ---                                           |  ---
1080p or lower    | HQ HDMI with passive converter DP1.x -> HDMI 1.4a | 100 ft (30 meters) 
UHD               | DP; requires active DP1.2a -> HDMI 2.0 conversion adapter | 10 ft (3 meters) 

For installation instructions, see [Input and Display Board Installation to EPIC™ MV Chassis](on page 39). 

**Dual 10 GBE LOM with SFP+ Cages**

The LOM system board has an embedded NIC, referred as LAN-on-motherboard (LOM) architecture. Customers can provide their own SFPs.

For installation steps see [SFP Removal](on page 49).

See [Purchasing Options](on page 21) for a list of SFPs that are approved for use.
Required and Recommended Hardware and Software Control Options

To configure and operate your multiviewer system, you need to have the Layout Designer software installed on your local PC.

To control and operate your multiviewer system using remote control options, you require the SDN Orchestrator. You can also control and monitor the multiviewer using the 3rd-party web API.

When it is in live operation, most of the actions done to EPIC™ MV will be switching sources and changing layouts. These actions can be done by:

- Magellan Control Panel
- SDN Orchestrator
- Layout Designer

Configuration is done by Layout Designer.

Magellan™ SDN Orchestrator (SDNO)

This purchasable option is an overarching software control system for managing hybrid baseband and IP networks. It ensures and maintains the integrity of all content being created, processed and distributed and delivers complete visibility of the entire network, offering a management view for optimal operational monitoring. Magellan SDNO uses current routing protocols and control panels, and offers compatibility with automation, tally, multiviewer, and other devices in the facility. EPIC™ MV requires SDNO to switch inputs to PIPs.

See your SDNO documentation for instructions on setting up EPIC™ MV in the database.

Layout Designer

Layout Designer provides an integrated computer interface for the control and configuration of one or more EPIC™ MV display systems over a LAN (local area network). These configuration options include:

- Setting output display mode
- Configuring output display devices
- Creating and assigning layouts to outputs

Use Layout Designer to select layouts for display, select and change PIP input sources, and modify layouts and layout objects. Layout Designer also provides the tools to create and design new layouts and configure monitoring tools such as audio meters, tally indicators, and audio and video alarms. See also Discovering EPIC™ MV Using Layout Designer (on page 90).
CCS Navigator and Magellan Remote Control Systems

The EPIC™ MV is fully compatible with CCS network control systems such as CCS Navigator and Magellan control panels.

Using Magellan control panel you can remotely perform the following operations:

- Select layouts that are stored on the multiviewer hardware for display
- Monitor multiviewers for system diagnostic and audio and video signal alarms
- Set audio and video alarm threshold values
- Change PiP input sources

For more information about controlling the multiviewer using CCS control, see Controlling Your Multiviewer on a Network (on page 93). For detailed information about using Magellan Control Panel to control and monitor your multiviewer, see your Magellan Router Control Panels User Manual. See your Navigator User Manual for detailed descriptions of its installation and features.

Open API

The EPIC-MV Remote API defines a set of access functions, notifications, resource identifiers, and objects providing means of control, monitoring, and configuration of the EPIC-MV product. For more information, see the EPIC MV Remote API User Guide, available from Customer Service.
Installation

System Setup

Optimum Environment

When installing the server in a rack, select a location that meets the environmental standards described in this section.

Space and Airflow Requirements

To allow for servicing and adequate airflow, observe the following space and airflow requirements when deciding where to install a rack:

- Leave a minimum clearance of 63.5 cm (25 in) in front of the rack.
- Leave a minimum clearance of 76.2 cm (30 in) behind the rack.
- Leave a minimum clearance of 121.9 cm (48 in) from the back of the rack to the back of another rack or row of racks.

HPE servers draw in cool air through the front and expel warm air through the rear. Therefore, the front and rear rack doors must be adequately ventilated to allow ambient room air to enter the cabinet, and the rear door must be adequately ventilated to allow the warm air to escape from the cabinet.

**CAUTION**: To prevent improper cooling and damage to the equipment, do not block the ventilation openings.

When vertical space in the rack is not filled by a server or rack component, the gaps between the components cause changes in airflow through the rack and across the servers. Cover all gaps with blanking panels to maintain proper airflow.

**CAUTION**: Always use blanking panels to fill empty vertical spaces in the rack. This arrangement ensures proper airflow. Using a rack without blanking panels results in improper cooling that can lead to thermal damage.

The 9000 and 10000 Series Racks provide proper server cooling from flow-through perforations in the front and rear doors that provide 64 percent open area for ventilation.

**CAUTION**: When using a Compaq branded 7000 series rack, install the high airflow rack door insert (PN 327281-B21 for 42U rack, PN 157847-B21 for 22U rack) to provide proper front-to-back airflow and cooling.
CAUTION: If a third-party rack is used, observe the following additional requirements to ensure adequate airflow and to prevent damage to the equipment:

- Front and rear doors—If the 42U rack includes closing front and rear doors, you must allow 5,350 sq cm (830 sq in) of holes evenly distributed from top to bottom to permit adequate airflow (equivalent to the required 64 percent open area for ventilation).
- Side—The clearance between the installed rack component and the side panels of the rack must be a minimum of 7 cm (2.75 in).

Temperature Requirements

To ensure continued safe and reliable equipment operation, install or position the system in a well-ventilated, climate-controlled environment.

The maximum recommended ambient operating temperature (TMRA) for most server products is 35°C (95°F). The temperature in the room where the rack is located must not exceed 35°C (95°F).

CAUTION: To reduce the risk of damage to the equipment when installing third-party options:

- Do not permit optional equipment to impede airflow around the server or to increase the internal rack temperature beyond the maximum allowable limits.
- Do not exceed the manufacturer’s TMRA.

Power Requirements

Installation of this equipment must comply with local and regional electrical regulations governing the installation of information technology equipment by licensed electricians. This equipment is designed to operate in installations covered by NFPA 70, 1999 Edition (National Electric Code) and NFPA-75, 1992 (code for Protection of Electronic Computer/Data Processing Equipment). For electrical power ratings on options, refer to the product rating label or the user documentation supplied with that option.

WARNING: To reduce the risk of personal injury, fire, or damage to the equipment, do not overload the AC supply branch circuit that provides power to the rack. Consult the electrical authority having jurisdiction over wiring and installation requirements of your facility.

CAUTION: Protect the server from power fluctuations and temporary interruptions with a regulating uninterruptible power supply. This device protects the hardware from damage caused by power surges and voltage spikes and keeps the system in operation during a power failure.

When installing more than one server, you might need to use additional power distribution devices to safely provide power to all devices. Observe the following guidelines:

- Balance the server power load between available AC supply branch circuits.
- Do not allow the overall system AC current load to exceed 80% of the branch circuit AC current rating.
- Do not use common power outlet strips for this equipment.
- Provide a separate electrical circuit for the server.

For more information on the hot-plug power supply and calculators to determine server power consumption in various system configurations, see the HPE Power Advisor section at https://www.hpe.com/us/en/integrated-systems/rack-power-cooling.html#Portfolio.

**Electrical Grounding Requirements**

The server must be grounded properly for proper operation and safety. In the United States, you must install the equipment in accordance with NFPA 70, 1999 Edition (National Electric Code), Article 250, as well as any local and regional building codes. In Canada, you must install the equipment in accordance with Canadian Standards Association, CSA C22.1, Canadian Electrical Code. In all other countries, you must install the equipment in accordance with any regional or national electrical wiring codes, such as the International Electrotechnical Commission (IEC) Code 364, parts 1 through 7. Furthermore, you must be sure that all power distribution devices used in the installation, such as branch wiring and receptacles, are listed or certified grounding-type devices.

Because of the high ground-leakage currents associated with multiple servers connected to the same power source, HPE recommends the use of a PDU that is either permanently wired to the building’s branch circuit or includes a nondetachable cord that is wired to an industrial-style plug. NEMA locking-style plugs or those complying with IEC 60309 are considered suitable for this purpose. Using common power outlet strips for the server is not recommended.

---

**Rack Mounting EPIC™ MV**

**WARNING:** To reduce the risk of personal injury or damage to the equipment, be sure that:

- The leveling jacks are extended to the floor.
- The full weight of the rack rests on the leveling jacks.
- The stabilizing feet are attached to the rack if it is a single-rack installation.
- The racks are coupled together in multiple-rack installations.
- Only one component is extended at a time. A rack may become unstable if more than one component is extended for any reason.
WARNING: To reduce the risk of personal injury or equipment damage when unloading a rack:

- At least two people are needed to safely unload the rack from the pallet. An empty 42U rack can weigh as much as 115 kg (253 lb), can stand more than 2.1 m (7 ft) tall, and might become unstable when being moved on its casters.
- Never stand in front of the rack when it is rolling down the ramp from the pallet. Always handle the rack from both sides.

**Install the Server into the Rack**

To install the server into a rack with square, round, or threaded holes refer to the instructions that ship with the rack hardware kit.

If you are installing the server into a telco rack, order the appropriate option kit. See https://www.hpe.com/us/en/integrated-systems/rack-power-cooling.html. Follow the server-specific instructions on the website to install the rack brackets.

Use the following information when connecting peripheral cables and power cords to the server.

**WARNING:** This server is very heavy. To reduce the risk of personal injury or damage to the equipment:

- Observe local occupational health and safety requirements and guidelines for manual material handling.
- Get help to lift and stabilize the product during installation or removal, especially when the product is not fastened to the rails. HPE recommends that a minimum of two people are required for all rack server installations. A third person may be required to help align the server if the server is installed higher than chest level.
- Use caution when installing the server in or removing the server from the rack; it is unstable when not fastened to the rails.

**CAUTION:** Always plan the rack installation so that the heaviest item is on the bottom of the rack. Install the heaviest item first, and continue to populate the rack from the bottom to the top.

1. Install the server and cable management arm into the rack. See the installation instructions that ship with the selected rail system.
2. Connect the peripheral devices to the server.  
   **See:** Back View.
3. Connect the power cord to the server.
4. Use the Velcro strip to secure the power cord.
5. Connect the power cord to the power source.
Extend the Server from the Rack

**Note:** If the optional cable management arm option is installed, you can extend the server without powering down the server or disconnecting peripheral cables and power cords. These steps are only necessary with the standard cable management solution.

**WARNINGS**

- To reduce the risk of personal injury or equipment damage, be sure that the rack is adequately stabilized before extending a component from the rack.
- To reduce the risk of personal injury, be careful when pressing the server rail-release latches and sliding the server into the rack. The sliding rails could pinch your fingers.

1. Power down the server.
2. Disconnect all peripheral cables and power cords.
3. Pull down the quick release levers on each side of the server.
4. Extend the server from the rack.
5. After performing the installation or maintenance procedure, slide the server into the rack:
   a. Slide the server fully into the rack.
   b. Secure the server by tightening the thumbscrews.
6. Connect the peripheral cables and power cords.

Remove the Server from the Rack

To remove the server from an HPE, Compaq branded, telco, or third-party rack:

1. Power down the server.
2. Extend the server from the rack. See Extend the Server from the Rack (on page 34).
3. Disconnect the cabling and remove the server from the rack. For more information, see the documentation that ships with the rack mounting option.
4. Place the server on a sturdy, level surface.

---

### Adding and Removing Hardware Components

EPIC™ MV is field serviceable for the following interior components:

- EPIC-MV-UCIP cards
- EPIC-MV-3G cards
- Dual 10GBE LOM modules

In order to add or remove these cards, you must first extend the server from the rack (if it is rack mounted) and remove the access panel, as described in the following topics.

#### Remove the Access Panel

**WARNING:** To reduce the risk of personal injury from hot surfaces, allow the drives and the internal system components to cool before touching them.

**CAUTION:** Do not operate the server for long periods with the access panel open or removed. Operating the server in this manner results in improper airflow and improper cooling that can lead to thermal damage.

To remove the component:

1. Power down the server.
2. Extend the server from the rack. See Extend the Server from the Rack (on page 34).
3. Open or unlock the locking latch, slide the access panel to the rear of the chassis, and remove the access panel.

#### Install the Access Panel

1. Place the access panel on top of the server with the hood latch open. Allow the panel to extend past the rear of the server approximately 1.25 cm (0.5 in).
2. Push down on the hood latch. The access panel slides to a closed position.
3. Tighten the security screw on the hood latch.

#### Remove the Hot-plug Fan

To remove the component:

1. Do one of the following:
   - Extend the server from the rack. See Extend the Server from the Rack (on page 34).
   - Remove the server from the rack. See Remove the Server from the Rack (on page 34).
2. Remove the access panel. See Remove the Access Panel (on page 35).
3. Remove the fan.

![Diagram of component removal](image)

**CAUTION:** Do not operate the server for long periods with the access panel open or removed. Operating the server in this manner results in improper airflow and improper cooling that can lead to thermal damage.

To replace the component, reverse the removal procedure.

# Riser Cage Assemblies

## Primary Riser Cage Assembly

**WARNING:** To reduce the risk of personal injury, electric shock, or damage to the equipment, remove the power cord to remove power from the server. The front panel Power On/Standby button does not completely shut off system power. Portions of the power supply and some internal circuitry remain active until AC power is removed.

To remove the component:

1. Back up all server data.
2. Power down the server. See Power Down the Server (on page 57).
3. Remove all power:
   a. Disconnect each power cord from the power source.
b. Disconnect each power cord from the server.

4. Do one of the following:
   ▪ Extend the server from the rack. See Extend the Server from the Rack (on page 34).
   ▪ Remove the server from the rack. See Remove the Server from the Rack (on page 34).

5. Remove the access panel. See Remove the Access Panel (on page 35).

6. Disconnect any internal cables that are connected to the expansion board.

7. If any full-length expansion boards are installed, release the full-length expansion board retainer.

8. Remove the primary PCI riser cage.

To replace the component, reverse the removal procedure.
Secondary Riser Cage Assembly

**WARNING:** To reduce the risk of personal injury, electric shock, or damage to the equipment, remove the power cord to remove power from the server. The front panel Power On/Standby button does not completely shut off system power. Portions of the power supply and some internal circuitry remain active until AC power is removed.

To remove the component:

1. Back up all server data.
2. Power down the server. See Power Down the Server (on page 57).
3. Remove all power:
   a. Disconnect each power cord from the power source.
   b. Disconnect each power cord from the server.
4. Do one of the following:
   ▪ Extend the server from the rack. See Extend the Server from the Rack (on page 34).
   ▪ Remove the server from the rack. See Remove the Server from the Rack (on page 34).
5. Remove the access panel. See Remove the Access Panel (on page 35).
6. Disconnect any internal cables that are connected to the expansion board.
7. If any full-length expansion boards are installed, release the full-length expansion board retainer.
8. Remove the secondary PCI riser cage.

To replace the component, reverse the removal procedure.

**Input and Display Board Installation to EPIC™ MV Chassis**

Input boards can be installed in slots 1, 2, 3, and 6 of the EPIC™ MV frame.

To install boards, see the following topics:

- [Assembly Kit Required](on page 39)
- [Tools and Materials Required](on page 40)
- [Side Riser Assembly](on page 41)
- [Center Riser Assembly](on page 44)
- [Re-Installing the Riser Modules](on page 46)

**CAUTION**

When installing or removing hardware, take the following precautions to ensure you do not damage your equipment:

- Ensure all working surfaces are ESD-safe with adequate dust control. Always follow ESD-safe procedures and protocols.
- Unless otherwise specified, torque settings to be used are in document TORQ2005-x.
Assembly Kit Required

EPIC-MV-UCIP and/or EPIC-MV-3G Hardware Kit for HPE Chassis

- 164-100680Q00 EPIC-MV-UCIP HPE Support Bracket
- 164-100681Q00 EPIC-MV-UCIP HPE Support Bracket Single Slot
- 6-32X3/16 PH_Q Screw 6-32 3/16" Pan Head Phillips (x6)
- 164-100698Q00 PCIe Bracket (x2)

Tools and Materials Required

- Phillips screw driver with #1 bit and torque adjustment
- Needle-nose pliers

HPE Chassis Preparation

Input cards need to be installed into the slots in the HPE Chassis shown below. Three input cards can be installed into the Side Riser and one card can be installed into the lower slot in the Center Riser. The first display card is installed in the top slot of the center riser, and an optional second display card is installed below it in the second slot of the center riser.
To install a card, remove the Top Cover of the chassis and remove the Riser Module by following printed diagrams on chassis.

**Side Riser Assembly**

For the Side Riser assembly, follow these steps:

1. Open the blue latch and carefully pull it away from the riser module to remove it. The three cover plates can then be removed.

2. Plug an input card into each of the three slot connectors on the riser module.
If you are installing a single card, it should go in the top slot. If you are installing two cards, they should go in the top and middle slots.

You can install both EPIC-MV-UCIP and EPIC-MV-3G cards in the same chassis. When mixing card types, install all EPIC-MV-UCIP boards in the first slots, followed by EPIC-MV-3G cards. This will ease configuration later.

3. To mount the HPE Riser Support Bracket (164-100680Q00) to the side of the riser module, start by hooking the back end onto the input cards with each slot of the bracket fitting into each of the corner of the cards.
For each unpopulated slot on the risers, insert a PCI SLOT FILLER PANEL (164-100698Q00).

Below is the top view of this procedure.
4. Secure the support bracket with three Pan Head Screws (6-32X3/16PH\_Q).

**Center Riser Assembly**

For the Center Riser assembly, follow these steps:

1. Open the blue latch and carefully pull it away from the riser module to remove it. The top slot always contains the first EPIC-MV-DISP module, included with server.
2. Remove the cover plates from any empty slots.
3. Plug an input board into the bottom slot connector on the riser module.

Insert EPIC™ MV Input Board into Bottom Slot of Center Riser (EPIC-MV-UCIP shown)

4. Install PCIe Brackets (164-100698Q00) over any unused slots.

5. Mount the HPE Riser Support Bracket Single Slot (164-100681Q00) to the side of the riser module.

6. Secure the secure support bracket with two Pan Head Screws (6-32X3/16PH_Q).
The completed assembly is shown below.

Note: Current assemblies will have no module in the center slot.

Re-Installing the Riser Modules

Re-install each riser module (with the input cards mounted) back into the HPE chassis, into their respective slots.
**IMPORTANT:** Secure the full-length expansion board retainer, as below:

---

**Hot-plug Hard Drives**

When adding hard drives to the server, observe the following general guidelines:

- The system automatically sets all device numbers.
- Drives should be the same capacity to provide the greatest storage space efficiency when drives are grouped together into the same drive array.

**Install a Hot-plug SAS or SATA Drive**

The EPIC™ MV system supports 2 system drives in RAID1 mirror configuration. While electrically how-swappable, removing drives on an active raid system will break the OS-based RAID-1 array.

Empty drive bays will include a hard drive cover.

To install a drive:
1. Remove the drive blank.

2. Prepare the drive.

3. Install the drive.

Remove a Hot-plug SAS or SATA Drive

**CAUTION:** For proper cooling, do not operate the server without the access panel, baffles, expansion slot covers, or blanks installed. If the server supports hot-plug components, minimize the amount of time the access panel is open.

1. Determine the status of the drive from the hot-plug SAS drive LED combinations.
2. Back up all server data on the drive.
3. Remove the drive.

Making System Connections

See [Back View](#) (on page 19) and the following sections for a complete description of cabling requirements.

**SFP Removal**

Due to varying release mechanisms, some SFPs may be difficult to remove from the EPIC™ MV chassis. To remove Finisar brand SFP cables, follow these steps:

1. Firmly push and hold the cable connector towards chassis (red arrow).
2. Pull the release tab away from chassis (green arrow) to unlatch.
3. While still pulling release tab, pull cable connector away from chassis.

For stuck cables, use a small flat head screwdriver to lift the locking tab of the SFP cage to clear the cable latch.
Connecting Multiple EPIC™ MVs

Each EPIC™ MV unit separately maintains configuration information. This information includes a lot of settings and configuration details.

When multiple units are connected, you may want to set up all the units the same way. In order to facilitate this (and also facilitate other typical product functionalities) there is a preset store/save/export/import functionality on a unit. These exported preset files include ALL of the configuration details of the device. However, some of the configuration details of the EPIC-MV unit are NOT overwritten when restoring a preset file - in this way a customer can save a preset from one unit which has been configured successfully, and apply it to other units in their system, without breaking the system. Items that are not imported from one unit to another include the following:

- The IP host address configuration of the various IP interfaces on the unit, including the PCIE-UCIP modules
- The unique unit name
- The per-signal UUIDs associated with an eventual AMWA-NMOS exposed routing interface
- The routing system IDs associated with any routing control interfaces (each unit should have a unique XY/LRC ID for instance)
- Router destination name mappings and names for interfaces

Each epic unit within a system has some configuration which distinguishes it from the other units within the system, yet binds it to that system. Note that multiple EPIC-MV systems could share some network resources, yet be configured as separate systems for a user-facing reason (such as redundancy).

Unit Name (unique on each EPIC in a sharing cluster)

System (Sharing Cluster) ID (set to the same ID on each EPIC unit within a sharing cluster)

When an EPIC™ MV unit is part of a system with pip-sharing, each EPIC™ MV will have the same list of PIPs that can be shared. EPIC™ MVs may be on the same network, switch, etc., but still need to be connected to the PIP Sharing Network to share PIPs. Shared PIPs will normally be a subset of all available PIPs. For more information, see Connecting to the PIP Sharing Network (on page 51).

Connecting to the PIP Sharing Network

PIP content is shared on a different VLAN from the video inputs, and is not managed by the SDNO. Instead, PIP shares have an inter-device private interconnect consisting of one or two connectors on the back of the EPIC™ MV frame (item #10 in the figure at Back View (on page 19)).

If you have only two EPIC™ MV devices, you can connect them directly together via these connectors. With more than two EPIC™ MV devices, connect each device directly to a dedicated switch via the LAN on motherboard connectors (item #10 in the figure at Back View (on page 19)).
PIPs are not automatically shared on the PIP sharing network. A file designates which PIPs from each EPIC™ MV are made available to all other EPIC™ MV devices on the network. This config file is stored on all EPIC™ MV devices participating in the PIP sharing network. See PIP Share Config File (on page 52).

An ingest channel shared on the PIP sharing network includes video, audio, and ancillary data (Captioning, teletext, and timecode).

**PIP Share Config File**

All PIPs are not automatically shared to all EPIC™ MV devices on the PIP-sharing network. Each device can share PIPs to other EPIC™ MV devices and can request PIPs that are shared from other EPIC™ MV devices. Each PIP to be shared is defined by its input to the EPIC™ MV, so if the input to that EPIC™ MV changes, the shared video, audio, and ancillary data will also change. The content of the ingest channel is always defined by the EPIC™ MV that is offering the PIP for use by other EPIC™ MVs.

PIP sharing in EPIC™ MV is configured by generating and loading a common XML file (PipSharingCfg.xml) on all EPIC™ MV devices participating in the PIP sharing network. This file must be the same on all devices and is located with the other multiviewer configuration files at a default location of

```
C:\ProgramData\Imagine Communications\Multiviewer
```

The configuration file will usually be made during the commissioning process, but may need to be modified later as system needs evolve.

The EPIC™ MV PIP Sharing network has certain requirements. All PIPs need to have a fixed scale. Each multiviewer providing PIPs needs to be identified along with the PIPs to be shared.
To set up a PIP Share config file, create a CSV file. Your raw data might look something like this:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Width,Height,AspectRatio,FrameRate,Name,ControlIp,DataIp,Channel,CustomName,VideoAddress,AudioAddress,DataAddress</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Width: Integer between 1 and 1920 Height: Integer between 1 and 1080 Aspect Ratio: integer/integer Frame Rate: integer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Name: &lt;string&gt; Control IP: IPv4 address Data IP: IPv4 address</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Channel: 1 - 48 (or blank, what would this mean) Custom name: &lt;string&gt; Can contain the fact that the PIP is a share, and what the source of the share is. This is how the content will appear when you are selecting it as a source on other EPIC™ MV devices Video Address: IPv4 address: port Audio Address: IPv4 address: port Data Address: IPv4 address: port</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

And save as something like this:

```
Width,Height,AspectRatio,FrameRate,Name,ControlIp,DataIp,Channel,CustomName,VideoAddress,AudioAddress,DataAddress
320,180,16/9,30000/1001,IPMV-R1,172.25.99.72,10.10.99.71,1,IPMV-R1 ch1,239.1.0.1:16,239.1.0.1:32,239.1.0.1:48 ,,,,,,,12,IPMV-R1 ch12,239.1.0.12:16,239.1.0.12:32,239.1.0.12:48 ,,,,,,IPMV-R2,172.25.99.73,10.10.99.72,48,IPMV-R2 ch48,239.2.0.48:16,239.2.0.48:32,239.2.0.48:48
```

When an EPIC™ MV device is running, the PIPs it has been designated to share are automatically sent to the PIP sharing network.
In Layout Designer, shared PIPs will appear in the PIP Properties panel under Source & Format Channel and Source menus. See Selecting a PiP’s Input Source (on page 192).

On the multiviewer display itself, valid shared PIP sources will display normally. Invalid sources will display "source Not Available" if there is no matching PIP as defined in the PipSharingCfg.xml file.

Making SDI Connections

A special tool is provided for making SDI connections on EPIC-MV-3G modules. This tool facilitates inserting and removing HD-BNC connectors at the back of the modules.

SDI connections are normally managed by a separate router, and Layout Designer displays whatever input is routed to that connection.

Using Compressed Video

EPIC™ MV can receive Compressed IP (CIP) video through various NIC connectors, and is able to monitor SPTS (single program transport stream) or MPTS (multiple program transport stream).

<table>
<thead>
<tr>
<th>SDNO Slot Number</th>
<th>Available Ports</th>
<th>Channels per Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1, 2, 3, 4</td>
<td>32</td>
<td>The 4 copper 1-GB NICs on the EPIC™ MV system, item #14 in Back View (on page 19).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The 2 10-GB NICs on the EPIC™ MV system. Slot 7 may not be available for compressed IP if the system is configured for Pip Sharing, item #10 in Back View (on page 19).</td>
</tr>
<tr>
<td>7</td>
<td>1, 2</td>
<td>256</td>
<td></td>
</tr>
</tbody>
</table>

Compressed IP EPIC™ MV Channels

With SDNO v2.3, the valid slot and ports for the CIP channels include:

- Slot 0 port 1, 2

With SDNO v2.5, the valid slot and ports for the CIP channels include:

- Slot 0 port 1, 2, 3, 4
- Slot 7 port 1, 2

Compressed video must be routed using SDNO. SDNO also provides database 'configuration', and is where you can configure the program to be selected within the MPTS stream. See Magellan™ SDN Orchestrator (SDNO) (on page 28) and your SDNO documentation for more information.

Once compressed video inputs are configured, they can be selected for a PIP just like any other video input. See Selecting a PiP’s Input Source (on page 192). You can set the audio service and add IP stream info. See Adding IP Stream Info (on page 253) for more information.
CIP Share Config File

```xml
<?xml version="1.0"?>

- <IPChannelConfiguration>
  
  <IPChannelGroup>
    
    <Name>Compress1</Name>
    <NumberOfChannels>2</NumberOfChannels>
    <NIC>ENET1</NIC>
    <DeviceSlot>0</DeviceSlot>
    <DevicePort>1</DevicePort>
  
  </IPChannelGroup>

  - <IPChannelGroup>
    
    <Name>Compress2a</Name>
    <NumberOfChannels>12</NumberOfChannels>
    <NIC>ENET2</NIC>
    <DeviceSlot>0</DeviceSlot>
    <DevicePort>2</DevicePort>
  
  </IPChannelGroup>

  - <IPChannelGroup>
    
    <Name>Compress2b</Name>
    <NumberOfChannels>4</NumberOfChannels>
    <NIC>ENET2</NIC>
    <DeviceSlot>0</DeviceSlot>
    <DevicePort>2</DevicePort>
  
  </IPChannelGroup>

</IPChannelConfiguration>
```

Where

- `<Name>` is the CIP group
- `<NumberOfChannels>` is the # of channels defined for the group name
- `<NIC>` is the network adapter to bind to to receive the compressed ingest

These are the two 10GbE NICs:
- Embedded FlexibleLOM 1 Port 1 (ENET5)
- Embedded FlexibleLOM 1 Port 2 (ENET6)

These are the four 10GbE NICs:
- Embedded LOM 1 Port 1 (ENET1)
Embedded LOM 1 Port 2 (ENET2)
Embedded LOM 1 Port 3 (ENET3)
Embedded LOM 1 Port 4 (ENET4)

<DeviceSlot> is the physical NIC group location. The 1-GB NIC is in slot 0. The 10-GB NIC is in slot 7
<DevicePort> is the physical NIC within the NIC group.
HPE Server Configuration and Operation

The EPIC™ MV has HPE-native software and hardware configuration, control, and monitoring tools that allow you to track your hardware's state and behavior. See the following topics:

- Powering the Server
- Join a Domain (on page 58)
- System Recovery (on page 59)
- Prevent Damage and Malfunction (on page 60)
- Server Management Network (on page 63)

Power Up the Server

To power up the server, press the Power On/Standby button.

Power Down the Server

Before powering down the server for any upgrade or maintenance procedures, perform a backup of critical server data and programs.

**IMPORTANT**: When the server is in standby mode, auxiliary power is still being provided to the system.

To power down the server, use one of the following methods:

- Press and release the Power On/Standby button.
  
  This method initiates a controlled shutdown of applications and the OS before the server enters standby mode.

- Press and hold the Power On/Standby button for more than 4 seconds to force the server to enter standby mode.
  
  This method forces the server to enter standby mode without properly exiting applications and the OS. If an application stops responding, you can use this method to force a shutdown.

- Use a virtual power button selection through HPE iLO.
  
  This method initiates a controlled remote shutdown of applications and the OS before the server enters standby mode.

Before proceeding, verify the server is in standby mode by observing that the system power LED is amber.
Join a Domain

To join a domain from a EPIC MV system you must make sure the Start Up Type is set to Manual for the following three services: Computer Browser, Intersite Messaging, Windows Firewall.

1. Set the Start Up Type to Manual for each of the three services:
   a. Open the Services window (Task Manager > Services tab > Services button).
   b. In the Services window, right-click on the service name (Computer Browser, Intersite Messaging, or Windows Firewall).
   c. Select Properties from the right-click menu. The Properties dialog displays.
   d. On the General tab, select Manual from the Startup Type menu.
   e. Click OK to apply the setting.
   f. Repeat these steps for all three services.

2. Reboot the EPIC MV system.

3. Join a domain:
   a. Open System Properties (Control Panel > System).
   b. In the “Computer name, domain, and workgroup settings” area, click the Change Settings option. The Systems Properties dialog opens.
   c. On the Computer Name tab, click the Change button.
   d. In the Computer Name/Domain Changes dialog enter the appropriate credentials.
   e. Click OK through the dialogs to apply the settings.
System Recovery

The initial factory install is captured as a WIM image to the system recovery drive, which is internal to the EPIC™ MV system.

After the software has been set up successfully on your system it is recommended that you create a new WIM image to capture the current state of the C:\ drive for future system recovery. You can capture this new image to the internal system recovery drive, to a shared network location, or to a properly formatted USB stick.

If you are using a third-party USB stick, follow these steps to format the USB stick for the WIM image:

1. Insert the third-party USB stick into the USB port on the back of the EPIC™ MV system.
2. On the EPIC™ MV system, open the Programs\PE_Apps folder.
3. Double-click NxImage.exe to start the NxImage application.
4. From the File menu, select Format Disk. The Format Disk dialog opens.
5. From the Assign Letter drop-down list, select only the third-party USB stick.
6. From the Format Type drop-down list, select NTFS.
7. Click the FORMAT button to format the third-party USB stick.

Capture the WIM Image

Use the following steps to capture a WIM image for future system recovery.

1. Insert the System Recovery USB stick into the USB port on the EPIC MV system.
2. Restart the system.
3. Continuously press F11 during the POST to open the Boot Menu.
4. Select the USB drive and press ENTER to access the Recovery Desktop.
5. On the Recovery Desktop, double-click the Utility Launcher icon.
6. In the Utility Launcher, click the Imaging button to open the NxImage application.
7. From the File menu, select Capture WIM Image to open the Capture Image dialog.

8. If necessary, click the Browse button beside the Step (1) field and select the C: drive.
9. Click the Browse button beside the Step (2) field.
10. Select the location on the USB stick for saving the WIM file and enter a name for the file.
11. In the Capture Image dialog, select the Make Bootable checkbox.
12. Click the Capture Image button. The progress and status displays in the title bar.
13. When the capture is complete, click Close.

**Note:** If the final WIM image does not fit on the System Recovery USB stick or the third-party USB stick, you can capture the WIM image to a network share.

---

**Prevent Damage and Malfunction**

Read and observe all instructions in this section to keep your system working safely and effectively.

**Anti-Virus, Monitoring, & Third-Party Software**

Imagine Communications does not pre-test, certify, or guarantee the trouble-free performance of any third-party anti-virus/security software package. All anti-virus/security and monitoring software packages have the potential to degrade the real-time, stable performance of Playout products. We make no guarantee that our product has the resources necessary to support or interoperate with any particular package, including processing overhead, storage space, or networking connectivity.

However, in most cases, customers who install a third-party anti-virus/security or monitoring software package will not experience performance issues when the software operations are properly managed. Customers who do install any third-party software must:

- Accept responsibility for the third-party product used, including testing that confirms the software does not interfere with their workflow or real-time capture and playout. This includes but is not limited to stacked playout, ingest, graphics insertion, automation timing and control; as well as non-real-time operations such as file interchange and configuration.
- Manage any scheduled third-party operations (such as file scanning, log polling, API calling, etc.) so the software does not impact system performance. This includes limiting potentially intrusive...
operations to times when server load is minimal and staff are available to deal with any security related and/or Imagine Communications application issues that may occur.

- Exclude Imagine Communications log files from scans to help ensure the anti-virus software does not block or restrict access to files generated by real-time processes. Customers should contact Imagine Communications support for a list of files and directories that are used for logging.
- Use the least intrusive monitoring approach possible that makes operational sense. Focus on looking for issues that are pre-cursors of impeding or potential failure such as fan failures, drive errors, RAID set degradation, and so on.
- Notify Imagine Communications support of any third-party packages installed and agree to disable/remove them as the first step of any troubleshooting process.

Imagine Communications support will make reasonable efforts with warranty-entitled or ImagineCare customers to help resolve product issues surrounding the installation of any third-party anti-virus/security software package, however we cannot guarantee a successful outcome.

### Operating System Updates

To assure the operation, service, technical support, and maintenance of Imagine Communications EPIC MV systems on known tested and qualified operating system configurations, customers should not install any operating system updates on EPIC MV systems unless formally notified by Imagine Communications to do so. Imagine Communications tests and verifies software releases using current updates immediately prior to release, and are confident of the operation of the updates as of that date.

Customers who do install additional operating system updates on EPIC MV systems waive the right for Imagine Communications support to assist with any updates which have not been formally approved by Imagine Communications. Furthermore, Imagine Communications service representatives may require the removal of any operating system updates which have not been formally approved by Imagine Communications for use on EPIC MV systems, before offering assistance with troubleshooting and providing service, technical support, or maintenance. If additional updates have been installed we recommend creating a system restore point before proceeding.

### Automatic Updates

Imagine Communications builds and ships EPIC MV systems with the Microsoft® Updates feature turned off. This prevents future operating system updates from automatically installing code which may prevent Imagine Communications EPIC MV systems from operating as expected.

EPIC MV systems comply with the platform design rules as they existed when the software was built. Imagine Communications has no control over Microsoft’s platform support or the patches which Microsoft may issue. Imagine Communications also has no control over the user-configured distribution mechanism which Microsoft uses to push updates to machines running operating system software.
BIOS Settings

Whenever you make changes to the BIOS configuration, make a point of saving before exiting the BIOS Configuration tool.

1. Under **System Configuration**, choose **BIOS / Platform Configuration**.
2. Under **Performance Options > Advanced Performance Tuning > NUMA Group Size Optimization**, choose **Flat**.
   
   When set to Clustered, Windows will have two separate processor groups, and each process can only run on half the cores. This will not be enough power to run the blueprint.
3. Under **System Options > Processor Options > Intel Hyperthreading**, choose **Enabled**.
4. For full 100% iLO display availability and best isolation between VGA (desktop) and Nvidia GPU heads for Multiviewer display, under **Platform Configuration > Advanced Options**, ensure the following two settings are correct:
   - Embedded Video Connection: **Always Enabled**
   - Video Options: **Both Add-in and Embedded Video Enabled**
5. Under **Platform Configuration > PCI Device Enable/Disable**, make sure that the standard Nvidia GPU is **Enabled** in what the BIOS calls Slot 2.
6. Under **Platform Configuration**, set **Server Availability** to **Restore Last Power State** or **Always On State**, to ensure that the platform returns to an On state when power returns after an unexpected power failure.
7. Under **Platform Configuration > Power Management**, choose **Maximum Performance**.

iLO Setup

If you make any changes to the BIOS configuration, make a point of saving before exiting the BIOS Configuration tool.

1. To start iLO configuration from the BIOS, navigate up to **System Utilities** (or enter again via F9).
2. Press **Enter** for system configuration.
3. Scroll down and select **Enter** for iLO4 Configuration Utility.
4. Select **DHCP Enable** and switch to **Off**.
5. Scroll down to IP Address, Subnet and Gateway for the independent protocol stack used by the iLO system.
6. Press F10 to save all changes made under System Configuration.

If you need to reboot the system for your changes to take effect, with EPIC MV, it's necessary to hard reset the system by holding the power button down for several seconds. This ensures that all capture cards are in the best possible state.

To use the iLO tool remotely, EPIC-MV must recognize a monitor connected to its VGA port. See **Forcing VGA on EPIC™ MV with no VGA Cable Connected** (on page 80) for more information.
Server Management Network

EPIC™ MV uses the iLO (integrated Lights out) Server Management Network to remotely control and monitor fans, power, networking, etc. iLO is an independent microprocessor running an embedded operating system.

For complete information about HPE iLO and other aspects of your HPE server, see Obtaining Documents (on page 10).

Logging into iLO (Server Management Network)

EPIC™ MV hardware has a dedicated iLO connector labeled #13 in the graphic in Back View (on page 19). The iLO interface is pre-installed.

When you boot up your EPIC™ MV one of the first things you will see will include the IP address of the iLO connector.

The iLO firmware is configured with a default user name, password, and DNS name. This default user information is located on the serial label pull tab attached to the server that contains the iLO management processor, #4 in the diagram in Front Panel (on page 17). It’s also on a sticker on the top of the unit.

To access iLO remotely, follow these steps:

1. Enter the IP address for the device into a web browser.
2. Enter the user name and password.
Default User name—Administrator  
Password—A random eight-character alphanumeric string

A screen similar to the following will appear.

Note: iLO will not display on a monitor that is larger than 1920 x 1080.

Using the iLO Web Interface

Every page in the iLO web interface provides full access to system configuration and UEFI. It includes controls at the bottom of the browser window to indicate critical information such as system health -- server fans, temperature sensors, and monitored subsystems. Click the icon to view the status of the monitored components, and select a component to view more information about the component status.

Note: iLO will not display on a monitor that is larger than 1920 x 1080.

Navigate to iLO Overview information (Information > Overview in the panel on the left of the screen) to see high level details of the server and the iLO subsystem. Without leaving this screen you have access to the following information:

- Information Overview (on page 65)
- Status Overview (on page 66)
- Active Sessions Overview (on page 66)

Your HPE iLO 4 User Guide has complete information about every indicator.
Information Overview

The Information Overview section of the screen shows the following information:

- **Server Name**—The server name defined by the host operating system. Click the Server Name link to navigate to the Access Settings page.
- **Product Name**—The product with which this iLO processor is integrated.
- **UUID**—The universally unique identifier that software uses to uniquely identify this host. This value is assigned when the system is manufactured.
- **UUID (Logical)**—The system UUID that is presented to host applications. This value is displayed only when it has been set by other software, such as HPE Virtual Connect Enterprise Manager. This value might affect operating system and application licensing. The UUID (Logical) value is set as part of the logical server profile that is assigned to the system. If the logical server profile is removed, the system UUID value reverts from the UUID (Logical) value to the UUID value. If no UUID (Logical) value is set, this item is not displayed.
- **Server Serial Number**—The server serial number, which is assigned when the system is manufactured. You can change this value by using the system RBSU or the UEFI System Utilities during POST.
- **Serial Number (Logical)**—The system serial number that is presented to host applications. This value is displayed only when it has been set by other software, such as Virtual Connect Manager. This value might affect operating system and application licensing. The Serial Number (Logical) value is set as part of the logical server profile that is assigned to the system. If the logical server profile is removed, the serial number value reverts from the Serial Number (Logical) value to the Server Serial Number value. If no Serial Number (Logical) value is set, this item is not displayed.
- **Chassis Serial Number**—The serial number of the chassis that contains the server node. This information is displayed for servers with chassis firmware version 6.0 or later.
- **Product ID**—This value distinguishes between different systems with similar serial numbers. The product ID is assigned when the system is manufactured. You can change this value by using the system RBSU or the UEFI System Utilities during POST.
- **System ROM**—The version of the active system ROM.
- **System ROM Date**—The date of the active system ROM.
- **Backup System ROM**—The version of the backup system ROM. The backup system ROM is used if a system ROM update fails or is rolled back. This value is displayed only if the system supports a backup system ROM.
- **Integrated Remote Console**—Provides links to start the .NET IRC or Java IRC for remote, out-of-band communication with the server console. When you use the Java IRC:
  - For environments with Windows or Linux and the Oracle JRE—Use the Java Web Start link.
  - For environments with Linux and the OpenJDK JRE—Use the Java Applet link.
- **License Type**—The level of licensed iLO firmware functionality.
- **iLO Firmware Version**—The version and date of the installed iLO firmware. Click the iLO Firmware Version link to navigate to the Firmware Update page.
- **IP Address**—The network IP address of the iLO subsystem.
- **Link-Local IPv6 Address**—The SLAAC link-local address of the iLO subsystem. Click the Link-Local IPv6 Address link to navigate to the Network Summary page. This value is displayed only for iLO Dedicated Network Port configurations.
• iLO Hostname—The fully-qualified network name assigned to the iLO subsystem. By default, the hostname is ILO, followed by the system serial number and the current domain name. This value is used for the network name and must be unique.

Status Overview

• The Status Overview section of the screen shows the following information:
  • System Health—The server health indicator. This value summarizes the condition of the monitored subsystems, including overall status and redundancy (ability to handle a failure). Lack of redundancy in any subsystem at startup will not degrade the system health status. Click the System Health link to navigate to the Health Summary page.
  • Server Power—The server power state (ON or OFF).
  • UID Indicator—The state of the UID LED. The UID LED helps you identify and locate a server, especially in high-density rack environments. The possible states are UID ON, UID OFF, and UID BLINK.

You can change the UID LED state to UID ON or UID OFF by using the UID buttons on the server chassis or the UID control at the bottom of the iLO web interface window. When the UID LED is blinking, the UID Indicator displays the status UID BLINK. When the UID LED stops blinking, the status reverts to the previous value (UID ON or UID OFF). If a new state is selected while the UID LED is blinking, that state takes effect when the UID LED stops blinking.

CAUTION

The UID LED blinks automatically to indicate that a critical operation is underway on the host, such as Remote Console access or a firmware update. Do not remove power from a server when the UID LED is blinking.

• TPM Status or TM Status—The status of the TPM or TM socket or module.
  • Module Type—The TPM or TM type and specification version. The possible values are TPM 1.2, TPM 2.0, TM 1.0, Not Specified, and Not Supported. This value is displayed when a TPM or TM is present on a server.
  • SD-Card Status—The current status of the internal SD card. If present, the number of blocks in the SD card is displayed.
  • iLO Date/Time—The internal clock of the iLO subsystem.

Active Sessions Overview

The Active Sessions Overview section of the screen shows the following information about all users logged in to iLO:

• Login name
• IP address
• Source (for example, HTTPS, Remote Console, or SSH)

Viewing System Information

The iLO System Information page displays the health of the monitored subsystems and devices.
The information that you can view depends on whether you are using Agentless Management or SNMP Pass-thru, and whether AMS is installed.

The System Information page includes health tabs that are described in the following topics:

- **Viewing Health Summary Information** (on page 67)
- **Viewing Fan Information** (on page 68)
- **Viewing Temperature Information** (on page 69)
- **Viewing Power Information** (on page 69)
- **Viewing Processor Details** (on page 72)
- **Viewing Memory Information** (on page 73)
- **Viewing Network Information** (on page 73)
- **Viewing the Device Inventory** (on page 73)
- **Viewing Storage Information** (on page 74)
- **Viewing Firmware Information** (on page 74)
- **Viewing Software Information** (on page 75)

**Viewing Health Summary Information**

The System Information dialog's Summary tab displays the status of monitored subsystems and devices. Depending on the server configuration, the information on this page varies.

If the server is powered off, the system health information on this page is current as of the last power off. Health information is updated only when the server is powered on and POST is complete.

**Redundancy Status**

Redundancy status is displayed for the following:

- Fan Redundancy
- Power Status

**Subsystem and device status**

Summarized status information is displayed for the following:

- BIOS/Hardware Health
- Fans
- Memory
- Network
- Power Supplies
- Processors
- Storage
- Temperatures
- Smart Storage Battery Status
- Agentless Management Service
Subsystem and device status values

The Health Summary page uses the following status values:

- **Redundant**—There is a backup component for the device or subsystem.
- **OK**—The device or subsystem is working correctly.
- **Not Redundant**—There is no backup component for the device or subsystem.
- **Not Available**—The component is not available or not installed.
- **Degraded**—The device or subsystem is operating at a reduced capacity.
  
  Previous versions of iLO used a status of Mismatched to indicate the presence of mismatched power supplies. iLO 4 displays the power supply status as Degraded when mismatched power supplies are installed.
  
  If you power on a server with nonredundant fans or power supplies, the system health status is listed as OK. However, if a redundant fan or power supply fails while the system is powered on, the system health status is listed as Degraded until you replace the fan or power supply.
- **Failed Redundant**—The device or subsystem is in a nonoperational state.
- **Failed**—One or more components of the device or subsystem are nonoperational.
- **Other**—For more information, navigate to the System Information page of the component that is reporting this status.
- **Link Down**—The network link is down.
- **Unknown**—The iLO firmware has not received data about the device status.
  
  If iLO was reset when the server was powered off, some subsystems display the status Unknown because the status cannot be updated when the server is powered off.
- **Not Installed**—The subsystem or device is not installed.

**Viewing Fan Information**

The information displayed on the System Information dialog's Fans tab varies depending on the server configuration. On servers that support fan redundancy, empty fan bays are hidden by default.

If the server is powered off, the system health information on this page is current as of the last power off. Health information is updated only when the server is powered on and POST is complete.

The following details are displayed for each fan:

- **Fan**—The fan name.
- **Location**—For nonblade servers, the location in the server chassis is listed. For server blades, the virtual fan is listed with the location Virtual.
- **Status**—The fan health status.
- **Speed**—The fan speed (percent).

The iLO firmware, in conjunction with the hardware, controls the operation and speed of the fans. Fans provide essential cooling of components to ensure reliability and continued operation. The fans react to the temperatures monitored throughout the system to provide sufficient cooling with minimal noise.

Fan control takes into account the internal temperature of the system, increasing the fan speed to provide more cooling, and decreasing the fan speed if cooling is sufficient. In the event of a fan failure,
fan operation policies might increase the speed of the other fans, record the event in the IML, or turn LED indicators on.

Where multiple fan failures occur, the system might be incapable of providing sufficient cooling to protect the server from damage and to ensure data integrity. In this case, in addition to the cooling policies, the system might start a graceful shutdown of the operating system and server.

**Viewing Temperature Information**

The System Information dialog's Temperatures tab includes a temperature graph and a table that displays the location, status, temperature, and threshold settings of temperature sensors in the server chassis.

If the server is powered off, the system health information on this page is current as of the last power off. Health information is updated only when the server is powered on and POST is complete.

- Select the 3D check box to display a three-dimensional graph.
- Clear the 3D check box to display a two-dimensional graph.
- Select Front View or Back View to display the sensors located at the front or back of the server.

Move the mouse over a circle on the graph to view individual sensor details.

The sensor ID, status, and temperature reading are displayed in the Sensor Data table.

The color on the graph is a gradient that ranges from green to red. Green represents a temperature of 0°C and red represents the critical threshold. As the temperature of a sensor increases, the graph color changes from green to amber, and then to red if the temperature approaches the critical threshold.

By default, sensors that are not installed are hidden. To view the missing sensors, click Show Missing Sensors.

The following temperature thresholds are monitored:

- **Caution**—The server is designed to maintain a temperature below the caution threshold. If the temperature exceeds the caution threshold, the fan speeds are increased to maximum. If the temperature exceeds the caution threshold for 60 seconds, a graceful server shutdown is attempted.

- **Critical**—If temperatures are uncontrollable or rise quickly, the critical temperature threshold prevents system failure by physically shutting down the server before the high temperature causes an electronic component failure. Monitoring policies differ depending on the server requirements. Policies usually include increasing fan speeds to maximum cooling, logging temperature events in the IML, providing a visual indication of events by using LED indicators, and starting a graceful shutdown of the operating system to avoid data corruption.

Additional policies are implemented after an excessive temperature condition is corrected, including returning the fan speed to normal, recording the event in the IML, turning off the LED indicators, and canceling shutdowns in progress (if applicable).

**Viewing Power Information**

The System Information dialog's Power tab displays the following sections:
Power Supply Summary

Present Power Reading

When HPE Common Slot Power Supplies are present, the most recent power reading from the server is displayed. Other power supplies do not provide this data.

Although this value is typically equal to the sum of all active power supply outputs, there might be some small variance as a result of reading the individual power supplies. This value is a guideline value and is not as accurate as the values presented on the Power Management pages.

Power Management Controller Firmware Version

The firmware version of the power management controller. The server must be powered on for the iLO firmware to determine this value. This feature is not available on all servers.

Power Status

The overall status of the power supplied to the server.

• If the server power supplies are connected to a nonintelligent power source, this section displays the status of the internal server power supplies.

• If the server power supplies are connected to Power Discovery Services through an iPDU, this section displays the status of the power supplied to the internal server power supplies.

Possible Power Status values follow:

• Redundant—Indicates that the power supplies are in a redundant state. If Power Discovery Services is integrated into the infrastructure, this value indicates whether the externally supplied power to the internal power supplies is redundant.

• Not Redundant—Indicates that at least one of the power supplies or iPDU (in the case of Power Discovery Services) is not supplying power to the server. The most common reason for this status is a loss of input power to the power supply. Another reason for this status is a configuration with multiple power supplies connected to the same iPDU. In this case, the individual power supply status is Good, In Use, but the Power Status value is Not Redundant because the loss of input power to the iPDU would lead to a total loss of power to the server.

• OK—A Common Slot Power Supply is not installed. The installed power supply is working correctly.

HPE Power Discovery Services Status

The possible values follow:

• Redundant—The server is configured for a redundant iPDU configuration.

• Not Redundant—There are not sufficient iPDU to support redundancy, or the server’s power supplies are connected to the same iPDU.

• N/A—No iPDU were discovered.
When the iLO processor or the server is reset, the iPDU discovery process might take a few minutes to complete.

**High Efficiency Mode**

The redundant power supply mode that will be used if redundant power supplies are configured.

The possible values follow:

- **N/A**—Not applicable.
- **Balanced Mode**—Delivers power equally across all installed power supplies.
- **High Efficiency Mode (Auto)**—Delivers full power to one of the power supplies, and places the other power supplies on standby at a lower power-usage level. A semi-random distribution is achieved because the Auto option chooses between the odd or even power supply based on the server serial number.
- **High Efficiency Mode (Even Supply Standby)**—Delivers full power to the odd-numbered power supplies, and places the even-numbered power supplies on standby at a lower power-usage level.
- **High Efficiency Mode (Odd Supply Standby)**—Delivers full power to the even-numbered power supplies, and places the odd-numbered power supplies on standby at a lower power-usage level.
- **Not Supported**—The installed power supplies do not support High Efficiency Mode.

**Power Supplies List**

**Power Supplies list:** Some power supplies do not provide information for all of the values in this list. If a power supply does not provide information for a value, N/A is displayed.

**Bay:** The power supply bay number.

**Present:** Whether a power supply is installed. The possible values are OK and Not Installed.

**Status:** The power supply status. The displayed value includes a status icon (OK, Degraded, Failed, or Other), and text that provides more information. The possible values follow:

- Unknown
- Good, In Use
- Good, Standby
- General Failure
- Over Voltage Failure
- Over Current Failure
- Over Temperature Failure
- Input Voltage Lost
- Fan Failure
- High Input A/C Warning
- Low Input A/C Warning
- High Output Warning
- Low Output Warning
- Inlet Temperature Warning
- Internal Temperature Warning
• High Vaux Warning
• Low Vaux Warning
• Mismatched Power Supplies

**PDS:** Whether the installed power supply is enabled for Power Discovery Services.

**Hotplug:** Whether the power supply bay supports swapping the power supply when the server is powered on. If the value is Yes, and the power supplies are redundant, the power supply can be removed or replaced when the server is powered on.

**Flex Slot Battery Backup Unit:** The following information is displayed for supported servers with an installed Flex Slot Battery Backup Unit:

- Charge—The current battery charge (percent).
- Days Active—The number of calendar days that the battery has been installed in a powered server.
- Battery Health—The battery health status (0 to 100 percent).

Power capping and power metering are not supported on servers with an installed Flex Slot Battery Backup Unit.

**Model:** The power supply model number.

**Spare:** The spare power supply part number.

**Serial Number:** The power supply serial number.

**Capacity:** The power supply capacity (watts).

**Firmware:** The installed power supply firmware version.

**Smart Storage Battery**

EPIC™ MV supports the Smart Storage Battery, so the following details are displayed:

- Index—The battery index number.
- Present—Whether a battery is installed. The possible values are OK and Not Installed.
- Status—The battery status. The possible values are OK, Degraded, Failed, or Other.
- Model—The battery model number.
- Spare—The part number of the spare battery.
- Serial—The battery serial number.
- Capacity—The battery capacity.
- Firmware—The installed battery firmware version.

**Viewing Processor Details**

The System Information dialog's Processor tab displays the following information for each processor:

- Processor Name—The name of the processor.
- Processor Status—The health status of the processor.
- Processor Speed—The speed of the processor.
- Execution Technology—Information about the processor cores and threads.
- Memory Technology—The processor memory capabilities.
- Internal L1 cache—The L1 cache size.
- Internal L2 cache—The L2 cache size.
- Internal L3 cache—The L3 cache size.

**Viewing Memory Information**

The System Information dialog's Memory tab displays a summary of the system memory. When server power is off, AMP data is unavailable, and only memory modules present at POST are displayed.

If the server is powered off, the system health information on this page is current as of the last power off. Health information is updated only when the server is powered on and POST is complete.

By default, empty memory sockets are hidden in the Memory Details table. To view the empty memory sockets, click Show empty sockets.

**Viewing Network Information**

The System Information dialog's Network tab displays network health status information.

If the server is powered off, the health status information on this page is current as of the last power off. Health information is updated only when the server is powered on and POST is complete.

To view a full set of data on this page, ensure that AMS is installed and running. The server IP address, add-in network adapters, and the server NIC status are displayed only if AMS is installed and running on the server.

**Viewing the Device Inventory**

The System Information Device Inventory tab displays information about devices installed on the system board.

Some examples of the devices listed on this page include installed adapters, PCI devices, SATA controllers, and Smart Storage batteries.

If the server is powered off, the health status information on this page is current as of the last power on. Health information is updated only when the server is powered on and POST is complete.

The following information is displayed only if AMS is installed and running on the server: Firmware version and status of add-in network adapters, network-attached storage details, and Smart Storage Battery status.

If the iLO firmware cannot retrieve the network adapter product name or part number directly from the device, it attempts to collect that information from AMS.

**Device Inventory details**

- Location—The device install location.
- Product Name—The device product name.
- Product Part Number—The device part number. This column displays the value Various when the listed device’s actual part number is dependent on internally installed graphics devices that differ by server model.
• Serial Number—The device serial number.
• Product Version—The device product version.
• Firmware Version—The installed device firmware version.
• Status—The device status.

**Viewing Storage Information**

The System Information dialog's Storage tab displays the following information.

If the server is powered off, the system health information on this page is current as of the last power off. Health information is updated only when the server is powered on and POST is complete.

To view a full set of data on this page, ensure that AMS is installed and running. SAS/SATA controller information is displayed only if AMS is installed and running on the server.

The information displayed on this page depends on your storage configuration. Some storage configurations will not display information for every category.

**Viewing Firmware Information**

The System Information Dialog's Firmware tab displays firmware information for various server components.

If the server is powered off, the information on this page is current as of the last power off.

Firmware information is updated only when the server is powered on and POST is complete.

The firmware types listed on the Firmware Information page vary based on the server model and configuration.

For most servers, the system ROM and iLO firmware are listed. Other possible firmware options include the following:

• Power Management Controller
• Server Platform Services Firmware
• Smart Array
• Intelligent Platform Abstraction Data
• TPM or TM firmware
• SAS Programmable Logic Device
• System Programmable Logic Device
• Intelligent Provisioning
• Networking adapters
• NVMe Backplane Firmware

Firmware information for hard drives is not listed on this page. To view hard drive firmware details, navigate to the Information→System Information page, and then click the Storage tab.

The Firmware Information page displays the following information for each listed firmware type:

• Firmware Name—The name of the firmware.
• Firmware Version—The version of the firmware.
• Location—The location of the component that uses the listed firmware.

**Viewing Software Information**

The System Information dialog Software tab contains the following information:

- **HPE Software**—Lists all of the HPE software on the managed server. This includes Hewlett Packard Enterprise and Hewlett Packard Enterprise-recommended third-party software that was added manually or by using the SPP.
  - Name—The name of the software.
  - Description—A description of the software.
  - Version—The software version.

The versions of the firmware components displayed on this page indicate the firmware versions available in the firmware flash components that are saved on the local operating system (for example, the hp-firmware-ilo4 RPM on Linux systems). The displayed version might not match the firmware running on the server.

- **Running Software**—Lists all of the software that is running or available to run on the managed server.
  - Name—The name of the software.
  - Type—The software type. The following values are valid: Application and OS Software.
  - File path—The file path of the software.

- **Installed Software**—Lists all of the software installed on the managed server. The Installed Software list displays the name of each installed software program.

To display a complete set of data on this page, AMS must be installed.
There are a number of configuration, control, and monitoring options that you can use with your multiviewer. All multiviewer control, test, and monitoring capabilities can be accessed remotely using Layout Designer or through network control options such as Magellan Control Panel. This diagram illustrates a typical control and monitoring scenario:

**EPIC™ MV Configuration and Control**

All control and monitoring communication with the multiviewer occurs through the EPIC™ MV’s Ethernet port.

For information about making network connections, see Network Connections.

**Starting and Stopping the EPIC MV**

To run EPIC MV, start the KayakServer.bat file.
To stop EPIC MV, terminate Kayak Server.

**Updating Software and Firmware**

Your multiviewer comes with all the software and firmware already installed. However, you may occasionally need to update some or all software or firmware components.

The following sections outline individual components that can be updated:

- Updating the Multiviewer Core Application
- Updating Layout Designer Software (on page 78)

You may also need to update non-multiviewer-specific software and firmware to enable features or functionality with EPIC™ MV.

**Determining Software and Firmware Versions**

You may occasionally want to check software and firmware versions, to determine if updates are necessary, optional or even available. You may also want to check software and firmware versions, to ensure that updates were executed complete and correctly.

To check your software and firmware versions, follow these steps:

In Layout Designer, choose Tools > Advanced Configuration.

1. Select the Version tab.

To determine the firmware version, follow these steps:

1. In Device Manager, expand ‘Imagine Communications Devices’ list.
2. Right-click on any of the EPIC-MV-UCIP card and select Properties.
3. Locate the Driver Version field.

**Updating Multiviewer Software and Firmware**

Do not update the Multiviewer firmware while the EPIC™ MV application is running.

FlowFirmwareUpdater is a tool that updates all the drivers as required on your EPIC MV. Firmware upgrade does not include Layout Designer, which you should update separately. See Updating Layout Designer Software (on page 78).

1. Download or otherwise retrieve the executable upgrade file.
   Check SalesForce for the EPIC release package.
2. Close the EPIC MV core application:
   a. Locate the KayakServer running in the background.
b. Click Close (the X in the top right corner) to terminate the application.

3. Browse to the location of the EPIC-MV-2PRO-WS-* .exe file, and then double-click the file. The EPIC™ MV Setup dialog box opens.

4. Read and accept the terms and conditions, and then click Install.
   The installation will upgrade the firmware (i.e. device drivers and firmware) if the version is older than the current version. A dialog box displays the progress. As various elements are updated, the dialog indicates what files are being updated.

   More than one progress bar may appear if multiple components need to be updated.
   A dialog box opens indicating that the firmware has been updated and that the EPIC-MV-UCIP card(s) are ready for use.

   A Flow NIC Configuration dialog box opens.

5. Click X to close the Flow NIC Configuration dialog box.
   The Hardware Configurator dialog box opens.


7. Press Generate XML.

8. Press OK to close the dialog box.

   Note: A pop up message box may ask you to shut down the EPIC™ MV. If it does, power cycle the EPIC™ MV by physically turning off the EPIC™ MV with the power button and then turning it on again in order to complete the upgrade.

Updating Layout Designer Software

Layout Designer should not be installed on the actual EPIC™ MV PC itself, but on a separate computer.
You must uninstall the Layout Designer software before installing an updated version. If you cancel the uninstallation process, you will not be able to install an updated version of the software. Only one version of Layout Designer can be installed on a given platform. If a different version of Layout Designer is installed already, you will be prompted to repair or remove. Once that Layout Designer install has been removed, you can install a new version.

Always install Layout Designer using "RunAsAdministrator".

1. Browse to the location of the Layout Designer *.msi file (if using Windows XP) or *.exe file (if using Windows Vista), and then double-click the file.
   
   An Application Maintenance dialog box opens.

2. Choose Remove, and then click Next.

3. On the Layout Designer 3.x Uninstall window, click Next to continue the uninstall process.

   A progress bar will appear on the screen.

4. When the uninstallation process is done, click Finish.

5. Return to the location of the Layout Designer *.msi file, and then double-click the file again.

   A Welcome to EPIC™ MV Designer 4.0 Installation Wizard window appears.

6. Click Next, and follow the instructions that appear on the screen to install the updated version of Layout Designer.

---

**NVIDIA Display Configuration**

An EDID is a file that describes what a monitor is capable of. When you start EPIC™ MV, it downloads the EDID information from the displays and loads it automatically. This file protects the displays from being damaged, and ensures that the failure of a single monitor (for example, if it is disconnected) does not cause the entire group of monitors to lose signal.

**OS View**

In addition to the EPIC-MV-DISP outputs, EPIC MV has a VGA monitor output that drives local configuration. See #15 on Back View (on page 19).

The main desktop should never be allocated to the NVIDIA controlled raster.

**Note:** iLO will not display on a monitor that is larger than 1920 x 1080.

### Updated nVidia Drivers

If your EPIC™ MV has an older nVidia driver such as version 361.91 (from February 8, 2016), the system needs to be upgraded to driver version 376.84 (or later).

To determine what drivers are installed on your EPIC™ MV, follow these steps:

1. Right click on the desktop and choose Screen Resolution.

2. On the screen that opens, choose Advanced settings.
3. On the Adapters tab of the Properties screen, choose Properties.

The Driver Version number appears on this screen.

For best results, first install the 375.63 drivers (from October 2016) and then the 376.84 drivers.

To update drivers, follow these steps:

1. Go to the nVidia website and download the drivers.
2. Launch the driver installer and follow the instructions that appear on the screen.

**Note:** Do not uninstall prior nVidia drivers. If you uninstall prior nVidia drivers, your system can wind up in a state where the driver cannot be updated or downgraded, and a complete system rebuild is required.

---

**Forcing VGA on EPIC™ MV with no VGA Cable Connected**

Follow these steps to configure the VGA port so that EPIC™ MV will recognize the display drivers and permit remote viewing of iLO data without a monitor.

   
   You can get there by right-clicking on the desktop and choosing Screen Resolution, or from the Start menu by choosing Control Panel > Display > Adjust Resolution.

2. Click Detect to make it find another device.

3. Force connect the VGA to it the additional device, make sure you have chosen the on board graphics card.

4. Click Apply.

5. Place a check beside Make this my main display.

6. Click Apply.
SDN Orchestrator Configuration and Control

EPIC™ MV devices are added to SDNO via the switch they are connected to. They are added as IPVR devices. See Adding a Switch as a Device (on page 82), and please refer to your SDNO documentation.

The EPIC™ MV system has support for up to 4 physical PCIe hardware slots to hold the EPIC-MV-UCIP or EPIC-MV-3G boards. It also has six network ports that can be used for compressed video over IP (CIP).

<table>
<thead>
<tr>
<th>EPIC™ MV Slots</th>
<th>SDNO Slots</th>
<th>Available Ports</th>
<th>Channels per Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1, 2, 3, 4</td>
<td>32</td>
<td>4 copper 1-GB NICs on the EPIC™ MV system that can be used for Compressed video over IP (CIP). See #14 on Back View (on page 19).</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>EPIC-MV-UCIP: 1, 2</td>
<td>EPIC-MV-UCIP:  • 12 if 1.5 Gb video  • 6 if 3Gb video EPIC-MV-3G: 12</td>
<td>Physical location of an EPIC-MV-UCIP or EPIC-MV-3G board.</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>EPIC-MV-3G: 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>1, 2</td>
<td>256</td>
<td>2 10-GB NICs on the EPIC™ MV system. Slot 7 may not available for compressed video over IP (CIP) if the system is configured for Pip Sharing. See #10 on Back View (on page 19).</td>
</tr>
</tbody>
</table>

To configure these slots, ports, and channels, see Adding Destinations (on page 83) and Adding Sources for your Channels (on page 84).
Adding a Switch as a Device

External switches (such as Brocade and Arista) need to be added as IP Virtual Router (IPVR) devices in SDN Orchestrator. To add a Brocade or Arista switch, follow these steps:

1. Click **Add Devices** in the **Hardware Foundry**.
2. Enter a unique **Name** for the IPVR device.
3. Select **Vendor** as **Imagine Communications**.
4. Select **IPVR** from the **Family** drop down.
5. Under **Management**, choose whether this will be a **managed** or **unmanaged** switch.  
   Note: Arista and Brocade are managed switches; all other switches are currently unmanaged. Also see Managed/Unmanaged Switches and Sources/Destinations.
6. Select the appropriate **Protocol** based on the switch being used.  
   - Select **NETCONF** for a **Brocade** switch  
   - Select **JSON RPC** for an **Arista** switch
7. In the **Primary IP** and **Secondary IP** fields, enter the management IP addresses of your Brocade or Arista switch.  
   Note: If you have only one switch, enter the SAME IP Address in both fields.
8. Under **Data VLAN**, in the **Primary** and **Secondary Switch** fields, enter the VLAN IDs created during switch configuration.
9. Enter the **Username** and **Password** details to log into the switch via the management port (admin as username and password as password is the default if it has not been changed).
10. Click **Add**. This will create a new device in the system.
Adding Destinations

Adding destinations is the process you will go through to configure the channels that will be available to your PIPs, for selection in Layout Designer, etc. Destinations in your EPIC-MV-UCIP and EPIC-MV-3G boards, in addition to Compressed video over IP, are configured using SDNO. The only inputs to your EPIC™ MV that are not directly configured in SDNO are PIP Shares from other EPIC™ MV devices, which are configured in SDNO at their original EPIC™ MV.

1. In the Database Foundry, select Database Editor.
2. On the Destinations tab, enter a number of Destinations (Channels) to create.
3. Enter a name for the channels.
4. Select the appropriate device type.
5. Select Managed for the Management Type.
   For EPIC™ MV 1.1, you must use SDNO (managed mode) to route channels.
6. Enter the IP address of the EPIC™ MV.
7. Enter the Port, Slot and number of Channels as per SDN Orchestrator Configuration and Control (on page 81).

8. Click Add Rows to see the destinations added.

Adding Sources for your Channels

You will add sources for compressed video over IP (CIP) and EPIC-MV-UCIP destinations, but not for SDI video (from EPIC-MV-3G boards) or PIP Shares (which are defined at their originating EPIC™ MV).

1. In the Database Foundry, select Database Editor.
2. On the Sources tab, enter a number of Sources to create.
3. Enter a name for the sources.
4. Select the appropriate device type.
5. Select Unmanaged for the Management Type.
   For EPIC™ MV 1.1, you must use Unmanaged mode to route CIP sources.
6. Enter the IP address and port of the multicast group(s).

![Image of Add Sources dialog](image.png)

7. Click **Add Rows** to see the sources you have created.

**Switching Sources to Destination PIPs**

Unless you are operating your EPIC™ MV in Unmanaged Mode, it should be configured on your network.

1. In Magellan CCS Navigator, add your EPIC™ MV devices in the Flat Matrix Editor.
2. Within SDN Orchestrator, configure your EPIC™ MV PIPs as destinations, and your inputs as sources. See your DSNO documentation for more information.
In the below image, the left column shows the EPIC™ MV PIPs. The right column shows available sources.
The menu in the top left has the following options:

---

**Adding Multiviewers to a Router Database**

After installing an output module in a router frame, you must configure a router matrix that includes your multiviewer output module. Using Navigator’s routing components, you can either create a new router matrix that includes your output modules, or you can add output modules to an existing routing matrix. Adding output modules to the routing matrix defines which router inputs will be used as input source audio and video.

The information below describes the different methods by which you can add an output module to a router database. It does not go into detail about any of these methods or about other aspects of editing a router database. For more information, please refer to the Volume 6 of your *Navigator User Manual*.

To complete this task, you should have a working knowledge of Navigator.

---

**Adding Output Modules by Polling**

The Poll option queries the control system for any programmable devices present in the system. Polling obtains information about the current configuration of each physical device, and compares it to the information found in the database to determine if the database information matches the actual configuration.

1. Start Navigator.
2. Right click on **Routers** in the **Navigation** pane, and then select **Create > Routing System** from the context menu.
The **New Routing System Configuration** dialog box opens.

3. In the **Name** field, enter a name for the EPIC™ MV.
   This is the name that will appear in the **Navigation** window.

4. Under **Create Options**, choose **Start from a blank configuration**.
   This selection allows you to designate a new EPIC™ MV, and then populate it manually or with a system poll.

5. Place a check beside **Perform System Poll**.

6. In the **Connection** field, choose **TCP/IP**.

7. Click **OK**, and then wait while Navigator searches the network.
   When the search is complete, a series of folders appear under the name you provided in the Navigation pane.

8. Right-click the **Frame** in the **Routers** folder, and then select Poll.
   Wait while Navigator polls the device.

9. When the frame poll is complete, double-click the Frame in the Routers folder.
   The **Edit Platinum Frame** dialog box appears.

10. On the **Configured Matrices** tab, click **Add**.

11. If required, make any changes to other settings in the dialog box, and then click **OK**.

12. Select the range of inputs to assign to EPIC™ MV, then right-click and choose **Assign to EPIC™ MV**.

13. Make any necessary changes to this screen, and then click **OK**.

### Configuring Multiviewers in Database Editor

1. To open the Router Database Editor, double-click on the item inside the routing system’s **Control Views** folder.
   In this dialog box, you can make the following changes:
   ▪ Configuring UMD names (on page 89)
   ▪ Configuring Discrete Audio Inputs
   ▪ Creating Destinations Representing EPIC™ MV Inputs (on page 89)
2. When your changes are complete, click Save, and then close the dialog box.

3. Right-click the frame in the Routing system, and select Download.

This loads the changes to the frame.

**Configuring UMD names**

On the Sources tab of the Database Editor dialog box, change the contents of the Name column to change the UMD names of devices on the multiviewer.

**Creating Destinations Representing EPIC™ MV Inputs**

1. Select the Sources tab in the Database Editor.
   Make sure the EPIC™ MV video matrix (EPIC™ MV V) and virtual matrix (EPIC™ MV PIPs) are mapped to the same sources.

2. Edit the PiP destinations as required.
   Information on different methods of editing your PiP destinations is included in Volume 6 of your Navigator User Manual.

3. Ensure that the correct destination names appear (or are assigned) to the correct control device(s).

**Configuring Salvos for use in Layout Designer**

You can create salvos within Navigator, and then create rules to trigger those salvos within Layout Designer or from the Multiviewer Onscreen Application. Follow these steps:

1. Right click on Salvos under the Routing system you created for your EPIC™ MV in the Navigation pane.

2. select Create > Routing Salvo.... from the context menu.
   The Salvo Editor opens.

3. Click New.
   The Rename Salvo dialog box opens.

4. Type a new name, and then click OK to save the name and close the window.
   Your salvo appears in the list at the left of the screen.
   You can now use the salvo editing tools to create your salvo. For complete information on the salvo editing tools, see your Navigator User manual or online help.

5. When you are done creating salvos, click Publish to Devices.

This sends the salvos and all other logical information, including the names.txt files, to applicable devices in the routing system. You can configure salvo triggering using Trigger Salvo and Change Salvo alarm actions in Layout Designer. See your Layout Designer documentation for more information.
Configuring Multiviewers in a Local Area Network

There are four 1G LOM ports. The primary (right-most) connector is set for default IP. The other four are set for DHCP.

The default IP address for your EPIC™ MV is 192.168.100.250. You can use this IP address to connect your multiviewer directly to Layout Designer or add EPIC™ MV to your network. Once you have added the multiviewer to your network, you can change its IP address to suit your network requirements.

Each multiviewer on the network must have an unique IP address.

Configuring multiviewers on a local area network includes the following steps:

1. Discovering EPIC™ MVs using the default IP address. This may involve first configuring the Layout Designer PC to be on the same subnet as the multiviewers. See Adding the Multiviewer to the Layout Designer Devices List (on page 91) and Preparing to Add EPIC™ MV to the Devices List (on page 90).

2. Changing EPIC™ MVs' IP addresses from their defaults to addresses that are within the range of the rest of your network. See Connecting to SDNO (on page 92).

3. Returning the Layout Designer PC to its original IP and subnet settings. See Returning the Layout Designer PC to its Original IP and Subnet Settings (on page 92).

Discovering EPIC™ MV Using Layout Designer

You can discover EPIC™ MV by adding its default IP address to Layout Designer’s Devices. You can connect Layout Designer to the EPIC™ MV, and then change the EPIC™ MV's IP address.

After you discover EPIC™ MV, change its IP address using Layout Designer. If you have not yet installed Layout Designer on your local PC, do so now. See Software Installation (on page 103).

When you use the Discovery tool to add EPIC™ MVs to the device list, Layout Designer scans the network and reports all devices with an IP address. The amount of time required for discovery depends on the number of devices you have on your network. Layout Designer may discover devices that you do not want to add to the devices list.

Preparing to Add EPIC™ MV to the Devices List

Before adding an EPIC™ MV to the Layout Designer Devices list, ensure that it is connected to the Layout Designer PC.

The PC can be directly connected to the EPIC™ MV using an Ethernet cross-over cable, or directly connected to the same hub or switch as the multiviewer using a normal Ethernet cable.

To connect your Layout Designer PC to an EPIC™ MV at its default IP address, follow these steps:

1. Make note of the IP address, subnet mask, and default gateway settings on your Layout Designer PC.

2. Change the network settings on your PC to the following:
• IP Address: 192.168.100.100
• Subnet Mask: 255.255.255.0
• Default Gateway: Blank

Adding the Multiviewer to the Layout Designer Devices List

1. Start Layout Designer.
2. From the toolbar at the top of the window, select File > New Configuration, or from the main menu, select Edit > Multiviewer Configuration.
   The Device Manager dialog box appears.

   ![Device Manager](image)

   Entering the Multiviewer’s Default IP Address

3. Click Add Device.
   A new device appears in the Device list.
4. Under Device Name, you can enter a new name for the EPIC™ MV.
5. Under IP Address, type the EPIC™ MV’s IP address.
6. Under Display, enter the display number onto which your layouts will be published.
7. To connect the EPIC™ MV to Layout Designer, click the Test button.
   - If the connection is valid, the ✅ icon is displayed under Connected.
   - If the connection is invalid, the ❌ icon is displayed under Connected.

   If your connection is reported as invalid, check the default IP address you entered, the IP address of your PC, and your Ethernet connections, and then click Test to test the connection again.
8. After you establish a valid connection, click **Save** to save the list and connection information.

**Connecting to SDNO**

Use Layout Designer’s **Advanced Configuration** dialog box to connect to SDN Orchestrator.

1. From the main menu, select **Tools > Advanced Configuration**. The **Advanced Configuration** dialog appears.

2. Under **Device Name**, select your new EPIC™ MV, and then click the **IP Settings** tab.

![Advanced Configuration Dialog Box](image)

**Changing the Multiviewer’s Default IP Address**

3. If your multiviewer communicates with the SDNO through external cables, click **ENET**, and then enter the IP address of that controller.

4. Click **Done**.

Repeat steps 2 - 4 for each EPIC™ MV device.

**Returning the Layout Designer PC to its Original IP and Subnet Settings**

If you changed your Layout Designer PC IP address to communicate with the EPIC™ MV at its default IP address, and you have successfully changed the EPIC™ MV IP address, you can now change the Layout Designer PC IP address, subnet mask and gateway settings to the original settings that you recorded in **Preparing to Add EPIC™ MV to the Devices List** (on page 90).
Controlling Your Multiviewer on a Network

You can use Magellan Control Panel to set CCS controllable parameters on your EPIC™ MV. CCS parameters allow you to select layouts, modify some layout attributes as well as monitor feedback from multiviewers.

For information about controlling EPIC™ MV using Magellan control panels, see your Magellan Router Control User Manual.

Parameters and Alarms

Use CCS Navigator in Control mode or Magellan network control panel to access CCS controllable parameters and alarms. You must discover the multiviewer before you can access CCS parameters and alarms (see Discovering Output Modules Using Navigator).

Multiviewer alarms function in the same way other CCS device Smart Alarms operate. For information about how CCS Alarms work, see your CCS Navigator documentation. Additional audio and video alarms can be viewed on display layouts and with Layout Designer software. See Alarms and Info Panels (on page 219) for more information about configuring and viewing on-screen audio and video alarms.
Parameters and alarms are divided into the following Navigator Control Window tabs.

Multiviewer Devices That Launch Control Windows

- Parameters for the multiviewer system as a whole appear in Multiviewer System Parameters and Alarms (on page 95).
- Each PiP has a separate control window. The contents are described in PiP Parameters and Alarms (on page 96).
- Parameters for an individual output module (of which there are four) appear in Multiviewer Module Parameters and Alarms (on page 98).

Parameter Table Notes

The parameters are listed in the order that they appear in CCS Navigator.

When viewing the control parameter tables, observe the following:
- Shaded table rows indicate read-only (feedback) parameters. Some Read-only parameters can be modified using Layout Designer.
- Bold parameter options indicate the default settings for the parameter.

**Multiviewer System Parameters and Alarms**

Each display output has its own set of parameters and alarms. To access these, in the Network view, click the multiviewer’s system icon, and select either the **Parameters** or **Alarms** tab.

See [Initial Layout Designer Configuration](on page 106) for information on configuring for Independent mode.

The two tables below list the system parameters and system alarms.

### Multiviewer System Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Function</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameters</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Name</td>
<td>Displays the name of the current output module.</td>
<td>(displayed system name)</td>
</tr>
<tr>
<td>Active Layout Name</td>
<td>Displays the name of the layout that is active on this output (lists all layouts stored on the Multiviewer module)</td>
<td>(name of currently active layout)</td>
</tr>
<tr>
<td><strong>Parameters &gt; Virtual GPI</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Virtual GPI (1-16)</td>
<td>Renders the specified virtual GPI as active or inactive</td>
<td>• Disable • Enable</td>
</tr>
<tr>
<td><strong>Parameters &gt; Event Control</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Global Event Name</td>
<td>Choose an event from the drop-down menu. Events are created in Layout Designer. See Configuring Layout Events and Global Events (on page 238)</td>
<td>&lt;List&gt;</td>
</tr>
<tr>
<td>Enable Event</td>
<td>Enables the selected event</td>
<td>• Disable • Enable</td>
</tr>
<tr>
<td>Enable All Events</td>
<td>Enables all events</td>
<td>• Disable • Enable</td>
</tr>
</tbody>
</table>

### Multiviewer System Alarms

<table>
<thead>
<tr>
<th>Alarm Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Major Summary</td>
<td>Active if any alarm condition is reported (priority &gt; 7) for the system</td>
</tr>
<tr>
<td>System Minor Summary</td>
<td>Active if any alarm condition is reported (4 &lt; priority &lt; 7) for the system</td>
</tr>
<tr>
<td>System Communication</td>
<td>Master module has lost connection to a slaved module</td>
</tr>
</tbody>
</table>
### PiP Parameters and Alarms

You can access PiP parameters and alarms for each PiP that is associated with a currently active layout.

To access the PiP parameters and alarms, follow these steps:

1. In the Network view, double-click or expand the **PiP** folder.
   - Each PiP associated with the layout is listed in the Network view.
2. To access an individual PiP’s parameters, click the PiP icon, and in Control mode, click the **Parameters** tab.
3. To view a consolidated list of PiP alarms, click the **Alarms** tab.

Here are the CCS parameters and alarms for each PiP.

<table>
<thead>
<tr>
<th>Alarm Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failure</td>
<td></td>
</tr>
<tr>
<td>System LTC Failure</td>
<td>System lost connection to input LTC, if configured</td>
</tr>
<tr>
<td>System GPIO Failure</td>
<td>System lost connection to external GPIO device, if configured</td>
</tr>
</tbody>
</table>

### PiP Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Function</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameters</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Displays the PiP name</td>
<td>String (always shows PiP)</td>
</tr>
<tr>
<td>Static</td>
<td>Displays the label text on the selected PiP</td>
<td>String (displayed label text)</td>
</tr>
<tr>
<td>Display</td>
<td>Identifies which output display device is currently</td>
<td>String (display name)</td>
</tr>
<tr>
<td>Full Screen Enable</td>
<td>Activates/deactivates full-screen view of the selected PiP</td>
<td>• Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Disable</td>
</tr>
<tr>
<td><strong>PiP Location</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X Offset</td>
<td>Displays the offset value of the PiP’s horizontal (x)</td>
<td>(offset value)</td>
</tr>
<tr>
<td></td>
<td>position in the layout.</td>
<td></td>
</tr>
<tr>
<td>Y Offset</td>
<td>Displays the offset value of the PiP’s vertical (Y)</td>
<td>(offset value)</td>
</tr>
<tr>
<td></td>
<td>position in the layout.</td>
<td></td>
</tr>
<tr>
<td>X Size</td>
<td>Displays the value of the PiP’s horizontal (X)</td>
<td>(value)</td>
</tr>
<tr>
<td></td>
<td>position in the layout.</td>
<td></td>
</tr>
<tr>
<td>Y Size</td>
<td>Displays the value of the PiP’s vertical (Y) position in the layout.</td>
<td>(value)</td>
</tr>
<tr>
<td>PiP State</td>
<td>Indicates if the PiP is active in the layout</td>
<td>• <strong>Disabled</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Enabled</strong></td>
</tr>
</tbody>
</table>
## PiP Alarms

<table>
<thead>
<tr>
<th>Alarm Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Video Summary</td>
<td>Active if any video alarm is reported</td>
</tr>
<tr>
<td>Global Audio Summary</td>
<td>Active if any audio alarm is reported</td>
</tr>
<tr>
<td>Global Tally Summary</td>
<td>Active if any tally alarm is reported</td>
</tr>
<tr>
<td>PiP Audio Ch 1 Missing -</td>
<td>An audio signal is not present on the PiP audio channel indicated (Ch1–Ch16).</td>
</tr>
<tr>
<td>PiP Audio Ch16 Missing</td>
<td></td>
</tr>
<tr>
<td>PiP Audio Ch 1 Peak -</td>
<td>The audio level on the PiP audio channel indicated (Ch1–Ch16) is over the set peak threshold value.</td>
</tr>
<tr>
<td>PiP Audio Ch16 Peak</td>
<td></td>
</tr>
<tr>
<td>PiP Audio Ch 1 Low -</td>
<td>The audio level on the PiP audio channel indicated (Ch1–Ch16) is under the set low threshold value.</td>
</tr>
<tr>
<td>PiP Audio Ch16 Low</td>
<td></td>
</tr>
<tr>
<td>PiP Audio Ch 1 Silence -</td>
<td>The audio level on the PiP audio channel indicated (Ch1–Ch16) is under the set silence threshold value.</td>
</tr>
<tr>
<td>PiP Audio Ch16 Silence</td>
<td></td>
</tr>
<tr>
<td>Audio Group 1 Missing -</td>
<td>The specified audio group is not present....</td>
</tr>
<tr>
<td>Audio Group 4 Missing</td>
<td></td>
</tr>
<tr>
<td>Format Change</td>
<td>Indicates that the video input format has deviated from its defined standard</td>
</tr>
<tr>
<td>SD EDH Error</td>
<td>Reports recurring EDH errors in the standard definition video signal</td>
</tr>
<tr>
<td>HD CRC Error</td>
<td>Indicates that the internally calculated CRC value is different from the received CRC value</td>
</tr>
<tr>
<td>Loss of Video</td>
<td>Indicates that the multiviewer hardware can no longer detect a video signal from the video channel</td>
</tr>
<tr>
<td>CC Missing</td>
<td>Indicates that closed captioning (can be HD or SD) is not present in the incoming video stream</td>
</tr>
<tr>
<td>CC Not Updating</td>
<td>Indicates that closed captioning is not updating correctly in the incoming video stream</td>
</tr>
<tr>
<td>WSS Missing</td>
<td>Indicates that WSS is not present in the incoming video (should be present in SD625 only)</td>
</tr>
<tr>
<td>Video Freeze</td>
<td>Indicates that the input video image is frozen (static) according to user-defined frozen picture delay (duration), percent of frozen video in the frame, and amount difference between pixels percent tolerance</td>
</tr>
<tr>
<td>Video Black</td>
<td>Indicates that the input video image is considered a black picture according to user-defined percentage non-black picture, delay (duration), and black level threshold values</td>
</tr>
<tr>
<td>VChip Data Missing</td>
<td>Indicates that there is no V-chip data in the incoming video stream</td>
</tr>
<tr>
<td>VITC Missing</td>
<td>Indicates that there is no VITC in the incoming video stream</td>
</tr>
<tr>
<td>CC Not Valid</td>
<td>Indicates that the closed captioning data in the incoming video stream is not usable</td>
</tr>
<tr>
<td>Alarm Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Teletext Missing</td>
<td>Indicates that there is no teletext in the incoming video stream</td>
</tr>
<tr>
<td>Teletext Not Updating</td>
<td>Indicates that the teletext data in the incoming video stream is frozen</td>
</tr>
<tr>
<td>Teletext Not Valid</td>
<td>Indicates that the teletext data in the incoming video stream is not usable</td>
</tr>
<tr>
<td>AFD Missing</td>
<td>Indicates that AFD data is not present in the incoming video</td>
</tr>
<tr>
<td>AFD Format Change</td>
<td>Indicates that the AFD information has changed from its previous format</td>
</tr>
<tr>
<td>Audio Format Change</td>
<td>Indicates that the audio format has switched from Dolby D, Dolby E, or PCM, or indicates any format change</td>
</tr>
<tr>
<td>Dolby E Program Change</td>
<td>Indicates that the Dolby program format has deviated from the one specified</td>
</tr>
<tr>
<td>VChip Mismatch</td>
<td>Indicates that the V-chip data in the incoming video stream does not match the expected rating</td>
</tr>
<tr>
<td>WSS Format Change</td>
<td>Indicates that the WSS information has changed from its previous format</td>
</tr>
<tr>
<td>TS Sync Loss</td>
<td>Indicates that the transport stream has lost sync</td>
</tr>
<tr>
<td>Sync Byte Error</td>
<td>Indicates that the sync byte is not equal to 47 hexadecimals</td>
</tr>
<tr>
<td>Continuity Count</td>
<td>Indicates that an error has occurred with packets being out of order, or a packet being lost, or a packet being duplicated</td>
</tr>
<tr>
<td>PAT Error</td>
<td>Indicates that the packet ID hasn't appeared recently, or is duplicated, or is lost</td>
</tr>
<tr>
<td>PID Error</td>
<td>Indicates that a PID has been received that doesn't refer to an actual data stream</td>
</tr>
<tr>
<td>PMT Error</td>
<td>Indicates that the Program Map Table (PMT) has not come up on the PID that is referred to in the PAT</td>
</tr>
<tr>
<td>BBC SCTE 104 Alarm</td>
<td>Indicates that the SCTE 104 BBC data is missing or in an error state</td>
</tr>
</tbody>
</table>

**Multiviewer Module Parameters and Alarms**

Multiviewer module alarms apply to the device hardware. To access the multiviewer module alarms, in the Network view, click the Multiviewer module icon, and select the **Alarms** tab. There are no parameters at this level.

**Multiviewer Module Parameters**

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Function</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Type</td>
<td>Displays the module type</td>
<td>(displayed Master)</td>
</tr>
<tr>
<td>System Name</td>
<td>Displays the name of the current output module</td>
<td>(displayed system name)</td>
</tr>
</tbody>
</table>
### Multiviewer Module Alarms

<table>
<thead>
<tr>
<th>Alarm Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major Alarm Summary</td>
<td>Active if any alarm condition is reported (priority &gt; 7) for the module.</td>
</tr>
<tr>
<td>Minor Alarm Summary</td>
<td>Active if any alarm condition is reported (4 &lt; priority &lt; 7) for the module.</td>
</tr>
<tr>
<td>CPU Over Temperature</td>
<td>The maximum operating temperature of the module’s central processing unit has been exceeded.</td>
</tr>
<tr>
<td>GPU Over Temperature</td>
<td>The maximum operating temperature of the module’s graphics processing unit has been exceeded.</td>
</tr>
<tr>
<td>Main Board Over Temperature</td>
<td>The maximum operating temperature of the module’s main circuit board has been exceeded.</td>
</tr>
<tr>
<td>Storage Over Temperature</td>
<td>The maximum operating temperature of the module’s storage device has been exceeded.</td>
</tr>
<tr>
<td>Fan Unit 1 Failure</td>
<td>Cooling Fan Unit #1 is not operating.</td>
</tr>
<tr>
<td>Fan Unit 2 Failure</td>
<td>Cooling Fan Unit #2 is not operating.</td>
</tr>
</tbody>
</table>

### Configuring JLCooper eBOX in Layout Designer

You can use JLCooper eBOX units to add GPIO functionality to your EPIC™ MV. For information on connecting a JLCooper eBOX, see [External Hardware Components](#) and the documentation that came with the unit.

The first JLCooper eBOX that is connected to the multiviewer using Ethernet must be set up as a server, and any following eBOX devices should be configured as clients. Up to ten eBOXes can be connected. Information on configuring clients and servers is included in your JLCooper eBOX documentation.

To configure your multiviewer to communicate with the JLCooper eBOX, follow these steps:

1. Right-click a device in the **Multiviewers** window, select **Advanced Configuration**, and then click on the **External Devices** tab.
2. (Optional) In the **Name** field, enter a name for the device.
3. Under **Type**, select **JL Cooper E-Box**.
4. Under **Port**, select **TCP/IP**.
   - The right side of the dialog box may update to display IP settings.
5. Under **IP**, enter the IP address of the JLCooper eBOX.
   - 192.168.254.102 is the default IP address. Depending on the way your eBOX is connected to the multiviewer, you may need to change this so both devices are on the same subnet. This is not necessary if they are connected directly using an Ethernet cross-over cable. See your [eBOX Users Manual](#) for information on changing the device’s IP address.
6. Under **IP**, enter the IP Port of the JLCooper eBOX.
   - The default port is 23.
7. Click Add.
   The JLCooper eBOX appears in the table below the Add button.
8. Click Done to close the Advanced Configuration dialog box.

Configuring the Multiviewer to share JLCooper eBoxes

You can connect up to four eBoxes (Part number HV-GPIO-24E) to an EPIC™ MV multiviewer, providing up to 96 GPI/O triggers.

Connecting Multiple eBoxes to a Single Multiviewer

1. Configure a multiviewer to connect to multiple eBoxes, following the steps in Configuring JLCooper eBOX in Layout Designer (on page 99).
2. Configure a second multiviewer to connect to an eBox as in Step 1, with the following changes:
   ▪ Use the IP address of the multiviewer configured in Step 1.
   ▪ Use IP port 49153.
3. To configure each additional multiviewer to connect to a multiviewer configured with an eBox, increment the IP port number by one each time (port 49154, 49155, and so on).
To configure the eBox server port, edit the settings.xml eBoxServerPort on the multiviewer that has the eBox physically connected.

Configuring Multiple Multiviewers to Multiple JLCooper eBoxes

You can connect multiple multiviewers to up to ten JLCooper eBoxes.

Note: The EBoxServerPort parameter in Settings.xml file defines the base starting port number. This parameter setting is only applicable to the master multiviewer.

Multiple JLCooper eBoxes Connected to Multiple Multiviewer Devices

1. On the Advanced Configuration > Ext. Devices Tab, configure the master multiviewer to point to all eBOXes using the port defined in the EBoxServerPort parameter in the Settings.xml file. The default is 23. In the figure above, the master multiviewer points to nine eBoxes on port 23.

2. On the Advanced Configuration > Ext. Devices Tab, configure the slave multiviewers to point to the master multiviewer using the starting port number (port 49154, 49155, and so on). The slave multiviewer’s port number automatically increments by one for each eBOX configured.

Assigning Input and Output Triggers in Layout Designer

Configuring GPIO is done through Layout Designer’s Alarms configuration. When any object is selected in Layout Designer there is an alarms tab available. From the alarms tab, an alarm template can be created that will allow the setup of conditions for GPI's to trigger or actions that will fire a GPO.
A run through to add a GPI trigger to a window with a tally in Layout Designer.

1. Drop a window with a tally onto Layout Designer canvas.
2. With the alarms tab in front, select New Template.
3. Enter a name for the template.
4. Enter a name for the condition.
5. Select the priority.
6. Select the target.
   - Auto will pick the first applicable target available when an alarm template is applied to an object. For example, if there is a Tally indicator in a window it will set the state of that tally according to the priority selected. Note: GPO is an option.
7. Click Add.
8. Select GPI.
9. Enter a source number. This corresponds to the GPI input number on the eBox.
10. Click Done.
11. Select the new template.
12. Click Apply to selected. This will apply the condition to the window.
   - Note: On the left the will be the condition and an option to change the target. For GPI outputs, the output GPI output number can be selected.
Software Installation

Layout Designer Minimum System Requirements

You must use Layout Designer to create and modify layouts, and you can use it to remotely control a layout.

Layout Designer is installed on a separate PC that is on the same network as your multiviewer hardware. The PC where Layout Designer is installed should meet the following requirements:

- Intel™ dual-core processor or higher
- 2.0 GB or more of physical memory (RAM)
- Microsoft® Windows® XP, Windows Vista, Windows 7 (32- or 64-bit), Windows 8, or Windows 10
- Monitor with SXGA (1280 x 1024) or higher resolution

For best results, set the display font size to Normal (Control Panel > Display > Appearance > Font Size).

Installing Layout Designer

Install Layout Designer on a PC that meets the recommended system requirements. Your PC does not need to be connected to the multiviewer system to install Layout Designer.

You will need Microsoft .NET Framework 3.5. If this application has not already been installed on your system, download it or install it from the supplied CD.

If you have another version of Layout Designer installed on your system, remove it before installing the upgraded version. Do this by clicking Explorer on the Multiviewer Control Panel, and then using the Add/Remove Programs feature in the Windows Control Panel.

To install the Layout Designer software

Close all other applications running on the PC, and then insert the Documentation and Product Resources DVD into the PC DVD-ROM drive.

1. Click Software Applications > Layout Designer x.x (where x.x is the release version of the software) > Layout Designer-v.x.x setup.exe.
2. Follow the on-screen instructions to install the software.

![Software Installation](image)

If the installation does not start automatically, double-click the Layout Designer-V*-Setup.exe file on the DVD (where "**" is the version number).

---

**Closing Layout Designer**

When you close Layout Designer, the following dialog box appears:

![Closing Layout Designer](image)

Choose one of the following options:

- **Exit without saving** - closes all layouts, discarding changes or updates, and exits Layout Designer.
- **Exit with Saving All Layouts** - saves all changes to all open layouts, and then exits Layout Designer.
- **Exit With Saving One by One** - for each layout that has changes, asks if you do or do not want to save changes, or if you want to cancel out of closing the multiviewer. If you do not click **Cancel** at any time, Layout Designer closes.
• **Cancel** - does not save any layouts, does not close Layout Designer.

Layouts that have been changed since they were last saved have an asterisk (*) in the layout tab.
Initial Layout Designer Configuration

Layout Designer needs to be configured to work with not just your multiviewer hardware, but also to the other devices in your system.

Once you add multiviewer devices, they appear in the Layout Designer Multiviewers panel.

The chapter contains the following sections:

- Adding Output Displays to the Device List
- Configuring EPIC MV Output Display Devices (on page 109)
- Setting Up External Devices (on page 111)
- Getting Version Information (on page 114)
- Configuring Network Time Protocol (NTP) (on page 114)
- Enabling Alarm Logging (on page 115)

When No Multiviewers are Connected

When a computer running Layout Designer cannot discover any multiviewers on the network, the following functionality will not be available in Layout Designer:

- Enable Control button on toolbar
- Global Alarms and Global Events options in the Rules menu
- Start, Exit, Connect, Disconnect, Edit, Delete, Restart, Reboot, and Shutdown Multiviewer options in Tools menu
- On Screen Messages Reset and Preview Margins on Layout properties pane
- Publish option in File menu
- Download and Upload tools in the IP Configuration Manager (See IP Configuration Manager)

You can enable these features by connecting to a multiviewer. See Device Manager Dialog Box (on page 106) for more information.

Device Manager Dialog Box

To connect Layout Designer to your multiviewer, you need to add it to the Device list. Then you can configure the connected output display, etc.
To open the Device Manager dialog box, select **Edit > Multiviewer Configuration** from the application menu.

![Device Manager dialog box](image)

1. Lists by name the devices that have been added to the Devices list. You can add or edit the name of a multiviewer at any time.

2. Lists the IP address of devices in the Devices list. You can add devices to the list manually by typing the IP address of a multiviewer in the **IP Address** field.

3. Displays the number of multiviewer systems or independent displays. The number of displays depends on the display mode; for example, Spanned mode has one.

4. Tests the validity of the device connection by pinging the IP address. Invalid connections are indicated by the **X** icon.

   The Multiviewer application must be running to pass this test.

5. When **Connect to selected device** is checked, Layout Designer connects to the specified multiviewer immediately once you click **Save** on the Device Manager dialog box.

### Adding Devices Manually

To add a multiviewer manually, it must have a valid IP address and reside on the same subnet as the PC that is running Layout Designer.
To add a device manually:

1. Open the **Device Manager** dialog box.
2. Click **Add Device**.
   
   A new row appears in the **Device** list.

3. Under **Device Name**, enter a new name for the multiviewer hardware.
4. Under **IP Address**, type the IP address of the multiviewer.
5. Under **Display**, type or select the number of the display on the multiviewer.
6. To test the validity of the connection, click **Test**.
    
   One of the following appears in the **Connection** column.

   ![Connection Status Icons](image)

   - The connection has not been tested.
   - The connection is valid.
   - The connection is invalid.

   If your connection is reported as invalid, check the IP address of the device that you want to add, and then test the connection again. The Multiviewer application must be running for this test to pass.

   For EPIC MV devices only, you need to create a row for each display output you are using on the multiviewer. That is, click **Add Device**, enter a name (or increment the name, something to help keep track of the relationship between displays), the IP address for that multiviewer (all displays on a single EPIC MV will have the same IP address), and the display number. Therefore, there can be up to 8 displays at a single IP address.

   For Platinum SX Hybrid devices, this process of creating multiple rows to represent individual displays on the multiviewer is handled automatically.

7. Click **Save** to save the list and connection information.

You are now ready to configure individual displays. See **Configuring EPIC MV Output Display Devices** (on page 109).

---

**Advanced Configuration**

The **Advanced Configuration** dialog box allows you to define different aspects of your device, including its timing, communication options, and output display format. Controls and settings are divided into the following tabs:

- **Display Configuration**, described in **Configuring EPIC MV Output Display Devices** (on page 109)
- **IP Settings**, described in **Connecting to SDNO Controller** (on page 111)
To open the Advanced Configuration dialog box, do either of the following:

- Right-click on a multiviewer in the Multiviewers panel and select Advanced Configuration.
- From the Application menu, choose Tools > Advanced Configuration.

### Configuring EPIC MV Output Display Devices

Your EPIC-MV-DISP module can output to one UHD or four 1080p displays. For information about connecting monitors and other devices, see Making System Connections (on page 49). To configure EDIDs for each display, see NVIDIA Display Configuration (on page 79).

To configure your output display devices, follow these steps:

1. On the Advanced Configuration dialog box, choose the Display Configuration tab.
2. For the entire system, choose a refresh rate. Options are 50 and 60 Hz.
3. Click Identify.
This causes a number to appear on each display port output, such that the first monitor has a white "1" overlaid on its output, the second monitor has a '2' overlaid, etc.

**Note:** To hide this display, click **Identify** again.

4. For each display, choose a **Resolution** and **Orientation**.

See the following topics:
- [Output Display Resolutions](on page 110)
- [Display Orientations](on page 110)

5. Place a check in the **Enabled** box for each display you are using.

Click **Save** to record the configuration settings in the Configuration.xml file. This does not publish the changes.

See Display Cloning (on page 111) for information about display cloning.

Changing any setting in this UI requires restart of the EPIC MV application (via kill and launch of the KayakServer UI) for the settings to take effect.

### Output Display Resolutions

Available resolutions are:

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Video Standard</th>
<th>Full Name</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>3840x2160</td>
<td>4K UHD</td>
<td>Ultra High Definition</td>
<td>16:9</td>
</tr>
<tr>
<td>2560x1600</td>
<td>WQXGA</td>
<td>Wide Quad Super Extended Graphics Array</td>
<td>16:10</td>
</tr>
<tr>
<td>2560x1440</td>
<td>QHD</td>
<td>Quad High Definition</td>
<td>16:9</td>
</tr>
<tr>
<td>2048x1536</td>
<td>QXGA</td>
<td>Quad Extended Graphics Array</td>
<td>4:3</td>
</tr>
<tr>
<td>1920x1440</td>
<td></td>
<td></td>
<td>4:3</td>
</tr>
<tr>
<td>1920x1200</td>
<td>WUXGA</td>
<td>Widescreen Ultra Extended Graphics Array</td>
<td>16:10</td>
</tr>
<tr>
<td>1920x1080</td>
<td>FHD</td>
<td>Full High Definition (1080p)</td>
<td>16:9</td>
</tr>
<tr>
<td>1600x1200</td>
<td>UXGA</td>
<td>Ultra Extended Graphics Array</td>
<td>4:3</td>
</tr>
<tr>
<td>1680x1050</td>
<td>WSGXGA+</td>
<td>Widescreen Super Extended Graphics Array Plus</td>
<td>16:10</td>
</tr>
<tr>
<td>1600x1024</td>
<td>WSGXGA</td>
<td>Widescreen Super Extended Graphics Array</td>
<td>3:2</td>
</tr>
<tr>
<td>1600x900</td>
<td>HD+</td>
<td>High Definition Plus (900p)</td>
<td>16:9</td>
</tr>
<tr>
<td>1440x900</td>
<td>WXGA+</td>
<td>Widescreen Extended Graphics Array Plus</td>
<td>16:10</td>
</tr>
<tr>
<td>1366x768</td>
<td>WXGA</td>
<td>Widescreen Extended Graphics Array</td>
<td>16:9</td>
</tr>
<tr>
<td>1280x1024</td>
<td>SXGA</td>
<td>Super Extended Graphics Array</td>
<td>5:4</td>
</tr>
<tr>
<td>1280x960</td>
<td>SXGA-</td>
<td>Super Extended Graphics Array Minus</td>
<td>4:3</td>
</tr>
<tr>
<td>1280x800</td>
<td>WXGA</td>
<td>Widescreen Extended Graphics Array</td>
<td>16:10</td>
</tr>
<tr>
<td>1280x768</td>
<td>WXGA</td>
<td>Widescreen Extended Graphics Array</td>
<td>5:3</td>
</tr>
<tr>
<td>1280x720</td>
<td>HD (720p)</td>
<td>High Definition Plus (720p)</td>
<td>16:9</td>
</tr>
<tr>
<td>1152x864</td>
<td>XGA+</td>
<td>Extended Graphics Array Plus</td>
<td>4:3</td>
</tr>
<tr>
<td>1152x720</td>
<td></td>
<td></td>
<td>16:10</td>
</tr>
<tr>
<td>1024x768</td>
<td>XGA</td>
<td>Extended Graphics Array</td>
<td>4:3</td>
</tr>
</tbody>
</table>
Display Orientations

Available orientation options are:

- **Landscape**: wider than tall
- **Portrait**: Taller than wide
- **Landscape (flipped)**: upside down landscape
- **Portrait (flipped)**: Upside down portrait

Display Cloning

On the **Advanced Configuration** screen's **Display Configuration** tab, each display can be configured to output to another display as well, so you don't have to maintain duplicate layouts etc.

1. Choose the display you want to output to another display.
2. Click **Clone** to the right of that display.
   - A drop-down menu opens.
3. Choose the other display you want to output this display to.

Both displays must be the same size and have the same format. As you assign displays, the list of available displays removes displays that are unavailable.

Connecting to SDNO Controller

EPIC MV can map inputs using SDNO. For Layout Designer to know where the information is coming from, you will need to enter the IP address of the controller.

1. Open the **Advanced Configuration** dialog box.
2. Select the **IP Settings** tab.
3. Enter the IP Address of your SDNO Controller.
4. Click **Done** to close the Advanced Configuration dialog box.

Setting Up External Devices

External devices for use with multiviewers include the JLCooper Electronics eBOX™ Quad Serial to Ethernet Interface for GPI control and monitoring, and UMD devices.

Adding External Devices

1. Open the **Advanced Configuration** dialog box.
2. Select the **External Devices** tab.

3. In the **Device Name** list, select the multiviewer that the external device is going to communicate with.

4. Beside **Name**, enter a descriptive title for your device.

5. Select the appropriate option from the **Type** list.

### Supported External Devices

<table>
<thead>
<tr>
<th>External Device</th>
<th>Function</th>
<th>Specific Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>TSL Protocol</td>
<td>Provides basic tally and UMD data</td>
<td>See <a href="#">UMD/Tally Option</a> (on page 269)</td>
</tr>
<tr>
<td>TSL 4.0</td>
<td>Adds full control of text and tally lamp colors to TSL protocol</td>
<td></td>
</tr>
<tr>
<td>TSL 5.0</td>
<td>Incompatible with earlier TSL protocols, can address more devices, over UDP or TCP/IP</td>
<td></td>
</tr>
<tr>
<td>JL Cooper E-Box</td>
<td>Provides GPI control and monitoring</td>
<td></td>
</tr>
<tr>
<td>Image Video Tally</td>
<td>Provides tally and UMD data</td>
<td></td>
</tr>
<tr>
<td>Kalypso Tally</td>
<td>Provides tally data</td>
<td></td>
</tr>
<tr>
<td>Ross Tally</td>
<td>Provides tally data</td>
<td></td>
</tr>
<tr>
<td>D-Series UMD</td>
<td>Provides UMD data</td>
<td></td>
</tr>
<tr>
<td>Sony Tally</td>
<td>Provides tally data</td>
<td></td>
</tr>
</tbody>
</table>
| Dak RTD             | Provides scoreboard data to an info panel or label. See [Using the Scoreboard Option](#) (on page 246) for more information. Supports only one device, and only over serial. | Port: COM port 1  
                        |                                               | Data Bits: 8  
                        |                                               | Baud rate: 9600  
                        |                                               | Parity: None  
                        |                                               | Stop: 1                                                                 |

1. Beside **Port**, select the communication port that the device is using.
   
   Devices can communicate through one of the following:
   
   - TCP/IP (TCP client)
   - TCP/IP_S (TCP server)
   - UDP/IP
   - COM Port (1-9)

2. Do either of the following:
   
   - If the device is communicating through TCP/IP, TCP/IP_S, or UDP/IP, enter the device’s IP address and port.
     
     The default IP address of the JL Cooper eBOX is 192.168.254.102, and its default port is 23.
   
   - If the device is communicating through COM Port, enter values for **Data Bits**, **Baud Rate**, **Parity**, and **Stop**.
     
     These settings should match those of the unit to be communicated with.

3. Click **Add**.
   
   A row is added to the list at the bottom of the dialog box.

4. Repeat steps to for each external device that you want to add.
Removing External Devices

If you are no longer using an external device to communicate with your multiviewer, remove it so that the multiviewer no longer accepts inputs from that source.

1. Open the Advanced Configuration dialog box.
2. Select the External Devices tab.
3. Select an item in the list near the bottom of the dialog box.
4. Click Remove.

The row is removed from the list.

Binding UMD Addresses to Input Sources

If you intend to use UMD devices for tally or dynamic labels, you must first bind the UMD address to an input source on the Source UMD tab.

1. Open the Advanced Configuration dialog box.
2. Select the Source UMD tab.

3. Do one of the following:
   - To set the UMD address for each individual feed manually, select the corresponding UMD number once, and then click it again to enter the correct value.
To set the UMD address in increments of one, select the first feed, and then click Set. The UMD address values start with the value that is in the UMD field.

To set all of the UMD addresses to the same value, select the first feed, and then click Fill. All of the UMD addresses become the same value as that set in the UMD field.

To set the UMD address for a range of feeds, select a feed in the Starting Source field, and then select a feed in the Ending Source field. The UMD values, whether they are created by clicking Set or Fill, apply only to the range of feeds within your selection.

To view the alias name on PiPs, rather than the external protocol name or the router database name, place a check beside Use Source Alias.

A Source Alias file can be edited in Microsoft Excel, and then saved as a *.csv (comma-separated file), using the following buttons:

- Import—Opens a Browse dialog box, where you can select a *.csv file to load.
- Export—Opens a Browse dialog box, where you can save the current source alias information as a *.csv file.

- Update—Updates the alias names on the currently selected multiviewer.
- Update All—Update the alias names on all connected multiviewers.

4. Click Done to accept the new values.

### Getting Version Information

Select the Version tab to see version information about the hardware and software components and keys, which is for informational purposes only.

### Configuring Network Time Protocol (NTP)

Network Time Protocol (NTP) synchronizes the clocks of computer systems over internet connections.

1. Open the Advanced Configuration dialog box.
2. Select the NTP tab.

![NTP Configuration](image)

3. Click Enable.
4. Enter the IP Address or URL of your NTP source.
5. Beside Update Interval, select the frequency with which the multiviewer will check for updates.
6. Click OK.
Enabling Alarm Logging

When alarm logging is enabled, alarms are added to the system log, when the Log Message alarm action is set for a particular alarm. See Setting Alarm Actions (on page 229).

1. Open the Advanced Configuration dialog box.
2. Select the Miscellaneous tab.
3. Click Enable Alarm Logging.

Performance Meters

You can view a meter showing EPIC-MV system (CPU) performance in the bottom right corner of the screen.

1. Open the Advanced Configuration dialog box.
2. Select the Miscellaneous tab.
3. Click Show Performance Meters.

This is normally used for diagnostic purposes, as it appears on all output displays when enabled. To deactivate the feature, click Show Performance Meters again.
When you start Layout Designer, the workspace will look something like this:

The Layout Designer workspace is the area from which you open, publish, create, and modify multiviewer display layouts. The workspace has quick-access menus and palettes to help you create and modify layouts and PiPs, as well as to configure audio meters, alarms, and metadata. You can customize the Layout Designer workspace to suit the tasks you are performing.

Each workspace element is described below:

1. **Application menu** - Provides access to Layout Designer’s main commands and options. In addition, the menu provides access to the software preference settings. See [Application Menus](on page 117).
2 **Application toolbar** - Provides quick access to commonly-used commands and options. Some of these options also appear in the Application menu. See Application Menus (on page 117) and Layout Designer Application Toolbar (on page 123).

3 **Tools palette** - Provides tools for adding and editing layout objects such as PiPs, labels, clocks, tally indicators, info panels, counters, and audio meters to the layout canvas. See Tools Palette (on page 125).

4 **Layout canvas** - Displays the layout that is being created or edited when a Layout Designer tab is open. More than one layout can be open at one time, but only one layout is visible in the layout canvas. Each layout can be viewed using the layout tab at the top of the canvas. See Layout Canvas (on page 127).

5 **Multiviewers panel** - Displays the multiviewer systems that are currently and previously connected to the Layout Designer. All systems that are displayed in the Multiviewers panel (connected and disconnected) have been configured by Layout Designer. For more information, see Multiviewers Panel (on page 127).

6 **Library panel** - Provides access to stored layout objects (PiPs, windows, info panels). Where applicable, each library tab lists the specific name of the object and provides a preview of how the object will appear in a layout. For more information, see Using the Layout Designer Library Panel (on page 147).

7 **Properties pane** - Provides access to user-configurable properties for the layout and layout objects currently displayed in the canvas. You can use the Properties pane to modify layout, window, and layout object properties. For information, see Layout Properties (on page 165) and Layout Object Properties (on page 171).

8 **Application status bar** - Displays the current status of the Layout Designer application and other operation information.

---

**Application Menus**

In some cases, the application menus duplicate commands and options that are accessible from the application toolbar shortcuts (see Layout Designer Application Toolbar (on page 123)). Some advanced configuration options are only available using the menus.

Note the following menu information:

- Shortcut keystrokes are listed to the right of the menu item.
- Commands that are not relevant to the selected mode are unavailable.
- The Layout Designer context menu can be accessed by right-clicking items in the layout window.

The following tables describe each Layout Designer menu item and its options.
### File Menu Items and Options

<table>
<thead>
<tr>
<th>Menu Item/Shortcut Key</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Blank Layout</strong></td>
<td>![Blank Layout Icon]</td>
<td>Opens a blank layout. See [Creating a New Layout from a Blank Layout](on page 158).</td>
</tr>
<tr>
<td><strong>Layout Using the Layout Creation Wizard</strong></td>
<td>![Layout Wizard Icon]</td>
<td>Opens the Layout Creation Wizard dialog box, from which you can create a customized layout. See [Creating a New Layout Using the Layout Creation Wizard](on page 152).</td>
</tr>
<tr>
<td><strong>Open</strong> Ctrl+O</td>
<td>![Open Icon]</td>
<td>Opens the Open dialog box, from which you can open a layout file that is stored on a local or network drive. See [Viewing Layouts](on page 160).</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td></td>
<td>Closes the layout that is currently open.</td>
</tr>
<tr>
<td><strong>Save</strong> Ctrl+S</td>
<td>![Save Icon]</td>
<td>Saves the layout as a .lay file to a previously specified file name and location. See [Saving Layouts](on page 159).</td>
</tr>
<tr>
<td><strong>Save As</strong></td>
<td>![Save As Icon]</td>
<td>Opens the Save As dialog box, from which you can specify a file name (.lay file) and location for the layout file. See [Saving Layouts](on page 159).</td>
</tr>
<tr>
<td><strong>Save All</strong> Ctrl+Shift+S</td>
<td></td>
<td>Saves all open layouts. See [Saving Layouts](on page 159).</td>
</tr>
<tr>
<td><strong>Page Margin Setup</strong></td>
<td>![Page Margin Icon]</td>
<td>Opens the Page Margin Setup dialog box where you specify the margin widths for the print out of the layout when you click Print Layout on the toolbar.</td>
</tr>
<tr>
<td><strong>Print</strong> Ctrl+P</td>
<td>![Print Icon]</td>
<td>Opens a Print dialog where you can choose a printer and print the selected layout.</td>
</tr>
<tr>
<td><strong>Publish</strong> F12</td>
<td>![Publish Icon]</td>
<td>Sends the currently displayed layout and any new changes to the selected multiviewer. See [Displaying and Publishing Layouts](on page 163).</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td></td>
<td>Closes the Layout Designer application.</td>
</tr>
</tbody>
</table>

### Edit Menu Items and Options

<table>
<thead>
<tr>
<th>Menu Item/Shortcut Key</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undo</strong> Ctrl+Z</td>
<td>![Undo Icon]</td>
<td>Cancels the last operation performed on the current layout. Layout Designer supports multiple levels of the Undo command.</td>
</tr>
<tr>
<td><strong>Redo</strong> Ctrl+Y</td>
<td>![Redo Icon]</td>
<td>Reinstates the last operation performed on the currently open layout when the Undo command has been used.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>![Delete Icon]</td>
<td>Deletes the selected layout object.</td>
</tr>
</tbody>
</table>
### Menu Item/Shortcut Key

<table>
<thead>
<tr>
<th>Menu Item/Shortcut Key</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td><img src="image" alt="File Copy Icon" /></td>
<td>Copies the selected layout object and places it on the clipboard, from which the object can be pasted to another location.</td>
</tr>
<tr>
<td>Cut</td>
<td><img src="image" alt="File Cut Icon" /></td>
<td>Cuts the selected layout object from the current location and places it on the clipboard, from which the object can be pasted to another location.</td>
</tr>
<tr>
<td>Paste</td>
<td><img src="image" alt="File Paste Icon" /></td>
<td>Pastes the last layout object placed on the clipboard by either a Cut or Copy command.</td>
</tr>
<tr>
<td>Select All</td>
<td><img src="image" alt="Select All Icon" /></td>
<td>Selects all objects in the layout.</td>
</tr>
<tr>
<td>Deselect</td>
<td><img src="image" alt="Deselect Icon" /></td>
<td>Cancels the selection of objects in the layout.</td>
</tr>
<tr>
<td>Break Window</td>
<td><img src="image" alt="Break Window Icon" /></td>
<td>Breaks apart the objects contained in a window.</td>
</tr>
<tr>
<td>Create a Window</td>
<td><img src="image" alt="Create a Window Icon" /></td>
<td>Creates a window from two or more selected layout objects.</td>
</tr>
<tr>
<td>Lock Window</td>
<td><img src="image" alt="Lock Window Icon" /></td>
<td>Prevents accessing the properties of individual layout objects within a window.</td>
</tr>
<tr>
<td>Bring to Front</td>
<td><img src="image" alt="Bring to Front Icon" /></td>
<td>Brings the selected window to the top of the layout; also available as a right click option on objects (Order &gt; Bring to Front).</td>
</tr>
<tr>
<td>Send to Back</td>
<td><img src="image" alt="Send to Back Icon" /></td>
<td>Sends the selected window to the bottom of the layout; also available as a right click option (Order &gt; Send to Back).</td>
</tr>
<tr>
<td>Multiviewer Configuration</td>
<td><img src="image" alt="Multiviewer Icon" /></td>
<td>Opens the Multiviewer Configuration dialog box that you use to modify your multiviewer configuration. See Initial Layout Designer Configuration (on page 106).</td>
</tr>
<tr>
<td>Preferences</td>
<td><img src="image" alt="Preferences Icon" /></td>
<td>Opens the Layout Designer Preferences dialog box, from which you can set your application preferences. See Setting Your Layout Designer Preferences (on page 138).</td>
</tr>
</tbody>
</table>

### View Menu Items and Options

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td><img src="image" alt="Properties Icon" /></td>
<td>Shows the Properties pane.</td>
</tr>
<tr>
<td>Multiviewers</td>
<td><img src="image" alt="Multiviewers Icon" /></td>
<td>Shows the Multiviewers panel.</td>
</tr>
<tr>
<td>Library</td>
<td><img src="image" alt="Library Icon" /></td>
<td>Shows the Layout Designer Library panel.</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Restore All Panel Default States</strong></td>
<td></td>
<td>Resets the <strong>Properties</strong>, Multiviewers, and <strong>Library</strong> panels to their default positions. You must restart Layout Designer for the change to take effect.</td>
</tr>
<tr>
<td><strong>Zoom In</strong></td>
<td></td>
<td>Magnifies the current display of the layout. Depending on the current view, each time you select <strong>Zoom In</strong>, the layout display is magnified by increments of 50% or 25%.</td>
</tr>
<tr>
<td><strong>Zoom Out</strong></td>
<td></td>
<td>Reduces the current display of the layout. Depending on the current view, each time you select <strong>Zoom Out</strong>, the layout display is reduced by increments of 50% or 25%.</td>
</tr>
<tr>
<td><strong>Fit on Screen</strong></td>
<td>![Fit on Screen Icon]</td>
<td>Resizes the layout so that entire layout is displayed in the available screen space. The display size is limited by the size of the <strong>Properties</strong> pane.</td>
</tr>
</tbody>
</table>

### Insert Menu Items and Options

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PiP</strong></td>
<td>![PiP Icon]</td>
<td>Inserts a PiP into the current layout. Inserted PiPs have default properties (width, height, and aspect ratio) that can be modified using the Properties pane. See About Picture-In-Pictures (PiPs).</td>
</tr>
<tr>
<td><strong>Label</strong></td>
<td>![Label Icon]</td>
<td>Inserts a new label into the current layout. Inserted labels have default properties that can be modified using the Properties pane. See About Labels (on page 208).</td>
</tr>
<tr>
<td><strong>Analog Clock</strong></td>
<td>![Analog Clock Icon]</td>
<td>Inserts an analog clock into the current layout. Inserted clocks have a default properties that can be modified using the Properties pane. See About Layout Clocks (on page 212).</td>
</tr>
<tr>
<td><strong>Digital Clock</strong></td>
<td>![Digital Clock Icon]</td>
<td>Inserts a default digital clock into the current layout. Clocks have a default size and style that can be modified using the Properties pane. See About Layout Clocks (on page 212).</td>
</tr>
<tr>
<td><strong>Tally</strong></td>
<td>![Tally Icon]</td>
<td>Inserts a default tally indicator into the current layout. Inserted tally indicators have default properties that can be modified using the Properties pane. See Creating Tally Indicators (on page 204).</td>
</tr>
<tr>
<td><strong>Audio Meter</strong></td>
<td>![Audio Meter Icon]</td>
<td>Inserts a default audio meter into the current layout. Inserted audio meters have default properties which can be modified using the Properties pane. See Creating Audio Meters (on page 201).</td>
</tr>
<tr>
<td><strong>5.1 Audio Meter</strong></td>
<td>![5.1 Audio Meter Icon]</td>
<td>Inserts a 5.1 stereo surround sound type audio meter into the current layout. Inserted audio meters have default properties which can be modified using the Properties pane. See Creating Audio Meters (on page 201).</td>
</tr>
<tr>
<td><strong>Info Panel</strong></td>
<td>![Info Panel Icon]</td>
<td>Inserts an overlay that provides data from a source or PiP on the display. See Info Panels (on page 240).</td>
</tr>
</tbody>
</table>
### Menu Item: Up/Down Counter
- **Icon**: Up/Down Counter
- **Description**: Inserts a counter that can be the target or trigger for alarms, and can count up or down. See [About Up/Down Counters](on page 215).

### Menu Item: Add Object to Library
- **Icon**: Add Object to Library
- **Description**:
  - **PiP** - Adds the selected PiP to the PiPs section of the Library panel
  - **Window** - Adds the selected window to the Windows section of the Library panel
  - **Info Panel** - Adds the selected info panel to the Info Panels section of the Library panel

### Format Menu Items and Options

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy Properties</strong></td>
<td><img src="CopyIcon.png" alt="Copy Icon" /></td>
<td>Copies the properties from the selected object so that they can be pasted to other objects. See [Copying and Pasting Layout Object Properties](on page 174).</td>
</tr>
<tr>
<td><strong>Paste Properties</strong></td>
<td><img src="PasteIcon.png" alt="Paste Icon" /></td>
<td>Pastes all of the copied properties to the selected object. See [Copying and Pasting Layout Object Properties](on page 174).</td>
</tr>
<tr>
<td><strong>Paste Selected Properties</strong></td>
<td><img src="PasteSelectedIcon.png" alt="Paste Selected Icon" /></td>
<td>Opens the Paste Category dialog box, from which you can select the properties you want to paste to the selected object. See [Copying and Pasting Layout Object Properties](on page 174).</td>
</tr>
<tr>
<td><strong>Align</strong></td>
<td><img src="AlignIcon.png" alt="Align Icon" /></td>
<td>Opens a drop-down menu, from which you can select the following alignment commands:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Left</strong> - Aligns the selected layout objects along the left axis of the first object selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Right</strong> - Aligns the selected layout objects along the right axis of the first object selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Top</strong> - Aligns the selected layout objects along the top axis of the first objects selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Bottom</strong> - Aligns the selected layout objects along the bottom axis of the first object selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Center Vertical</strong> - Aligns the selected layout objects along a vertical axis that runs through the center of the layout window</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Middle Horizontal</strong> - Aligns the selected layout objects along a horizontal axis that runs through the middle of the layout window</td>
</tr>
</tbody>
</table>

See [Aligning and Distributing Objects in a Layout](on page 177).
### Distribute

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Distribute  | ![Icon](image) | Opens a drop-down menu, from which you can select the following distribute commands:  
  - **Widths** - Distributes the distance between the selected layout objects by width  
  - **Heights** - Distributes the distance between the selected layout objects by height  
  See [Aligning and Distributing Objects in a Layout](on page 177). |

### Tools Menu Items and Options

<table>
<thead>
<tr>
<th>Menu Item/Shortcut Key</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to Device</td>
<td><img src="image" alt="Icon" /></td>
<td>Connects Layout Designer to the selected multiviewer.</td>
</tr>
<tr>
<td>Disconnect From Device</td>
<td><img src="image" alt="Icon" /></td>
<td>Disconnects Layout Designer from the currently connected multiviewer.</td>
</tr>
<tr>
<td>Edit Device</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens the <strong>Device Manager</strong> dialog box, from which you can edit the configuration of the selected multiviewer. See [Adding Output Displays to the Device List](on page 108).</td>
</tr>
<tr>
<td>Delete Device</td>
<td><img src="image" alt="Icon" /></td>
<td>Deletes the selected multiviewer configuration from the folder.</td>
</tr>
<tr>
<td>Advanced Configuration</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens the <strong>Advanced Configuration</strong> dialog box, from which you can determine various hardware settings. See [Advanced Configuration](on page 108).</td>
</tr>
<tr>
<td>View System Logs</td>
<td><img src="image" alt="Icon" /></td>
<td>Provides access to logs by opening a web browser, and then connecting to the Logging Server.</td>
</tr>
<tr>
<td>Save Configuration Files</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens a browse dialog box where you can save files to a specified location. See [Saving and Loading Configuration Files](on page 138) for more information.</td>
</tr>
<tr>
<td>Load Configuration Files</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens a browse dialog box, so you can load configuration files to Layout Designer. See [Saving and Loading Configuration Files](on page 138) for more information.</td>
</tr>
</tbody>
</table>

### Layout Menu Items and Options

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Layouts&gt;</td>
<td>There is an item in this menu for each layout that is open.</td>
</tr>
</tbody>
</table>

### Help Menu Items and Options

<table>
<thead>
<tr>
<th>Menu Item/Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help F1</td>
<td>Opens the online help.</td>
</tr>
</tbody>
</table>
### Layout Designer Application Toolbar

You can use the Layout Designer toolbar to access frequently-used commands and options. Some of these functions are also accessible using the Layout Designer application menu (descriptions of their functions are located in Application Menus (on page 117)).

Some options are only available from the Layout Designer application toolbar. The following table describes these application toolbar options:

<table>
<thead>
<tr>
<th>Application Toolbar Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Layout</strong></td>
<td>Layout Using the Layout Creation Wizard - Opens the Layout Creation Wizard dialog box, from which you can create a customized layout. See Creating a New Layout Using the Layout Creation Wizard (on page 152). Blank Layout - Opens a blank layout. See Creating a New Layout from a Blank Layout (on page 158). Configuration - Opens the Device Manager dialog box, which you can use to create a new multiviewer configuration or modify an existing configuration. See Initial Layout Designer Configuration (on page 106).</td>
</tr>
<tr>
<td><strong>Open Layout</strong></td>
<td>Opens the Open dialog box, from which you can open a layout file that is stored on a local or network drive. See Viewing Layouts (on page 160).</td>
</tr>
<tr>
<td><strong>Save Layout</strong></td>
<td>Saves the layout as a .lay file to a previously specified file name and location. See Saving Layouts (on page 159).</td>
</tr>
<tr>
<td><strong>Print Layout</strong></td>
<td>Opens a Print dialog where you can choose a printer and print the selected layout.</td>
</tr>
<tr>
<td><strong>Publish Layout</strong></td>
<td>Saves the layout to the multiviewer hardware.</td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Cuts the selected layout object from the current location and places it on the clipboard, from which the object can be pasted to another location.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Copies the selected layout object and places it on the clipboard, from which the object can be pasted to another location.</td>
</tr>
<tr>
<td>Option Name</td>
<td>Icon</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Paste</td>
<td><img src="image" alt="Paste Icon" /></td>
</tr>
<tr>
<td>Ctrl+V</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td><img src="image" alt="Delete Icon" /></td>
</tr>
<tr>
<td>Clone a Component</td>
<td><img src="image" alt="Clone Icon" /></td>
</tr>
<tr>
<td>Centralize Layout Components Horizontally and Vertically</td>
<td><img src="image" alt="Centralize Icon" /></td>
</tr>
<tr>
<td>Undo</td>
<td><img src="image" alt="Undo Icon" /></td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td></td>
</tr>
<tr>
<td>Redo</td>
<td><img src="image" alt="Redo Icon" /></td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td><img src="image" alt="Zoom Icon" /></td>
</tr>
<tr>
<td>Rules</td>
<td><img src="image" alt="Rules Icon" /></td>
</tr>
<tr>
<td>Open/Close PiP Info Window</td>
<td><img src="image" alt="Open/Close Icon" /></td>
</tr>
<tr>
<td>Layout Designer Panels</td>
<td><img src="image" alt="Panel Icon" /></td>
</tr>
<tr>
<td>Enable Control</td>
<td><img src="image" alt="Enable Icon" /></td>
</tr>
</tbody>
</table>
Lock/Unlock Layout

This button has two states: Unlock Layout and Lock Layout. When the layout is unlocked, you can drag and drop items in the layout, in addition to adjusting the attributes of objects in the Properties panel. When a layout is locked, you can still use the Properties panel to adjust attributes of objects in the layout, but you cannot add, delete, or move objects in the layout. Context menus do not appear when you right click on a locked layout.

Tools Palette

Use the Tools palette to insert, select, move, and resize layout objects that are in the currently-displayed layout. Objects that are inserted into layouts using the palette’s insert tools have default property settings. See About Layout Objects (on page 131).

The following table describes each Tools palette option:

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow / Disallow Component Moving</td>
<td></td>
<td>Toggles the mouse’s ability to move individual or groups of objects in the layout. See Copying and Pasting Layout Object Properties (on page 174). You can resize items when movement is disallowed by selecting and dragging an object’s handles.</td>
</tr>
<tr>
<td>Pan</td>
<td></td>
<td>Toggles two modes: • Select and move objects in the layout. • Pans across the layout when the display is zoomed in so the entire layout does not fit on the screen.</td>
</tr>
<tr>
<td>Insert PiP</td>
<td></td>
<td>Inserts a single default PiP into the current layout. See Working with PiPs (on page 188).</td>
</tr>
<tr>
<td>Insert Label</td>
<td></td>
<td>Inserts a label into the current layout. See About Labels (on page 208).</td>
</tr>
<tr>
<td>Insert Analog Clock</td>
<td></td>
<td>Inserts an analog clock into the current layout. See About Layout Clocks (on page 212).</td>
</tr>
<tr>
<td>Insert Digital Clock</td>
<td></td>
<td>Insert a digital clock into the current layout. See About Layout Clocks (on page 212).</td>
</tr>
<tr>
<td>Insert Vertical Audio Meter</td>
<td></td>
<td>Inserts a multi-channel audio meter into the current layout. See Creating Audio Meters (on page 201).</td>
</tr>
<tr>
<td>Insert Horizontal Audio Meter</td>
<td></td>
<td>Inserts a multi-channel audio meter into the current layout. See Creating Audio Meters (on page 201).</td>
</tr>
<tr>
<td>Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Insert Tally Icon" /></td>
<td><strong>Insert Tally</strong></td>
<td>Inserts a tally into the current layout. See <a href="#">Creating Tally Indicators</a> (on page 204).</td>
</tr>
<tr>
<td><img src="image" alt="Insert 5.1 Audio Meter Icon" /></td>
<td><strong>Insert 5.1 Audio Meter</strong></td>
<td>Using this tool, you can choose to insert a six-channel audio meter for monitoring 5.1 channel surround sound audio. See <a href="#">Defining Alarms for a Layout Object</a> (on page 223).</td>
</tr>
<tr>
<td><img src="image" alt="Insert Info Panel Icon" /></td>
<td><strong>Insert Info Panel</strong></td>
<td>Using this tool, you can insert an overlay that provides data from a source or PiP on the display. See <a href="#">Info Panels</a> (on page 240).</td>
</tr>
<tr>
<td><img src="image" alt="Insert Up/Down Counter Icon" /></td>
<td><strong>Insert Up/Down Counter</strong></td>
<td>Using this tool, you can insert a unidirectional counter. See <a href="#">About Up/Down Counters</a> (on page 215).</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Icon" /></td>
<td><strong>Zoom</strong></td>
<td>Slides up and down to increase and decrease the size of the current display of the layout. As you drag the slider, the zoom indicator displays the current size.</td>
</tr>
</tbody>
</table>
Layout Canvas

The layout canvas is the design space used to create and edit layouts.

When multiple layouts are open in Layout Designer, the layouts’ names are listed on multiple tabs across the top of the canvas. Each tab also indicates the layout’s locked or unlocked status.

You can use Layout Designer’s editing tools to manipulate and modify PiPs and other layout objects. You can add objects to your layout by clicking them in the Tools palette, or by dragging the objects from the Library pane and dropping them onto the layout canvas.

Multiviewers Panel

The Multiviewers panel lists the multiviewer systems that are currently configured using Layout Designer. In most cases, the multiviewers listed in the panel have been previously configured with Layout Designer. This means that a unique configuration exists for the multiviewers listed in this Multiviewers panel.
The figure below shows the Multiviewers panel and its components.

Expand the multiviewer system icon to display layouts that are currently stored on the multiviewer’s hardware.

Use the Multiviewers panel menu or toolbar to connect to and disconnect from multiviewers, open the Device Manager dialog box to edit or create a new configuration, and delete a multiviewer from the Multiviewers panel.

If Layout Designer cannot detect a multiviewer that was previously connected to the software, Disconnected is displayed in the Multiviewers pane.

Double-click on any layout to open that layout in Layout Designer.

Using the Preferences dialog box, you can choose to have Layout Designer automatically connect to the last multiviewer that was connected to the software at startup, as well as automatically attempt to reconnect to a multiviewer when the previously established connection is lost. For more information, see Setting Your Layout Designer Preferences (on page 138).

**Multiviewers Panel Context Menu and Toolbar**

Toolbar icons may not be available depending on the item that is selected. When you right-click on a multiviewer, a context menu appears.

This table describes each Multiviewers panel menu item.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to Device</td>
<td><img src="connect.png" alt="Icon" /></td>
<td>Connects/disconnects Layout Designer to the selected multiviewer.</td>
</tr>
<tr>
<td>Disconnect Device</td>
<td><img src="disconnect.png" alt="Icon" /></td>
<td></td>
</tr>
</tbody>
</table>
When you click a layout in the Multiviewers panel, different menu items appear. The following table describes each layout menu item in the Multiviewers panel.

### Multiviewers panel Menu When You Click on a Layout

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display this layout on Multiviewer</td>
<td>Displays the selected layout on the selected multiviewer</td>
</tr>
<tr>
<td>Recall this layout to Layout Designer</td>
<td>Loads the selected layout in Layout Designer</td>
</tr>
<tr>
<td>Delete this layout on Multiviewer</td>
<td>Deletes the selected layout on the multiviewer (Note: this option is not available when the current layout displayed on the multiviewer is selected)</td>
</tr>
</tbody>
</table>

### Library Panel

The Library panel has the following sections: Windows, PiPs, and Info Panels. Objects in these sections can be dragged from the Library panel and dropped onto the currently displayed layout.

For information about using the Library panel toolbar to create, edit, or delete new library objects, see Using the Layout Designer Library Panel (on page 147).
The Library panel has a display option menu that you can use to customize how the panel is displayed in the layout workspace. For more information about customizing the Library panel, see Customizing the Layout Designer Workspace (on page 136).

The Library panel items include the following:

- **Windows** - You can select windows from the Library panel, and then drag and drop them onto the currently-open layout. If required, you can then use the Properties pane to modify how a window and its layout objects are displayed in the layout. The window must be ungrouped or "broken" if you want to modify any object. To ungroup objects inside a window, right-click on the window and select Break Window. For information about windows, see Creating Layout Windows (on page 179).

- **PiPs** - PiPs in the Library panel are organized according to their aspect ratio. You can select PiPs from the Library panel, and then drag and drop them onto the currently open layout. If required, you can then use the Properties pane to modify how the PiPs are displayed in the layout. For information about modifying PiP properties, see About Layout Objects (on page 131).

- **Info Panels** - You can drag info panels from the Info Panels section and drop them onto PiPs that are displayed in the layout window, or drop them onto the layout background as standalone info panels. You can use the Properties pane to modify the contents of an info panel. For information about modifying info panel properties, see Modifying Info Panel Properties (on page 241).

### Properties Pane

The Properties pane is located below the Layout canvas.

1. If the Properties pane is not currently displayed, select View > Properties from the application menu.

The Properties pane changes based on the object that is selected on the canvas.

You can modify properties that affect the way layout objects are displayed in the layout. Each group of layout objects has a tab with controls that allow you to adjust the layout object’s properties, such as changing the layout output resolution or PiP label text color. You can also add elements (such as audio meters and audio and video alarms) to your layout.

Depending on what object is selected in the layout canvas, different tabs appear in the Properties pane. To access the Properties pane for a specific layout object, select the object in the layout canvas, and then click the appropriate property tab. The number of tabs that will appear on the Properties pane will vary depending on the selected object.

You can resize the Properties pane by dragging its sides with the cursor. Use the scroll bars to view the entire pane. The Properties pane is always on top of other panes in the Layout Designer interface. If a portion of the pane is obscured by the size of the pane, use the scroll bars to view the content.

---

**About Layout Objects**

Layout objects are the building blocks that provide the look and feel of a layout. Layout Designer includes a variety of layout objects that perform different types of functions, such as bordering a PiP and metering input audio signals. Layout objects include PiPs, labels, clocks, tally indicators, audio meters, and info panels.

New layouts created using the Layout Creation Wizard contain PiPs and windows, which can contain any layout objects. Ideally, when creating a layout you will use pre-defined windows which contain such objects as audio meters, tallies, labels, and info panels, so the input source for all the objects in the window will track together.

Additional layout objects, such as audio meters and tally indicators, can be added to a layout after the layout has been created. You can add objects to layouts by dragging them from the Library panel onto the layout canvas, or by using the insert commands from the Tool palette and application menu.

You can group Layout objects together so that they can be simultaneously moved and/or formatted in the layout canvas. You can also create an arrangement of layout objects, and then add them to a window. As part of a window, this group of layout objects can be manipulated as a single layout object that has a distinct set of window properties. Window properties include a background (which is different from the layout background color). Windows and the arrangement of layout objects contained in the window can then be added to the Windows tab of the Library panel. The window can be added to other layouts in a single drag-and-drop action.

The display characteristics of layout objects are determined by their individual property settings. Layout object properties are modified in the same way, regardless of how they were added to the layout. For example, a PiP in layout created from the toolbar is modified in the same way as a PiP added to a layout from the Library panel. For information about layout object properties, see [Layout Object Properties](on page 171).
The following figure illustrates a typical layout displaying layout objects.

Each layout object is described below:

1. **PiP**
   Displays the input video/graphics from a single input channel. An individual PiP’s properties determine how it appears in the layout. Each PiP in a layout can have its own set of properties. For more information, see About Picture-In-Pictures (PiPs).

2. **Digital Clock**
   Displays time from NTP, linear time code, or internal reference source. The digital clock can be resized. For information, see Setting Digital Clock Format and Appearance Properties (on page 214).

3. **Analog Clock**
   Displays the time from NTP, linear time code, or internal reference source. There are various styles of analog clocks. For more information, see Setting Analog Clock Format (on page 212).

4. **Label**
   Three types of labels display text information, static, dynamic and alarm/rules. A Static label displays manually entered text. A Dynamic label can have an UMD source from either the router database or external UMD protocol. An alarm/rule label can be configured using the rules editor to display text information upon an event. For more information, see About Labels (on page 208).
5  Tally Displays monitoring status from external UMD protocol, GPI inputs, or an alarm/rule event. For more information, see Creating Tally Indicators (on page 204).

6  Audio Meter Displays audio ballistics from either a router source with embedded or discrete audio or from an audio service of an IP source. Audio meters can be added to individual PiPs in a layout. You can display up to 16 channels from an audio input on a PiP. For more information, see Defining Alarms for a Layout Object (on page 223).

7  Border Displays a user-defined graphic area around a PiP. Individual border properties determine how borders appear around the PiPs. Borders can display status from external UMD protocol, GPI inputs, or an alarm/rule event. For more information, see Modifying Border Properties (on page 183).

8  Info Panel Provides such data as alarms, closed captioning, VITC, Dolby E program information, and teletext data. Info panels can be standalone or overlaid on a PiP. For more information, see Info Panels (on page 240).

9  Up/Down Counter Provides either a count up or count down timer that can be configured to be triggered by alarm rules, GPI, or SNMP, and can target alarm actions. For more information, see About Up/Down Counters (on page 215).

Using the Layout Designer Properties panel, you can modify layouts and PiP properties, and add audio meters and info panels to create customized layouts that can be displayed in the multiviewer’s output display device. Customized PiP attributes such as borders and labels, are stored as part of the PiP in the Library panel.

---

## Layout Designer Context Menu

The Layout Designer context menu provides quick access to some commands and options that are also available from the application menu.

To access the Layout Designer context menu, in the canvas, select a layout object, and then right-click. The context menu appears. The options available on the context menu depend on the layout object that is currently selected in the layout.
Context menus do not appear when you right click on a locked layout.

The following table describes each Layout Designer context menu item.

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Where Found</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Any object</td>
<td>Deletes the selected layout object from the layout currently displayed on the canvas.</td>
</tr>
<tr>
<td>Copy</td>
<td>Any object</td>
<td>Copies the selected layout object and places it on the clipboard, from which the object can be pasted to another location.</td>
</tr>
<tr>
<td>Cut</td>
<td>Any object</td>
<td>Cuts the selected layout object from the current location and places it on the clipboard, from which the object can be pasted to another location.</td>
</tr>
<tr>
<td>Copy Properties</td>
<td>Single object, such as a PIP, clock, or audio meter, but not a composite object such as an info panel</td>
<td>Copies the properties from the selected layout object so that they can be pasted to another layout object (same type). For information about copying PiP properties, see Formatting Layout Objects in the Canvas (on page 174).</td>
</tr>
<tr>
<td>Paste</td>
<td>Background only</td>
<td>Pastes the last layout object that was placed on the clipboard by either a Cut or Copy command.</td>
</tr>
<tr>
<td>Paste Properties</td>
<td>An object of the same type that properties have been copied from and stored in the clipboard</td>
<td>Pastes all of the copied properties to the selected object. For information about pasting properties, see Copying and Pasting Layout Object Properties (on page 174)</td>
</tr>
<tr>
<td>Paste Selected Properties</td>
<td>An object of the same type that</td>
<td>A dialog box opens, providing the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Size</td>
</tr>
</tbody>
</table>

© 2017 Imagine Communications Corp. Proprietary and Confidential.
<table>
<thead>
<tr>
<th>Option Name</th>
<th>Where Found</th>
<th>Description</th>
</tr>
</thead>
</table>
| properties have been copied from and stored in the clipboard | • Borders  
• Others  
• All  
Click OK to paste the selected categories of properties to the selected object. | |
| Add/Edit Window Alarm       | Window      | Opens the Rules editor for the window, so you can alter the alarm configuration for that window. |
| Clear Window all Alarms     | Window      | Resets all alarms in the window.                                             |
| Set Properties              | When multiple windows are selected | A submenu offers all types of controls for all window controls within the selection. When you change the settings, all items of that type are altered to match. |
| Break Window                | Window      | Breaks apart the objects contained in a window.                             |
| Remove Window Component     | When multiple windows are selected | A submenu offers options for all window components within the selection. All instances of the selected item are deleted. |
| Create a Window             | When multiple objects are selected | Groups objects together to create a window.                                 |
| Lock Window                 | Window      | Prevents accessing the properties of individual layout objects within a window. |
| Consolidate Window(s)       | Window      | Adjusts the background size of the current window so that it is the minimum size to contain all the objects within the window. |
| Add Window to Library       | Window      | Adds the selected window to the Windows section of the Library panel.       |
| Add PiP to Library          | PIP         | Adds the selected PiP to the PiPs section of the Library panel.             |
| Order                       | One or more objects, including windows | Opens a drop-down menu, from which you can select the following order commands:  
• Bring to Front - Brings the selected layout object to the top of the object stacking order  
• Send to Back - Sends the selected layout object to the back of the object stacking order  
For information about ordering layout objects, see Formatting Layout Objects in the Canvas (on page 174). |
### Option Name | Where Found | Description
--- | --- | ---
Info Panel | Info Panel | Opens a drop-down menu, from which you can select the following commands:
- **Remove** - Removes the info panel from a PiP
- **Unlock Info Panel Items** - Unlocks individual items from the Info Panel
- **Move Out** - Allows info panel to move out of PiP
- **Add to Library** - Adds the info panel to the library
- **Enable Resizing Info Panel** - Allows you to drag the edges of the info panel to change its shape and size; this can ensure that the indicators do not fall on top of a PiP’s video (you can move the info panel off the PiP, for example).
- **Disable Resizing Info Panel** - Turns off Enable Resizing Info Panel

#### Add Info Panel to Library

| Info Panel | Add the selected info panel to the **Info Panels** section of the library |

#### Borders

| Window | Opens a drop-down menu, from which you can select from a list of all borders associated with an object (normally a window) |

---

## Customizing the Layout Designer Workspace

Layout Designer provides a number of different ways that you can customize the workspace to best suit your changing working environment. When you use Layout Designer to create new layouts and design custom layout objects, you can set up the workspace so that the Properties pane and the Library panel are easily accessible. When you are publishing layouts for display, you can hide (or auto hide) panels and the Properties pane to maximize your view of the canvas area on your computer’s screen.

When you close Layout Designer, and then reopen it, any previous changes to the pane states are retained. To return Layout Designer to its default state, select **View > Restore All Panel Default States** from the main menu.

You can also set default layout and PiP property options.

## Setting Panels and Panes Viewing Options

Layout Designer has view options for the Properties pane and Multiviewers and Library panels that you can use to customize the Layout Designer workspace. For example, you can move these items to different locations in the workspace, or you can hide the items from the workspace view.
To access the Properties pane and the Multiviewers and Library panel view options, click the down-arrow icon located at the end of the item’s title bar. The drop-down menu displays the view options.

Each menu option is described below:

- **Hide** - Select this option to remove the panel or pane from the Layout Designer workspace. After the item has been hidden, select one of the following options to add the item back to the workspace:
  - **View > Properties**
  - **View > Multiviewers**
  - **View > Library**

- **Floating** - Select this option to undock the panel or pane from its stationary location in the Layout Designer workspace (bottom of the workspace for the Properties pane and the right side of the workspace for the Multiviewers and Library panels). You can then use the mouse to move the item to different locations in the workspace. Double-click the item to redock it.

  When a workspace item is undocked, you can resize it by clicking then dragging the item’s outer edge while holding down your mouse button. The mouse pointer will turn to a double-headed arrow to indicate that you have selected the workspace item’s outer edge.

- **Auto Hide** - Select this option to collapse (temporarily hide) the menu item. When the Auto-Hide option is enabled, the collapsed items are stored either at the bottom (Properties pane) or to the right (Multiviewers library and Layout Designer Library) of the Layout Designer workspace. An auto-hidden workspace item is identified by a vertical or horizontal tab. To access the workspace item library, hold the pointer over the item’s tab.

  You can also activate or deactivate the Auto Hide option by clicking the icon from the workspace item title bar.

### Panning and Zooming in the Canvas Workspace

To view more or less of the canvas workspace, use one of the following tools:

- Choose a display percentage from the **Zoom** drop-down menu on the application toolbar at the top of the screen.

  You can also type a number between 15 and 125 in this field.

- Click **To Fit** on the application toolbar at the top of the screen to size the canvas so that its entire area is visible on the screen.

- Use the slider to the left of the canvas to increase or decrease the percentage of the display that is visible.

  When you click the pointer, the current display percentage appears.

If you are zoomed in close on an area of the canvas, you can pan the canvas by selecting the Pan tool.
Saving and Loading Configuration Files

To save configuration files:
1. From the main menu, choose Tools > Save Configuration files.
   A Browse dialog box opens.
2. Choose a location to save the files.

To load configuration files:
1. From the main menu choose Tools > Load Configuration Files.
   A Browse dialog box opens.
2. Choose a location to load the files from.

Files that are loaded and saved during this process include:

- Configuration.xml for the device and multi-viewer configuration
- Preference.dat for the Layout Designer application preference.
- dockManager.xml for the states of Multi-viewer panel, library panel and the property panel.
- Alarms.dat for the alarm template
- WindowCustomLibrary.xml for the customer-defined window library
- PiP16by9Library.xml for the customer-defined PiP library
- BorderStyles.xml for the custom-defined border style library

Note: You can select multiple files at one time by holding down the CTRL key.

Setting Your Layout Designer Preferences

Using the Layout Designer Preferences dialog box, you can set the application’s global preferences, including default settings for new layouts, windows, labels, and PiPs. You can also recall Layout Designer factory default settings.

To access the Layout Designer Preferences dialog box, from the Layout Designer application menu, select Edit > Preferences. There are five tabs on the Layout Designer Preferences dialog box. See the following topics:

- Setting General Preferences (on page 139)
- Setting Default Layout Properties (on page 140)
- Setting Default IP Source Properties
- Setting Default Window Properties (on page 142)
- Setting Default PiP Properties (on page 143)
- Setting Default Label Properties (on page 146)

After you finish setting your preferences, click OK to apply them. Your preference settings are automatically saved each time you exit Layout Designer.
Setting General Preferences

Use the **General** tab of the **Layout Designer Preferences** dialog box to set the number of levels for **Undo** and **Redo** commands, set auto connection options, and return to factory defaults.

### Setting Undo and Redo Levels

You can set the number of undo and redo levels that can be applied to when the **Undo** and **Redo** commands are used after an editing operation.

To set the number of undo and redo levels:

1. From the Layout Designer application menu, select **Edit > Preferences**, and then click the **General** tab.
2. Under **Undo/Redo**, type a value in the **Undo/Redo** field.

### Setting Multiviewer Connection Preferences

You can set up Layout Designer to automatically connect to the last connected multiviewer when a connection between the Layout Designer and the multiviewer is lost.

To select Layout Designer’s auto connect option:

1. From the Layout Designer application menu, select **Edit > Preferences**, and then click the **General** tab.
2. Under **Auto-Connect**, select **Auto connect to multiviewer if connection is lost** check box. If you clear this check box and a connection is lost, you can manually reconnect to the multiviewer using the **Multiviewers** panel menu.

### Setting Factory Default Recall Preferences

1. From the Layout Designer application menu, select **Edit > Preferences**, and then click the **General** tab.
2. Under **Recall Layout Designer Defaults**, select which options you want reset to factory default settings.
You can select from the following options:

- **LD Preferences** - Resets all Layout Designer preferences that you can set using the Layout Designer Preferences dialog box (General and Default Properties tabs)
- **Libraries** - Resets the Library panel to the default state.
- **Border Styles** - Resets all the available border styles available from the Border tab of the Properties pane factory default selection. This means that any created new borders added to the Border Styles selection are removed.

3. To recall the factory default options that you selected in step 1, click **Recall Factory Defaults**.

### Overwriting Layouts

<table>
<thead>
<tr>
<th>Overwrite Layouts</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Prompt when overwriting existing layout on Multiviewer.</td>
</tr>
</tbody>
</table>

If you want to be prompted before overwriting layouts on multiviewers, check this option. Otherwise, leave it blank.

### Setting the Default View

<table>
<thead>
<tr>
<th>Default View</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="default-view.png" alt="Radio Button" /> Zoom Level 100</td>
</tr>
<tr>
<td><img src="default-view.png" alt="Radio Button" /> Fit to Screen</td>
</tr>
</tbody>
</table>

Choose one of the following:

- **Zoom Level** - When a new layout is created, it is displayed at the percentage defined in the field to the right of the radio button. The range is from 15% to 125% in 1% increments.
- **Fit to Screen** - When a new layout is created, the entire layout is displayed in the available screen space. The display size is limited by the size of the Properties pane.

### Determining Auto Placement

<table>
<thead>
<tr>
<th>Auto Placement</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="auto-placement.png" alt="Field" /> Horizontal Spaces 2</td>
</tr>
<tr>
<td><img src="auto-placement.png" alt="Field" /> Vertical Spaces 2</td>
</tr>
</tbody>
</table>

When you add items to the layout using the **Clone a Component** button on the toolbar, they are spaced from one another using the Auto Placement settings. Use the Horizontal Spaces and Vertical Spaces fields to increase or decrease this padding. The available range is from 0 to 200.

### Setting Default Layout Properties

You can use the Layout tab of the **Layout Designer Preferences** dialog box to define the default properties for layouts and layout objects, and to configure email settings.
Configuring General Layout Properties

Layout default properties are used when Layouts are created from a blank layout (File > New Blank Layout) or when using the Layout Creation Wizard (File > New Layout Using Layout Creation Wizard). For more information, see Using a Blank Layout (on page 159).

To access these settings, from the Layout Designer application menu, select Edit > Preferences, and then click the Layout tab. After you finish setting your preferences, click OK to apply them.

To set default layout properties:

1. On the Layout Designer Preferences dialog box, select the Default Properties tab.

2. Under Layout, select a resolution from the Output Resolution drop-down list.

3. If you selected Custom from the Output Resolution list, type pixel values for the layout’s width and height in the field provided (width first and height second).

4. Under Margins, enter the amount of padding you would like between the edge of the layout and where objects, including the background, appear in the layout.

   Layout margins determine the boundary of the layout area where objects, including the background, can be placed. The overall layout size is maintained, not cropped. The maximum size for margins varies depending on the resolution of the layout.
5. Under **Paddings**, enter the amount of space you would like between objects when they are added to the layout using the layout wizard.

6. Beside **Background**, select either **Color** or a background image (**Background 1** to **Background 10**) from the drop-down list.

7. If you selected **Color** as your default background, click the [ ] button to access the **Select a Color** dialog box, and then use the slider to select a color, and click **OK**.

   For more information about using the **Select a Color** dialog box, see **Setting Default Window Properties** (on page 142).

8. Under **Orientation**, select either **Landscape** (wider than tall) or **Portrait** (taller than wide).

9. Under **UMD Address**, if you want fixed UMDs to start at a number other than 0, enter a number beside **Starting at**.

The **Allow component movable initially after loading a layout** option determines the initial setting of the **Allow/Disallow Component Moving** button in the Tools palette. When this item is checked, layout elements are movable when a layout is opened.

For information on changing a layout’s properties, see **Modifying Layout Properties** (on page 165).

### Configuring E-Mail Settings

The email settings determine the SMTP server for sending email and SMS text message alarm actions. See **Setting Alarm Actions** (on page 229) for more information.

### Email Settings in General Preferences

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SMTP Server</strong></td>
<td>Enter the address of the mail server.</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>Enter the account name.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Enter the password, if required, to send mail from that address.</td>
</tr>
<tr>
<td><strong>Security Type</strong></td>
<td>Choose None or SSL.</td>
</tr>
<tr>
<td><strong>Port Number</strong></td>
<td>Enter the SSL service port for the sending email address. This is only required for SSL-type security settings.</td>
</tr>
<tr>
<td><strong>Email Address</strong></td>
<td>Enter the user email address on the server, not necessarily the target email address of the alarm action.</td>
</tr>
</tbody>
</table>

### Setting Default Window Properties

You can set the default properties for windows that are created using the **Create Window** command from the Layout Designer context menu. For more information about windows, see **Creating Layout Windows** (on page 179).

To set default window properties:
1. From the **Layout Designer Preferences** dialog box, select the **Window** tab.

2. Under **Background**, select either **Color** or a background image (**Background 1** to **Background 10**) from the drop-down list.

3. If you selected **Color** as your default background, click the button to open the **Select a Color** dialog box.

4. To select a color, do either of the following:
   - Use the slider to select a color.
   - Enter the color values you want to use in one of the **ScRGB**, **sRGB**, or **Hexadecimal Notation** fields.
   - Your selected color is previewed below **Selected Color**.

5. Under **Border**, if you want a uniform border width around layout objects, select the **Uniform** check box.
   - If you do not want a uniform border width, clear the **Uniform** check box, and then type or select the values for the **Top**, **Bottom**, **Left**, and **Right** border widths.
   - To select the default border color, beside **Border Color**, click the button to open the **Selector a Color** dialog box.
   - In the **Select a Color** dialog box, use the slider to select a color, and then click **OK**.
   - If required, use the **Opacity** slider to adjust the color’s opacity value, and then click **OK**.

6. Select **Auto Lock window contents**, if you want the **Lock Objects in Window** to be enabled when a window is created.

When a window is locked, you cannot move or modify the layout objects contained in the window until **Lock Window** is cleared. For more information, see **Modifying Window Properties Using the Properties Pane** (on page 181).

**Setting Default PiP Properties**

You can set the default properties for PiPs that are created using Layout Designer’s Insert PiP commands. Default PiP properties are applied to PiPs that are created using **Insert > PiP** from the application window, and the Insert PiP tool from the **Tool** palette. For more information, see **Adding PiPs to a Layout** (on page 189).
To define default PiP values:

1. From the Layout Designer Preferences dialog box, select the PiP tab.

2. Type the values you want to use for the default PiP width and height in the Width and Height boxes.

3. Beside Aspect Ratio, select an aspect ratio from the drop-down list.

4. In the Source section of the screen, choose Router, WEB or VNC.
   If you choose Router or IP, the CCS-P Dynamic Name Reference section of the screen is available. Choose the source from which your PiPs will derive their names. See Modifying PiPs Using the Properties Pane (on page 189) for more information.

5. Beside Borders, if you want a uniform border width around layout objects, select the Uniform check box.
   If you do not want a uniform border width, clear the Uniform check box, and then type or select the values for the Top, Bottom, Left, and Right border widths.
   To select the default border color, beside Border Color, click the to open the Selector a Color dialog box. In the Select a Color dialog box, use the slider to select a color, and then click OK.

6. (Optional) Under Cropping & Markers, select Cropping, and then do either of the following:
• If you want a uniform cropping area around the PiP, select the **Uniform** check box, and then select a value.

• If you do not want a uniform cropping area, clear the **Uniform** check box, and then type or select the values for the **Top**, **Bottom**, **Left**, and **Right** cropping.

  Cropping rescales the video on the Multiviewer; the lines will not show when you publish the layout.

7. (Optional) Add markers to your PiP.

   ![Cropping marker: Image will be cropped to within this area and rescaled on the multiviewer](image)

Under **Cropping & Markers**, you can choose the following options:

- **Aspect Ratio Markers**—An indicator of correct aspect ratio on the PiP to let you know whether the video is properly scaled when a source that is one aspect ratio is put on a PiP that has a different aspect ratio. The aspect ratio markers display the area of an image with a 16:9 aspect ratio within a 4:3 coded frame, or an image with a 4:3 aspect ratio within a 16:9 coded frame. Click **Enable** to activate a marker on the PiP. To determine the color of the marker, click **Color**, make a selection, and then click **OK**.

- **Safe Area**—adds a Title Marker indicator on the PiP to indicate the safe area for titles to be displayed (80% of the picture area). Click **Title Marker** to activate a marker on the PiP. To determine the color of the marker, click **Color**, make a selection, and then click **OK**.

- **Active Format Description**—adds an indicator that displays the AFD description present on the incoming video. There are two options:
  - **AFD** - HD and SD video
  - **WSS** - SD 625 video only
  
  Click **Enable** to activate a marker on the PiP. To determine the color of the marker, click **Color**, make a selection, and then click **OK**.

  From the drop-down menu, there are two options:
  - **Display** mode—(note, this option is always selected) markers on the multiviewer PiP indicate the active picture area indicated by the AFD or WSS code on the input.
  - **Convert** mode—scales the video on the input source as indicated by the AFD or WSS code on the input.

8. Beside **Max Sources**, type the maximum number of inputs.

9. Check **Use Cached Sources** if you want the multiviewer to use the source names from the last time it connected, when the multiviewer is disconnected at Layout Designer start-up.

For information about altering an individual PiP’s properties, see [Modifying PiPs Using the Properties Pane](on page 189).
Setting Default Label Properties

You can set the default properties for labels that are created using Layout Designer’s Insert Label commands. Default PiP properties are applied to labels that are created using Insert > Label from the application window, and the Insert Label tool from the Tool palette. For more information, see About Labels (on page 208).

To define default label values:

1. From the Layout Designer Preferences dialog box, select the Label tab.

2. Beside Borders, if you want a uniform border width around layout objects, select the Uniform check box.
   
   If you do not want a uniform border width, clear the Uniform check box, and then type or select the values for the Top, Bottom, Left, and Right border widths.
   
   To select the default border color, beside Border Color, click the to open the Selector a Color dialog box. In the Select a Color dialog box, use the slider to select a color, and then click OK.

3. Under Text Source, choose an option.

   All the options are described in Setting the Label Text Source (on page 208).

   For information about altering an individual label’s properties, see About Labels (on page 208).
Using the Layout Designer Library Panel

The Layout Designer Library panel stores a collection of default and custom layout objects that can be dragged from the Library and dropped onto the currently-displayed layout. In the Library panel, layout objects are listed by name (which is indicated on each library tab) and a preview of the layout object. For information about adding new layout objects to the Library, see Adding Objects to the Library Panel (on page 147).

The Library panel has view options that customize the way the panel is displayed in the Layout Designer workspace. For example, you can undock Library panel items and move them to different locations in the workspace, or you can hide the items from the workspace view. For more information about the Library view options, see Setting Panels and Panes Viewing Options (on page 136).

Your layout must be in an unlocked state to use the Library panel. See Locking and Unlocking Layouts (on page 159).

Adding Objects to the Library Panel

You can design custom layout objects and add them to the appropriate tab in the Library panel by right-clicking on the object.

You can delete any new object using Delete on the Library panel menu. You cannot delete the default items from a Library panel.

If you delete a Library object, you cannot use the Undo command to restore the object to the Library.

Adding Layout Objects to the Library Panel

To add a PiP, info panel, or window from a layout to the Library panel, from the layout, select the object you want to add to the Library panel and do one of the following:

- From the application menu, select Insert > Add Object to Library, and then, depending on the object you want to add, select PiP, Info Panel, or Window.
  
  If no object is selected, you will be instructed to select the type of object you specified.

- Right-click, and then depending on the object you want add, select Add PiP to Library, Add Info Panel to Library, or Add Window to Library.

You will only have the option to add an info panel to the Library panel if the info panel is not attached to a PiP or a window. However, if a window or PiP contains an info panel, the info panel will be added to the Library panel as part of that object.

When you add a PiP to the Library panel, it is automatically added to the tab for the corresponding aspect ratio.
Using Objects from the Library Panel

You can use objects from the library panel as long as the currently selected layout is not locked. If the layout is locked, unlock it by clicking Layout in the main toolbar.

Adding Layout Objects from the Library Panel to a Layout

To add a PiP, Info Panel, or Window to a layout, select the object with the mouse and while holding down the mouse button, drag the object and drop it on the layout. You can readjust the position of the object once it has sized itself in proportion with the rest of the layout.

Searching a Library

When you have a large number of objects in a library, it can be difficult to find an object by scrolling. You can search a library for an item with a string of text in its title.

1. Select a library to search.
The active library is indicated by a green button next to its name.

1. Green indicates active library
2. Enter the Search criteria here
3. List of items in the active library that meet the search criteria

2. Enter your search criteria in the **Search** field, and then press **Enter**.

The library display updates to show all items in the selected library that meet your search criteria.
Working with Layouts

Layouts are made from an arrangement of windows, PiPs and other layout objects, including windows, PiPs, labels, tally indicators, clocks, up/down counters, and on-screen alarms. The largest single unit of a layout is a window. Windows are containers that are used to store a compilation or arrangement of layout objects, such as PiPs, audio meters, and tally indicators. PiPs, the main component of layouts, display video from the multiviewer’s various input sources.

Layout Designer provides a number of different ways to create new layouts for display on your multiviewer system. After layouts are created, you can use the editing options to define how you want the layout to appear in output display devices.

Use the Layout Designer to modify the default assignment of video before displaying the layout in the output display devices.

Layout objects do not need to be part of a window to be displayed in a layout.

The following figure illustrates a layout comprised of windows and layout objects.
Windows are similar to grouped layout objects with the exception that windows have a set of distinct properties associated with them. You can apply properties, such as tallies and borders, to affect how the window looks and behaves in a layout. Grouped layout objects are defined by the individual object properties. For information about creating and editing windows, see Creating Layout Windows (on page 179).

The display characteristics of a layout are determined by layout objects including PiPs, alarms, and audio meters. In addition to these objects, PiPs are associated with attributes: borders and labels. In layouts, the position and appearance of layout objects and PiP attributes are determined by properties.

---

**Creating New Layouts**

It is important to know the native resolution of the display monitor before you create an optimized layout. The native resolution varies from manufacturer to manufacturer. Please refer to your display monitor’s manual to find the native resolution.

<table>
<thead>
<tr>
<th>Monitor</th>
<th>Layout resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1600 x 1200</td>
<td>1600 x 1200</td>
</tr>
<tr>
<td>SDI 1080i</td>
<td>1920 x 1080</td>
</tr>
</tbody>
</table>

**Sample Monitor Resolutions and Layout Designer Resolutions**

There are two ways of creating layouts: online and offline.

New layouts can be created "online," which means you can take a published layout, edit it in Layout Designer, and then re-publish it.

New layouts can be created "offline," which means that you can use Layout Designer to create a layout, save it to a network or local drive, and then publish it to a connected multiviewer at a later time. You do not need to be connected to a multiviewer to create and save new layouts. (You must be connected to an multiviewer to publish layouts to it.)
After you create your layout, save it to a layout (.lay) file. For information about saving layouts, see Saving Layouts (on page 159).

**Layout Creation Workflows**

There are a number of different ways or workflows that you can follow to create or edit existing layouts. These workflows depend on the level of customization and complexity that your new layout requires. You can modify layouts at any time by adding layout objects, such as audio meters, on-screen video alarms, or rules. You can also drag layout objects from the Library panel and drop them on the layout that is currently in the canvas.

There are two main workflows you can use to start creating your new layouts. See the following:

- Creating a New Layout Using the Layout Creation Wizard (on page 152)
- Creating a New Layout from a Blank Layout (on page 158)

**Creating a New Layout Using the Layout Creation Wizard**

Using the Layout Creation Wizard, you can create customized layouts by defining the layout’s basic building blocks, including layout output resolution, the arrangement of PiPs (the number of PiPs across and the number of PiPs down) in the layout, as well as the style of the PiPs in the layout. The selection of PiP styles that you can choose are defined by the PiP styles listed in the PiP tab of the Layout Designer Library. The Layout Creation Wizard dialog box has a preview window that displays how your layout will appear in the Layout window.

After you have created the layout, you can add layout objects such as audio meters, tally indicators, and alarms. You can then save your custom layout to a layout (.lay) file.
The following figure illustrates the different options available when you create a new layout from the Layout Creation Wizard.

Clicking on any layout object in the Tools palette creates that object on the design canvas. You cannot drag and drop objects to the canvas.

For more information about customized layouts, see Using the Layout Creation Wizard (on page 153).

**Using the Layout Creation Wizard**

Use the Layout Creation Wizard to create custom layouts that you can save, and then publish to your multiviewer for display.

Initial settings for many portions of the Layout Creation Wizard are derived from user preferences (File > Edit > Preferences > Default Properties).

1. To access the Layout Creation Wizard, select File > Layout Using Layout Creation Wizard from the main menu.

   The Layout Creation Wizard dialog box opens.

2. In the Layout Name field, enter a name for your new layout.

   The layout name is used to identify the layout on the Properties pane and when the layout is published to your multiviewer hardware.
3. Click **Next**.

![Layout Creation Wizard](image)

**Wizard Page 2—Resolution and Margins**

4. To select an output resolution, under **Resolution**, do either of the following:
   - For a standard output resolution, select **Predefined**, choose either **Landscape** or **Portrait**, and then make a selection from the **Output Resolution** list.
   - For a custom output resolution, select **Custom Defined**, and then type or select values for width and height.
   
   For best results, select an output display resolution that matches the native resolution of your output display device.

5. Under **Margins**, enter the amount of the layout area you would like to have reserved, so that objects, including the background, cannot be placed there.

   The margin setting does not affect the size or resolution of the layout as a whole. The maximum size for margins will vary depending on the resolution of the layout.
6. Click **Next**.

![Wizard Page 3—Component Type]

7. Under **Component**, select either **PiP** or **Window**.
   The component type you choose here will be the basic item that will fill your layout.

8. If you choose **PiP**, select an aspect ratio.
   The aspect ratio you select determines the PiPs that are available when you select a style from the **Select PiP** tab. For example, if you want to select a style from the 16:9 tab of the **PiP Library**, select 16:9 from the **Aspect Ratio** list.

9. Below **Source**, choose one of the following:
   - **Router** - see **Selecting a Channel for Display on the PiP** (on page 193).
     - Choose one of the following:
       - Choose the first route index to follow
       - Check **Start Follow Destination**, and then choose an Index and a level
   - **VNC Sources** - see **Selecting a VNC Source** (on page 197).

10. Select a starting source for your PiPs.
    The Source PiP property of the first PiP will be set to the value of Starting Source, and following PiPs will use the next sources in sequential order.
    
    To find the index number for the first source of the layout, you can click **IP Sources Manager**, and then use cancel to return to the wizard.

11. Beside **UMD Address**, enter the first number as output by your UMD device when using layouts with a fixed UMD address.

12. Under **Padding**, choose the amount of padding to add to the top, bottom, left, and right of components in the layout.
    Padding is the distance between the components.
13. Click **Next**.

**Wizard Page 4—Choose PiP or Window Format**

14. Depending on whether you chose to populate your layout with PiPs or windows, do either of the following:

- If you chose PiPs on the previous page of the wizard, select the PiP style you want to use for your new layout.
  
  Click **Default PiP**, in which case the PiP will match the settings as configured in the Default Properties tab of the Preferences window, or click **A PiP from Library**, and then choose a PiP from the **PiP Library** field. Only the page of the PiP library which has the aspect ratio you chose on the previous page will be available.

- If you chose windows (which includes PiPs and other layout objects) on the previous page of the wizard, select the window style you want to use for your new layout from the **Window Library**. If the window you choose has alarms, you can select **Keep Alarms**, and the alarm settings, except those that point to controls outside the window, are retained and will appear in the new layout. When a window has no alarms, this option is unavailable.
15. Click **Next**.

**Wizard—Choosing a Layout Style**

16. Use the tools on this page to assign a number of rows and columns of PiPs or windows on your layout.

Drag the slider to the left of the preview to change the number of rows of displays, and drag the slider below the preview to change the number of columns. The range these sliders can be dragged through depends on settings you made in previous pages of the wizard.

17. (Optional) To choose a non-uniform style of layout (where PiPs or windows may vary in size), click **Open to Select More Styles**, and then click on a style in the pane that appears. The additional styles will update as you move the sliders on the preview pane.

18. If you choose a previously stored layout for your layout style, click the **Browse** button, and then choose any *.lay file, and then Click **OK**.

When you click **Next**, if you have chosen a custom layout, these options appear:

**Use selected PiP or Window (contains PiP) to:**

- **Replace all windows that contain PiPs**—replaces all windows with the default window or PiP selected in the wizard.

- **Replace all PiPs that are not in the windows**—replaces all PiPs with the default window or PiP selected in the wizard.

If both options are selected, then all windows and PiPs are replaced with the default PiP or window.

If neither option is selected, then no PiPs or windows are replaced with the default PiP or window.

19. (Optional) Click **Display Layout Preview Image**.

20. Click **Next**.

The final screen of the wizard displays a preview of your layout, if you chose **Display Layout Preview Image** on the previous screen.

21. To complete the layout and exit the **Layout Creation Wizard**, click **Finish**.

Before you make changes to the layout or publish your new layout, save it as a layout file on a local or network drive. See **Saving Layouts** (on page 159).
You can add layout objects (such as clocks and tally indicators, audio meters, and on-screen alarms) to your layout before publishing the layout to your multiviewer. You can also modify layout and layout object properties such as re-assigning input channels to PiPs. See the following sections for more information:

- [Layout Properties](#)
- [Layout Object Properties](#)
- [Formatting Layout Objects in the Canvas](#)
- [Alarms and Info Panels](#)

### Creating a New Layout from a Blank Layout

When you select a blank layout as the starting point, there is no pre-arrangement of PiPs or other layout objects in the layout canvas. You must add all of the layout objects, including PiPs, to your new layout by either dragging them from the Library panel or by inserting the objects using the Tool palette. You can also add layout objects by using the application menu’s insert commands.

Layout Designer does not restrict you from positioning PiPs so that they overlap one another.

After you add PiPs and objects to your new layout, you can use Layout Designer’s formatting tools, such as Align and Distribute, to create custom PiP arrangements. You can also use the Properties pane to modify the layout, PiP, and object properties, as well as add audio meters and alarms. You can then save your custom layout to a layout (.lay) file.

The following figure illustrates the different options you can use to create a new layout from a blank layout.
Using a Blank Layout

You can create a layout by dragging layout objects from the Layout Designer Library onto a blank layout.

To create a layout from a blank layout:

   The Layout window opens and displays a blank layout.
2. Set the layout properties using the Properties pane.

For information about viewing and setting layout properties, see Viewing Layout Properties (on page 165) and Modifying Layout Properties (on page 165).

Locking and Unlocking Layouts

When a layout is locked, it displays a closed padlock icon in the top left corner of the layout tab. When it is unlocked, the padlock icon is open.

The Lock/Unlock Layout button is on the button bar at the top of the Layout Designer screen.

To lock a layout:

1. Click Lock Layout.

You can use the Properties panel to adjust attributes of objects in the layout, but you cannot add, delete, or move objects in the layout. Context menus do not appear when you right click on a locked layout.

To unlock a layout:

1. Click Unlock Layout.

You can drag and drop items in the layout, in addition to adjusting the attributes of objects in the Properties panel.

Saving Layouts

After creating a new layout using the Layout Creation Wizard or a blank layout, you can save your layout. Layouts saved as layout files are opened using Layout Designer’s Open Layout command.

You can save your layout as layout (.lay) files to a local or network drive so that you can open the layout in Layout Designer at any time. Layouts that have been changed since they were last saved have an asterisk (*) in the layout tab.

To save your new layout as a layout file:

1. Select File > Save As.
2. Type a name for your new layout in the Save As dialog box, and then click OK.
When you close Layout Designer, you are offered the opportunity to save layouts. For more information, see Closing Layout Designer (on page 104).

To save all open layouts, select File > Save All.

To overwrite the layout when you have already saved it, select File > Save.

Opening Layouts

If you have closed a layout, depending on where it was saved, you can open it in the following ways:

- If the layout was published to a multiviewer and you are connected to that multiviewer, double-click the layout in the Multiviewers pane.
- If the layout was saved to a hard drive, USB key, or other backup storage system, from the main menu select File > Open and then browse to the location where the layout was saved. Select the layout and click Open.

The layout opens in a locked state.

Viewing Layouts

To display a layout on the layout canvas, you must connect Layout Designer to the multiviewer, and then select the layout you want to display. You can open multiple layouts in the layout canvas; however, you can only view one layout at a time. You can toggle between the different layouts that are currently open in the layout canvas by clicking the tabs located at the top of the layout canvas. When a layout is displayed in the canvas, you can modify its appearance and add new layout objects. You can create new layouts, edit existing layouts, and define audio and video alarms and rules.

If you want to modify a layout, you may need to unlock it. See Locking and Unlocking Layouts (on page 159).

For information about how to connect Layout Designer to a multiviewer and select layouts for display on the layout canvas, see Connecting Layout Designer to a Multiviewer (on page 162) and Displaying and Publishing Layouts (on page 163).
Below is an overview of Layout view options and controls.

Using Layout Designer Controls and Options

1. Publish layouts to the selected multiviewer. For information, see Displaying and Publishing Layouts (on page 163).

2. Create new layouts from a blank layout, or by using the Layout Creation wizard. For more information, see Creating New Layouts (on page 151).

3. Select a layout stored on a multiviewer for display or for editing. See Displaying and Opening Layouts Stored on the Multiviewer (on page 163).

4. Modify layout properties, such as display output resolution and background color, using the Layout Properties pane. See Modifying Layout Properties (on page 165).
Connecting Layout Designer to a Multiviewer

If Layout Designer is not currently connected to a multiviewer, or if you want to connect to any of the multiviewers that are displayed in the Multiviewers library, use the Connect command. If Layout Designer cannot find a configuration for the selected multiviewer, you must create one using the Configuration Wizard. For information about configuring multiviewers, see Initial Layout Designer Configuration (on page 106).

To connect the multiviewer to Layout Designer, in the multiviewers panel, do one of the following:

- Click the multiviewer to which you want to connect, right-click the selected multiviewer, and then select Connect to Device from the context menu.
- Click the multiviewer to which you want to connect and click the Connect button on the bottom left of the panel.
- Double-click the multiviewer.

It may take up to three seconds for Layout Designer to connect with the multiviewer. When connected, Layout Designer displays (Connected) after the multiviewer name. The layouts stored in the connected hardware are listed below the multiviewer name.

Disconnecting Layout Designer from a Multiviewer

To disconnect from a multiviewer, in the Multiviewers panel do one of the following:

- Right-click the multiviewer, and then select Disconnect Device from the context menu.
- Click the multiviewer, and then click the Disconnect button on the lower left of the Multiviewers panel.
- Connect to another multiviewer.

You can only be connected to one multiviewer at a time.
Displaying and Publishing Layouts

After you have connected Layout Designer to a multiviewer, you can select layouts and display them on the multiviewer’s output display devices. Using Layout Designer, you can choose to display layouts that are currently stored on the multiviewer or you can open layouts that are saved as layout files. You can then use the Publish command to display the layouts on the multiviewer’s output display devices.

The following sections describe how to display layouts. For information about displaying new layouts, see Viewing Layouts (on page 160).

Displaying and Opening Layouts Stored on the Multiviewer

When Layout Designer is connected to a multiviewer, the layouts currently stored on the multiviewer hardware are shown in the Multiviewers panel. To view the layouts that are stored on a multiviewer, in the Multiviewers panel, click or expand the multiviewer’s icon.

If you do not want to view or modify the layout, you can display the layout without opening it in Layout Designer. If you want to view, modify, or save the layout to a local or network drive, you must open it in Layout Designer. You can then use the Publish command to display the modified layout. For more information, see Publishing Modified Layouts (on page 164).

If Layout Designer is not connected to a multiviewer, see Connecting Layout Designer to a Multiviewer (on page 162).

If you want to modify the layout, you may need to unlock it. See Locking and Unlocking Layouts (on page 159).

To display a layout:

1. On the Multiviewers panel, right-click the layout that you want to display on the multiviewer(s), and then select Display this Layout on Multiviewer from the context menu that appears.
The selected layout is now displayed in the output display device(s).

To open a layout in Layout Designer:

Do either of the following:

- From the Multiviewers pane, select the layout that you want to open in Layout Designer, right-click, and then select **Recall this Layout to Layout Designer** from the context menu.
- In the Multiviewers panel, double-click the layout that you want to open in Layout Designer.

You can use tools to modify the layout and objects as well as add objects to the layout, and then use the **Publish** command to display the modified layout on the multiviewer. For more information, see **Modifying Layout Properties** (on page 165) and **Layout Object Properties** (on page 171). For information about publishing a layout, see **Publishing Modified Layouts** (on page 164). You can also save the layout as a layout (.lay) file. For more information, see **Saving Layouts** (on page 159).

**Publishing Modified Layouts**

You can open a layout in Layout Designer, modify it by adding objects, such as audio meters or alarms, and then use the **Publish** command to display the modified layout on the output display devices. When the layout is published, the multiviewer is automatically updated with the modified layout.

The following section describes how to open a layout in Layout Designer, and then publish the layout to the multiviewer. For information about modifying layouts and adding layout objects, see **Modifying Layout Properties** (on page 165).

To publish a modified layout:

1. From the **Multiviewers** library, double-click the layout you want to modify. The selected layout opens in the layout window.
2. Make the required modifications to the layout. For information about modifying a layout, see **Modifying Layout Properties** (on page 165).
3. To publish your modified layout to the multiviewer, click **Publish** on the Layout Designer application toolbar.

**Publishing Layouts From Layout Files**

You can select a layout file from a local or network drive, and then publish it to your multiviewer display. There is no limit to the number of layouts that you can store on your multiviewer hardware, as long as there is enough disk space.

To ensure that you do not lose any of the layouts currently stored on the multiviewer hardware, open them in Layout Designer, and then save them to a local or network drive.

To publish a layout that is stored on a local or network drive:

1. To open a layout (.lay) file, select **File > Open**.
2. In the **Open** dialog box, browse to the location of the layout file you want to open, and then click **OK**.

   The layout file opens in the layout window. You can make modifications to the layout before you publish it to the multiviewer display. For information about modifying a layout, see **Modifying Layout Properties** (on page 165).

3. To publish the layout, click **Publish** from the Layout Designer application toolbar.

### Layout Properties

Layout property settings define how the area of the layout window is displayed in the output display device(s) that are connected to the multiviewer. When you create new layouts, you need to select options for your layout properties. Layout properties can be modified any time layouts are open in the Layout Designer canvas. You can view and change layout properties using the Layout tab in the Properties pane.

For best results, ensure that the Output Resolution and frequency settings match the resolution and refresh rate of the output display device(s) connected to your multiviewer.

### Viewing Layout Properties

You can view and change layout properties using the Properties pane.

To access the Properties pane:

1. Select **View > Properties**.

The Layout Properties pane appears similar to the following:

---

**Layout Properties Pane**

### Modifying Layout Properties

You can modify the properties of a layout that is currently open in the Layout Designer canvas. This includes layouts that have been created using a blank layout or the Layout Creation Wizard. See the following sections:

- **Modifying the Resolution** (on page 166)
- **Modifying the Background** (on page 166)
Naming Layouts

A Layout’s name identifies it in various Layout Designer workspace dialog boxes and tabs including the following tabs:
- Multiviewers panel
- Properties pane

To modify the layout’s name:

1. Under Properties, type a name for your layout in the Layout Name field.

Modifying the Resolution

Layout Designer supports a number of standard predefined output resolutions. You can also define custom output resolutions. When selecting the orientation and resolution for your layout, ensure that your output display devices support your selections.

Your layout must be in an unlocked state to change its resolution.
See Locking and Unlocking Layouts (on page 159).

To modify the resolution:

1. Under Resolution, do one of the following:
   - To select a standard output resolution, click Predefined, and then select a resolution from the drop-down list.
   - To select a custom output resolution, click Custom, and then type or select values for output width and height.
2. Click Apply.

Modifying the Background

You can select either a solid color or a predefined background image as your layout’s background. There are 10 pre-defined background images.

To modify the background:

1. Under Background, from the Set Background list, select either Color or a background image (Background 1 to Background 10) from the drop-down list.
2. If you selected Color as your default background, click the button to access the Select a Color dialog box.
3. To select a color, do one of the following:
   - Use the slider to select a color.
   - Enter the color values you want to use in one of the ScRGB, sRGB, or Hexadecimal Notation fields.
     Your selected color is previewed below Selected Color.
4. If required, use the Opacity slider to adjust the color’s opacity value, and then click OK.
5. Click OK.
Setting the Background to the Foreground

On the Layout Properties tab, place a check beside Foreground Mode. This sets the background in front of all the other elements on the layout. In this mode, you only see the layout background, but all the other layout objects still report information though they do not display.

Making Layout-Specific Settings

There are three layout-specific buttons, which control settings on a per-layout basis.

Under Layout Alarms, click Clear to clear all the component alarms on the active layout opened in LD.

This does not affect the alarms on the display. To clear alarms on the display, republish the layout.

Under Layout Events, click Configure to open the Layout Event Configuration dialog box. This option is also available from the toolbar by clicking Rules and selecting Layout Events from the menu that appears. For complete information about setting and using triggers, see Configuring Layout Events and Global Events (on page 238).

Under On Screen Messages, click Reset to acknowledge all messages displayed.

Margins

You can adjust the margins on the layout by entering numbers in the four Margins fields. The margin limits the size of the entire layout. The background is resized to fit the new area.

The available range for margins varies depending on the resolution of the layout, with an absolute maximum of 200 pixels on the higher resolutions.

Your layout must be in an unlocked state to adjust the margins. See Locking and Unlocking Layouts (on page 159).

Drawing Grid

On the Layout Properties pane, you can activate a grid for the layout canvas. This grid is for layout purposes, and will not appear on the published layout.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Grid</td>
<td>Displays a grid on the layout canvas</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Whether the grid is displayed or not, when this is checked, items will snap to grid positions when dragged around the layout</td>
</tr>
<tr>
<td>Grid Color</td>
<td>Click the button to choose a color for the lines in the grid</td>
</tr>
<tr>
<td>Horizontal Spacing</td>
<td>Determines the distance (in pixels) of the lines that run from top to bottom on the grid; lines can be spaced from 5 to 40 pixels apart</td>
</tr>
<tr>
<td>Vertical Spacing</td>
<td>Determines the distance (in pixels) of the lines that run from left to right on the grid; lines can be spaced from 5 to 40 pixels apart</td>
</tr>
</tbody>
</table>
**IconMaster Mode**

Select this option if you will be using an IconMaster master control switcher with this layout and want to switch the multiviewer’s displayed layout, PIPs, etc. when the channel is switched. When in IconMaster mode, external protocol with tallies are disabled. Tallies update using CCS controls only.

IconMaster mode is configured in the IconMaster Configuration Utility. Your IconMaster must have a Multiviewers license enabled. See the **Multiviewer Configuration Settings** section of your *IconMaster Installation and Configuration Manual* for more information.

**Override PiP Number**

When this option is disabled, each PiP is automatically assigned a PiP number, which is greyed out (but still displayed, for informational purposes) on the PiP’s Properties pane. When this option is enabled, you can alter the PiP number.

Within a layout, each PiP must have a unique number. If you attempt to assign a number to a PiP, and that number is already in use, the PiP number will automatically jump to the next available PiP number.
Working with Layout Objects

Layout objects are the building blocks that provide the look and feel of a layout. Layout Designer includes a variety of layout objects that perform different types of functions, such as bordering a PiP and metering input audio signals. Layout objects include PiPs, labels, clocks, tally indicators, audio meters, and info panels.

New layouts created using the Layout Creation Wizard contain PiPs and windows, which can contain any layout objects. Ideally, when creating a layout you will use pre-defined windows which contain such objects as audio meters, tallies, labels, and info panels, so the input source for all the objects in the window will track together.

Additional layout objects, such as audio meters and tally indicators, can be added to a layout after the layout has been created. You can add objects to layouts by dragging them from the Library panel onto the layout canvas, or by using the insert commands from the Tool palette and application menu.

You can group Layout objects together so that they can be simultaneously moved and/or formatted in the layout canvas. You can also create an arrangement of layout objects, and then add them to a window. As part of a window, this group of layout objects can be manipulated as a single layout object that has a distinct set of window properties. Window properties include a background (which is different from the layout background color). Windows and the arrangement of layout objects contained in the window can then be added to the Windows tab of the Library panel. The window can be added to other layouts in a single drag-and-drop action.

The display characteristics of layout objects are determined by their individual property settings. Layout object properties are modified in the same way, regardless of how they were added to the layout. For example, a PiP in layout created from the toolbar is modified in the same way as a PiP added to a layout from the Library panel. For information about layout object properties, see Layout Object Properties (on page 171).
The following figure illustrates a typical layout displaying layout objects.

Each layout object is described below:

1. **PIP**
   - Displays the input video/graphics from a single input channel. An individual PiP’s properties determine how it appears in the layout. Each PiP in a layout can have its own set of properties. For more information, see About Picture-In-Pictures (PiPs).

2. **Digital Clock**
   - Displays time from NTP, linear time code, or internal reference source. The digital clock can be resized. For information, see Setting Digital Clock Format and Appearance Properties (on page 214).

3. **Analog Clock**
   - Displays the time from NTP, linear time code, or internal reference source. There are various styles of analog clocks. For more information, see Setting Analog Clock Format (on page 212).

4. **Label**
   - Three types of labels display text information, static, dynamic and alarm/rules. A Static label displays manually entered text. A Dynamic label can have an UMD source from either the router database or external UMD protocol. An alarm/rule label can be configured using the rules editor to display text information upon an event. For more information, see About Labels (on page 208).
Using the Layout Designer Properties panel, you can modify layouts and PiP properties, and add audio meters and info panels to create customized layouts that can be displayed in the multiviewer’s output display device. Customized PiP attributes such as borders and labels, are stored as part of the PiP in the Library panel.

### Layout Object Properties

Each layout object has a number of unique properties that determine and define how it is displayed and how it behaves in the layout. These properties are independently set; each layout object can have a different set of properties. These settings can be modified at any time. You can use the various tabs of the Properties pane to modify individual layout object properties. PiPs, windows, label text, clocks, and audio meters each have separate property tabs.

To access the Properties pane:

1. Select **View > Properties**.

### Adding Layout Objects to a Layout

You can add objects by using the Library panel, the Tools palette, or the Insert menu.
• Drag selected layout objects from the Windows, PiPs, or Info Panel Library panel tab, and then drop them onto the layout canvas. When you use this method of adding layout objects, you can select from standard as well as any customized objects that have been previously created and added to the Library panel.

• Click an object on the Tools palette. The object appears on the layout canvas.

• Choose an object item from the Insert menu.

Your layout must be in an **unlocked** state to add, move, or delete objects. See [Locking and Unlocking Layouts](on page 159).

Objects inserted into layouts using the Tools palette or the Insert menu have default object properties. New items are automatically added "on top" of other items. To change the order of items in the layout, use the **Order > Bring to Front** and **Order > Send to Back** options in the context menu. Items are positioned on the canvas based on your auto placement preferences setting. See [Determining Auto Placement](on page 140) for more information.

After you have inserted the objects into a layout, you can use the Properties pane to modify their properties.

To add layout objects using the Library panel:

1. If the Library panel is not currently visible in the Layout Designer workspace, select **View > Library**.
2. From the Library panel, click the tab of the layout objects that you want to add to your layout.
3. Select the layout object that you want to add, drag it to the canvas, and then drop it on to your layout.

To add layout objects using the Tools palette:
1. Click the icon of the layout object to insert.
   For information about the options on the Tools palette, see Tools Palette (on page 125).

After you add objects to your layout, you can:
• Use your muse to move the objects in the layout canvas
• Use Layout Designer’s formatting tools to accurately align and distribute the objects in the layout, as well as copy and paste PiP properties
• Modify layout objects using the Properties pane.

Before publishing your new layout, you can save it as a layout file on a local or network drive. For information about saving layouts, see Saving Layouts (on page 159).

See the following sections for information about modifying and formatting layout objects:
• Layout Properties (on page 165)
• Layout Object Properties (on page 171)
• Formatting Layout Objects in the Canvas (on page 174)
• Alarms and Info Panels (on page 219)

Formatting Layout Objects in the Canvas

Layout Designer has a number of layout object formatting options that you can use to arrange and resize objects in a layout, as well as cut, copy, and paste properties. These options are especially useful for quickly formatting objects for layouts that are created using a blank layout. For example, if you have dragged a number of objects from the Library panel onto your layout, you can use Align and Distribute commands to position each object accurately in the layout.

To modify the properties of more than one like object, you can change the property setting on one object, use the Copy Properties to copy the modified object’s properties, and then use the Paste Properties option to paste those modified properties to each like object in the layout.

You can use the formatting options to arrange and format objects in all types of layouts.

Your layout must be in an unlocked state to use the formatting options. See Locking and Unlocking Layouts (on page 159).

Copying and Pasting Layout Object Properties

Use the Copy Properties and Paste Properties options to copy and paste properties between objects of the same type. This option is useful when you want to modify the properties of multiple PiPs. For example, if you want to modify the same property setting for all the PiPs in your layout, select the PiP from which you want to copy properties, use the Copy PiP Properties option to copy those properties, and then paste the properties to other PiPs in the layout using the Paste PiP Properties option.

To access Layout Designer’s Copy Properties and Paste Properties options, select and then right-click on a PiP.

Your layout must be in an unlocked state to copy or paste properties. See Locking and Unlocking Layouts (on page 159).
To copy the properties from a selected object and paste them to another like object in the layout:

1. Right-click the object from which you want to copy properties.
2. From the context menu, select Copy Properties.
3. Right-click the like object to which you want to paste the copied properties.
4. Choose one of the following functions:
   - To paste all of the copied PiP properties, select Paste Properties.
   - To choose which properties to paste, select Paste Selected Properties.
   A Paste Category dialog appears.
5. Choose the categories of properties you want to paste by selecting one or more of the following options:
   - Size
   - Border
   - Others
   Selecting All will select all three options.
6. Click OK.

**Cloning Layout Objects**

The cloning tool creates a control similar to the currently selected control, with the differences being unique number and name, video source, dynamic source PiP number, and UMD address, which are all incremented.

1. Select the layout object to be cloned.
2. Click Clone a Component on the application toolbar.

The new object’s position in the layout canvas is determined by your auto placement preference setting. See Determining Auto Placement (on page 140) for more information.

**Resizing and Moving Layout Objects Using a Mouse**

Your layout must be in an unlocked state to resize or move objects. See Locking and Unlocking Layouts (on page 159). If the layout is unlocked and you cannot move objects, click Allow Component Moving in the Tools palette. See Tools Palette (on page 125).
You can use your mouse to resize and move selected objects in a layout. You can resize objects by clicking, and then dragging the resizing handles that are located around the outer edge of the object. To move an object, select it, and then hold down the mouse button while dragging the object to a different location in the layout. To make fine positional adjustments, after selecting an object in the layout, press the arrow keys on your keyboard to move the selected object.

If the Aspect Ratio property is set to Custom, when you resize a PiP, its width and height resizing are not constrained to the proportions of a set aspect ratio.

When you move an object into alignment with another object in a layout, red lines appear temporarily on the canvas so you can see when they are perfectly aligned.

---

**Working With Groups of Objects**

It is sometimes useful to select a group of like objects and alter them all the same way -- for example, resize all PiPs within a group of windows.

To select more than one object, hold down the CTRL key on your keyboard while clicking the objects in the layout. To remove an object from the selection group, click on it again with the CTRL key held down.
Setting Like Objects’ Properties

1. Right-click a group of objects, which can include one or more windows and select Set properties. A submenu lists all the object types that are selected, including the non-border items in the windows. The sub-menu can contain PiPs, Tallies, Labels, Clocks (analog or digital), Info panels, etc.

2. Select one of the items in the sub-menu to open the properties pane for that type of object.

You can now make changes to all the selected like objects simultaneously.

Removing Like Objects from Control for a Group of Windows

1. If a selection contains a window and at least one other object, right click and select Remove Window Component. A submenu lists all the object types that are selected, including the non-border items in the windows. The sub-menu can contain PiPs, Tallies, Labels, Clocks (analog or digital), Info panels, etc.

2. Select one of the items in the sub-menu to delete all instances of that type of object within the selection, for example all PiPs within the selection.

3. To resize the window to match the size of its contents, right-click and select Consolidate Window.

You cannot remove the first item in a window.

Aligning and Distributing Objects in a Layout

To align or distribute objects in a layout, you can use the Align and Distribute commands, which are located in the application menu or as right-click options when two or more items are selected. You can use the Align and Distribute commands to arrange objects in all types of layouts.

Your layout must be in an unlocked state to align or distribute objects. See Locking and Unlocking Layouts (on page 159).

To access these commands, you must select multiple objects in your layout. To select multiple objects, hold down the CTRL key while selecting individual objects with your mouse. To deselect multiple objects, click on an empty space in the window. The following figure illustrates a layout with multiple selected PiPs.
This table lists the **Align** commands you can use to arrange objects in a layout.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Toolbar Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td><img src="Left.png" alt="Icon" /></td>
<td>Aligns two or more selected objects along the left axis of the first object selected</td>
</tr>
<tr>
<td>Right</td>
<td><img src="Right.png" alt="Icon" /></td>
<td>Aligns two or more selected objects along the right axis of the first object selected</td>
</tr>
<tr>
<td>Top</td>
<td><img src="Top.png" alt="Icon" /></td>
<td>Aligns two or more selected objects along the top axis of the first object selected</td>
</tr>
<tr>
<td>Bottom</td>
<td><img src="Bottom.png" alt="Icon" /></td>
<td>Aligns two or more selected objects along the bottom axis of the first object selected</td>
</tr>
<tr>
<td>Center Vertical</td>
<td><img src="CenterVertical.png" alt="Icon" /></td>
<td>Aligns two or more selected objects along a vertical axis that runs through the center of the canvas</td>
</tr>
<tr>
<td>Middle Horizontal</td>
<td><img src="MiddleHorizontal.png" alt="Icon" /></td>
<td>Aligns two or more selected objects along a horizontal axis that runs through the middle of the canvas</td>
</tr>
</tbody>
</table>

This table lists the **Distribute** commands you can use to arrange objects in a layout.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Toolbar Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widths</td>
<td><img src="Widths.png" alt="Icon" /></td>
<td>Distributes the width distance between two or more selected objects</td>
</tr>
<tr>
<td>Heights</td>
<td><img src="Heights.png" alt="Icon" /></td>
<td>Distributes the height distance between two or more selected objects</td>
</tr>
</tbody>
</table>
Creating Layout Windows

Windows allow you to create containers for layout object compositions or arrangements. Each window can be copied and pasted as a single object. A window can be created from a selection of PiPs, labels, info panels, borders, clocks, audio meters, up/down counters, and tally indicators. After you create a window, you can add it to the Library panel, so it is ready to be dragged onto other layouts.

When you select a window in a layout, you can view and modify all the alarms for all the objects within that window on the Alarms tab of the Properties pane.

You can use the Window Properties tab to modify window properties. Similar to layout objects, windows can be moved and resized in the layout canvas using a mouse. For more information see, Copying and Pasting Layout Object Properties (on page 174).

Your layout must be in an unlocked state to create or break windows, or to modify their contents, position, or size. See Locking and Unlocking Layouts (on page 159).

The following figure illustrates window specific options and operations.

1. Create a window by selecting the layout objects that you want to include, and then use the context-menu’s Create a Window command. You can add your new window to the Library panel. See Creating New Windows (on page 180)

2. Break apart a selected window. For information, see Breaking Apart a Window (on page 181).
3 Drag a window from the Library panel and drop it on to the layout canvas. For information, see Adding Layout Objects to a Layout (on page 171).

4 Add PiPs and other layout objects for use as a window in your layout. Working With Groups of Objects (on page 176).

5 Modify window properties and configure window settings using the Window Properties tab. Modifying Window Properties Using the Properties Pane (on page 181).

Creating New Windows

You can create a window from two or more selected layout objects in any combination, including other windows, to form a new window. When layout objects become part of a window, they maintain their position, order, and size. The window background and border are the lowest layer among the objects contained in the window. This means that layout objects that are part of the window cannot be positioned behind the window background.

The properties of individual Layout objects can be modified when they are contained within a window. However, you cannot resize or position objects beyond the borders of the window.

To create a window:

1. To select multiple layout objects you want to add to the new window, hold down the CTRL key while selecting individual objects with your mouse.

2. Right-click the objects, and then select Create a Window from the context menu.

After you create a new window, you can add it to the Windows tab of the Library panel by selecting Add Window to Library.
The layout objects are superimposed over the window background, and surrounded by a layout border. You can name the window and modify some window properties using the **Window Properties** tab. For more information, see *Modifying Window Properties Using the Properties Pane* (on page 181).

To view your new window on output display devices, you must publish the current layout to the multiviewer hardware. For information, see *Displaying and Publishing Layouts* (on page 163).

### Breaking Apart a Window

When a window is broken apart, the objects contained in the window maintain their order in the canvas.

To break a window apart:
1. Select the window you want to break apart.
2. Right-click, and then choose **Break Window** from the context window.

### Consolidating a Window

If you have removed objects or changed their positions within a window, right click on the window and choose **Consolidate Window** to recreate the window.

If more than one window is selected and you select **Consolidate Windows**, this option consolidates all windows within the selection.

### Modifying Window Properties Using the Properties Pane

You can use the **Windows Properties** tab to modify window properties such as window size and position. Window border size and color properties are modified using the **Borders** tab.

To view your modifications on output display devices, you must publish the current layout to the multiviewer hardware. For information, see *Displaying and Publishing Layouts* (on page 163).

### Viewing Window Properties

To access the Windows Properties tab:
1. In the canvas, select the window you want to modify.
2. If the Properties pane is not open below the layout canvas, select **View > Properties**.

### Naming Windows

The name you give to a window identifies it when you add the window to the Library panel.

To name your new window:
1. In the **Windows** Properties tab, under **Details**, type a name into the **Name** field.
Modifying the Contents of a Window

To select the individual components in your window, the window must be unlocked.

To unlock the contents of the window:
1. Do either of the following:
   - In the Windows Properties tab, under Details, clear the Lock Objects in Window field.
   - Right-click on the window in the canvas and unselect Lock Window.
2. Change the properties of individual items within the window, including size, position, and other attributes.

To lock the contents of the window:
1. Do either of the following:
   - In the Windows Properties tab, under Details, select the Lock Objects in Window field.
   - Right-click on the window in the canvas and select Lock Window.
2. Click anywhere in the window, including any object contained within it, to move, resize, or adjust the attributes of the entire window.

Modifying a Window’s Background

Windows are created with a user-defined default background color. You can select a color or a pre-defined graphic image as the background to your window.

To modify a window’s background:
1. Under Appearance, select either Color or a predefined background image from the drop-down list.
2. If you selected Color from the Set Background list, click the icon to open the Select a Color dialog box.
3. Select or enter a color value.
   - Your selected color is previewed below Selected Color.
4. If required, use the Opacity slider to adjust the color’s opacity value.
5. Click OK.

Resizing and Moving Windows Using the Windows Properties Pane

Use the Windows tab on the Properties panel to resize and move windows. When you resize or move a window, the properties of the layout objects contained in the window are not modified. For example, if you resize a window, the layout objects remain anchored in their original position.

To resize a window:
1. Under Position & Dimensions, type or select values for the width and height in the Width and Height fields.
To move a window:

1. Under **Position & Dimensions**, type or select values for the window’s horizontal position in the **Left** field and vertical position in the **Top** field.

The **Left** control positions the window horizontally using the left edge of the layout canvas as the point of reference. A value of 0 places the window along the left edge of the layout canvas. The **Top** control positions the window vertically using the top edge of the layout canvas as the point of reference. A value of 0 places the window along the top edge of the layout canvas.

---

**Modifying Border Properties**

Borders display a user-defined graphic area around some layout objects, such as PiPs, windows, and labels. Like other layout objects, individual properties determine how the borders appear around supported layout objects. Border properties can only be modified using the **Borders** tab of the Properties pane. You cannot use your mouse to modify object borders directly in the canvas.

Your layout must be in an **unlocked** state to change a border’s properties. See **Locking and Unlocking Layouts** (on page 159).

Borders normally provide a graphic area around PiPs and windows. However, when a border is applied to a PiP, and that PiP is in an alarm state, the border can be used to signal an alarm condition. For example, you can create customized borders for Black Video and Frozen Video alarm conditions. See **Alarms and Info Panels** (on page 219) for more information.

Default values for **Border** property settings are defined in the **Layout Designer Preferences** dialog box. See **Setting Your Layout Designer Preferences** (on page 138).

---

**Selecting a Border for Modification Within a Window**

Multiple objects within a window can have border properties. In order to modify the border properties of a PiP or other object within a window, you must first select that object. By default, when you select a window and then select the **Borders** properties tab, you modify the border of the window itself.

To modify the border of an object within a window:

1. Right-click on the window.
2. Select **Borders > [Component] Border** where [Component] is the item with a border that you want to modify.
3. Make modifications on the **Borders** properties tab.

Within the Borders submenu, you can select the window itself and any sub-windows it may contain, as well as PiPs and labels.

---

**Applying Borders Using the Properties Pane**

To apply a border style from the Properties pane, you must first select a layout object that supports borders. This includes PiPs, info panels, and windows.
1. From the Properties pane, click the Borders tab to display the selected layout object’s border properties.

2. Click an item in the Border Styles field, and then click Apply.

### Modifying Borders Using the Properties Pane

To modify a border style, click Edit Style. The tools are the same as those used in creating a border style. See Creating New Border Styles (on page 185) for more information.

1. From the Properties pane, click the Borders tab to display the selected layout object’s border properties.

2. To set the width, do one of the following:
   - To set a uniform border width around the layout object, under Border, select Uniform, and then type or select a border weight in pixels.
   - To set different values for the top, bottom, left, and right border weights, clear Uniform, and then type or select border weight values in the Top, Bottom, Left, and Right boxes.

3. To select a new border color:
   a. Click Edit Border Colors to open the Border Colors dialog box.
   b. On the Normal tab, click beside Primary Color to set the color of the border before an alarm or tally is triggered.
   c. Click OK.

4. From the Style drop down box, select from the following outline styles and effects:
   - Normal - Border outline has color characteristics only
   - Rounded - Border outline has four rounded corners, instead of square corners
   - Beveled - Border outline has a beveled edge effect
   - Texture - Border fill is textured. You can select from three texture styles

You can also select combinations of outline styles and effects (Rounded Texture 1).

For information on filling out the Color Selector dialog box, see Setting Default Window Properties (on page 142).
Creating New Border Styles

Using the Properties pane, you can create new border styles which can be applied to layout objects such as PiPs, windows, and labels. After you create a border style, it appears in the Borders Properties tab under Border Styles. The border you create or modify is displayed in the Border Styles dialog box under Preview.

Setting new border style details:

1. In the current layout, select an object that has an associated border.

The Border Styles dialog box appears.

3. Under Details, type a name for your new label style in the Name field. This name is used to identify the style in Border Styles section of the Borders Properties tab.
4. From the Style drop down box, select from the following outline styles and effects:
   - Normal - Border outline has color characteristics only
   - Rounded - Border outline has four rounded corners, instead of square corners
   - Beveled - Border outline has a beveled edge effect
   - Texture - Border fill is textured. You can select from three texture styles

You can also select combinations of outline styles and effects (Rounded Texture 1).

The following topics describe other areas of borders that are available for modification.

- Setting Border Size (on page 185)
- Setting the Border State Source (on page 186)
- Setting Border Colors (on page 186)

Setting Border Size

Do one of the following:
To set a uniform border width, under **Size**, select **Uniform**, and then type or select a border weight in pixels in the **Size** box.

![Size box](image)

To set different values for the top, bottom, left, and right border weights, clear **Uniform**, and then type or select border weight values in the **T**, **B**, **L**, and **R** boxes.

### Setting the Border State Source

In the **Border State Source** area, there are three options:

<table>
<thead>
<tr>
<th>Border State Source Option</th>
<th>Configuration Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>UMD/Tally System (Fixed UMD Addr)</td>
<td>Select the <strong>UMD address</strong> that will be the input source for the border.</td>
</tr>
<tr>
<td>UMD/Tally System (Under Monitor Display)</td>
<td>Select the <strong>PiP Number</strong> that will be the input source for the border.</td>
</tr>
<tr>
<td>Source UMD</td>
<td>See the <strong>Source UMD</strong> tab in the Advanced Configuration dialog box for mapping. For more information, see [Binding UMD Addresses to Input Sources](on page 113).</td>
</tr>
</tbody>
</table>
| Alarm Rule | Select this option if you want the border to be the target for an alarm, and then follow these steps to define the alarm source:  
1. With the border selected in the layout, select the **Alarms** tab in the **Properties** pane.  
2. Following the instructions in [Defining Alarms for a Layout Object](on page 223), configure the **Detectors** and **Actions** pages of the **Rules** dialog box.  
On the **Actions** page, choose **Set Tally Alarm State**, and complete the **Action Parameters** section for that action. |

For UMD/Tally options, make the following selections:

- **Tally Number**—the number of the tally within the UMD address that is monitored.  
- **Program Number**—Enter the correct number in this field if you are using Ross Protocol. If you are using another protocol, the data in this field will be ignored.

### Setting Border Colors

You can set primary and secondary colors, and add animation and lighting effects to the border.

1. On the Border Properties pane, click **Edit Border Colors**.
The **Border Colors** dialog box opens.

2. Select the tab that identifies the state that you want to edit.
   
   For a static border, select **Normal**.

3. To create or modify a border for a tally or alarm, you can select colors that identify the border’s primary and secondary states. Layout Designer provides **Custom**, **Web**, and **System** color palettes.
   
   To select your new border color, make the following selections:
   
   - Click beside **Primary Color** to set the color of the border before an alarm or tally is triggered. You can choose colors from a menu.
   
   - Click beside **Secondary Color** to set the color of the border after an alarm or tally is triggered.

4. To add a spotlight effect to your border, select **Add Spotlight**, and then choose the angle from which the light appears from the **Light Position** menu.

   The spotlight effect is only available when the border style is Beveled or Rounded Beveled.

5. To apply animation effects to the border state, select one of the following from the **Animation** drop-down list:
   
   - **Color Change**—Applies a primary to secondary color change to the border
   
   - **Moving Light**—A moving light travels around the border perimeter.
   
   - **Flashing/Transition**—The lighting flashes and changes to different colors.

   The animations are not displayed on the Layout Designer canvas, and can only be viewed once the layout is published to a display.
Working with PiPs

PiPs display the input video from a single input channel. You can input video channels to PiPs for display on multiviewer output display devices. Each PiP has a number of properties that determine how it is displayed in the layout. PiP properties are independently set; each PiP in a layout can have a different set of PiP properties. All properties associated with a PiP can be modified using the Properties pane. You can also select a PiP in the layout and use your mouse to resize and move a PiP in a layout as well as format groups of PiPs using the align and distribute commands.

Layouts made from the Layout Creation Wizard are preconfigured with a predetermined number of PiPs and predefined PiP properties.

For information about adding PiPs from the Layout Object library, see Adding Layout Objects to a Layout (on page 171).

You can modify all PiPs, regardless of how they were created.

Your layout must be in an unlocked state to add, move, or delete objects. You can adjust properties of objects on a locked layout. See Locking and Unlocking Layouts (on page 159).

The following figure illustrates the various PiP operations.
1. Insert a PiP into a layout using the tool palette. See Adding PiPs to a Layout (on page 189).

2. Move and resize PiPs using your mouse. See Resizing and Moving Layout Objects Using a Mouse (on page 175).

3. Insert a PiP into a layout using the Insert > PiP command. See Adding PiPs to a Layout (on page 189).

4. Add PiPs to the Library panel. See Adding Objects to the Library Panel (on page 147).

5. Copy and paste PiP properties from one PiP to one or more other PiPs. See Copying and Pasting Layout Object Properties (on page 174).

6. Drag PiPs from the Layout Designer Library and drop them onto a layout. See Adding PiPs to a Layout (on page 189).

7. View PiP source information by clicking on the icon in the middle of the PiP.

8. Modify PiP properties using the PiP Properties pane. See Modifying PiPs Using the Properties Pane (on page 189).

---

### Adding PiPs to a Layout

You can use the canvas Tool palette and the application menus to add PiPs. You can also drag PiPs from the Library panel, and then drop them onto the canvas. For information about using the Layout Designer library, see Adding Layout Objects to a Layout (on page 171).

PiPs added to the layout canvas have default properties. See Setting Default Layout Properties (on page 140).

To add a PiP to your layout:

1. Do either of the following:
   - Select Insert > PiP from the main menu.
   - From the tool menu at the left of the screen, click PiP.

---

### Modifying PiPs Using the Properties Pane

Layout Designer provides a numbers of way to modify the appearance, size, and position of a PiP in a layout. You can use the PiP properties tab to modify a selected PiP by adjusting PiP property values such as width and height, and by selecting or changing the input channel you want the PiP to display in a layout. After completing the required modifications, you can copy the properties from the modified PiP,
and then paste them to other PiPs in the same layout. See Copying and Pasting Layout Object Properties (on page 174).

To access the Properties pane:

1. Select **View > Properties**.

![Properties Pane](image)

**Note:** The PiP Number is used by control panels to switch between video sources on a PiP.

See the following sections for additional PiP related modifications:

- Applying Borders Using the Properties Pane (on page 183)
- Creating New Border Styles (on page 185)
- Copying and Pasting Layout Object Properties (on page 174)
- Resizing and Moving Layout Objects Using a Mouse (on page 175)
- Aligning and Distributing Objects in a Layout (on page 177)

## Modifying PiP Size and Aspect Ratio

PiP width and height sizes do not include border size. The minimum PiP size for 4:3 and custom aspect ratios (available in Platinum SX Hybrid only) is 113×85 pixels. The minimum PiP size for 16:9 aspect ratio is 114×64 pixels. Maximum PiP size depends on the video standard of the input channel. When PiPs are resized, the width and height proportions are constrained by the aspect ratio. When you select a custom aspect ratio, the width and height sizes are not constrained.

You can set the default PiP width value in the **Default Preferences** tab of the **Layout Designer Preferences** dialog box. For more information, see Setting Default Layout Properties (on page 140).

To modify PiP size and aspect ratio using the Properties pane:

1. In the layout, select the PiP you want to modify, and then select the **PiPs** tab from the **Properties** pane.
2. Under **Video/Graphics Dimensions**, select the aspect ratio that you want to use from the **Aspect Ratio** list.

![Properties Pane](image)
3. To set the PiP width and height, type or select in the **Width** and **Height** boxes. The aspect ratio is maintained when you select a value for width and height.

4. (Optional) Add markers to your PiP.

5. Under **Cropping & Markers**, choose one of the following options:

   - **Aspect Ratio Markers**—An indicator of correct aspect ratio on the PiP to let you know whether the video is properly scaled when a source that is one aspect ratio is put on a PiP that has a different aspect ratio. Options include:
     - **Enable 4:3** shows a 4:3 aspect ratio marker on a 16:9 PiP.
     - **Enable 16:9** shows a 16:9 aspect ratio coded frame a within a 4:3 frame.
     Both aspect ratio options can be selected at the same time.
     To determine the color of the marker, click **Color**, make a selection, and then click **OK**.
   - **Safe Area**—adds a Title Marker indicator on the PiP to indicate the safe area for titles to be displayed (80% of the picture area).
     Click **Title Marker** to activate a marker on the PiP. To determine the color of the marker, click **Color**, make a selection, and then click **OK**.
   - **Active Format Description**—adds an indicator that displays the AFD description present in the incoming video. There are two options:
     - **AFD** - HD and SD video
     - **WSS** - SD 625 video only (with this option, choose the line to read WSS data from in the video stream)
     To determine the color of the marker, click **Color**, make a selection, and then click **OK**.
     From the drop-down menu, there are two options:
       - **Display** mode—markers on the multiviewer PiP indicate the active picture area indicated by the AFD code or WSS code on the input.
       - **Convert** mode—scales the video on the input source as indicated by the AFD code or WSS code on the input.

The Total Width and Total Height indicators describe the size of the PiP including the border. See **Modifying Border Properties** (on page 183) for more information.
Setting PiP Cropping Values

You can use Layout Designer’s cropping tool to crop the top, bottom, left, and right edges of a selected PiP. All cropping values are in pixels. When cropping a PiP, the cropping area you set is indicated by a red dotted line.

Be aware of the following:

- Switching video input standards on a PiP may affect how the current cropping values are applied to the input video.
- When publishing default layouts stored on the multiviewer hardware, ensure that the cropping area (indicated by the red dotted lines on the PiP in the window) is properly set.

To crop a selected PiP:

1. Under **Cropping & Markers**, select **Cropping**.
2. Do one of the following:
   - To set a uniform cropping area around the PiP, under **Cropping**, type or select a cropping width in the **Pixels** box, and then select the **Uniform** check box.
   - To set different values for the top, bottom, left, and right cropping, clear the **Uniform** check box, and then type or select a cropping width in the **Top**, **Bottom**, **Left**, and **Right** boxes.

Selecting a PiP’s Input Source

Under **Source & Format** on the PiPs Properties tab, you can modify the input source of selected PiPs.

- **Channel** — You can select any of the video channels that are input to the multiviewer from the EPIC-MV-UCIP and/or EPIC-MV-3G modules installed in the EPIC™ MV. You can also select PiPs shared by another device on the Pip Sharing network, and compressed video over IP (from SDNO). See **Selecting a Channel for Display on the PiP** (on page 193).
- **VNC** — When you choose a VNC server as the source for a PiP, many of the PiP controls in the PiP Properties pane are disabled (for example, Cropping & Markers, Scope options, and CCS-P Dynamic Name Reference). See **Selecting a VNC Source** (on page 197).
Selecting a Channel for Display on the PIP

The Channel and Source settings determine what is displayed on the PIP when the layout is published or selected to be displayed.

A Channel is like a Destination in the Router world, and can be one of the following:

- An input to either an EPIC-MV-UCIP or EPIC-MV-3G board in the EPIC™ MV
- A PIP from another device on the PIP Sharing network, as described in Connecting to the PIP Sharing Network (on page 51)
- Compressed video over IP (CIP), as configured in Using Compressed Video (on page 54)

**Note:** If a PIP source is used either in the same Layout or in another Layout on the same multiviewer, rather than formatting and manipulating the same content again, in order to conserve system resources, EPIC™ MV creates a PIP copy. PIP copies are in addition to the 48 input channels; however, they do use system resources to render.

1. Select an input channel from the Channel drop-down list.

Channels are listed in the Channel menu first with direct inputs to the EPIC™ MV, first with up to 12 inputs to the board in PCIe slot 1, then slot 2, then slot 3, then slot 6. Following these are PIPs shared by another device on the PIP Sharing network (if configured), and then Compressed IP video. The Channel Menu is fully described in Channel Numbering and Naming Conventions for PIPs (on page 193).

2. If your channel is from a EPIC-MV-UCIP module or a CIP input, make a selection from the Source menu.

The Source menu field is not available if the selected Channel is SDI, or if it is a channel shared from another EPIC™ MV device.

If you leave this menu blank on an SDNO-configured source, the source is defined using SDNO routing. If routing is not configured in SDNO for this input, the PIP will appear blank. PIPs that have a blank source field configured will display the last-selected signal.

**Channel Numbering and Naming Conventions for PIPs**

Channels are listed in a pre-defined order, with pre-defined ranges, and with the following naming convention:
### Starting Channel Number

<table>
<thead>
<tr>
<th>Starting Channel Number</th>
<th>Input Type</th>
<th>Slot</th>
<th>Port</th>
<th>First Channel ID</th>
<th>Name</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>UCIP or SDI</td>
<td>S1</td>
<td>C1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>UCIP or SDI</td>
<td>S2</td>
<td>C1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>UCIP or SDI</td>
<td>S3</td>
<td>C1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>UCIP or SDI</td>
<td>S4</td>
<td>C1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>PIP Share</td>
<td></td>
<td>C1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>513</td>
<td>CIP</td>
<td>E0</td>
<td>P1</td>
<td>C1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>545</td>
<td>CIP</td>
<td>E0</td>
<td>P2</td>
<td>C1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>577</td>
<td>CIP</td>
<td>E0</td>
<td>P3</td>
<td>C1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>609</td>
<td>CIP</td>
<td>E0</td>
<td>P4</td>
<td>C1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>641</td>
<td>CIP</td>
<td>E7</td>
<td>P1</td>
<td>C1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>897</td>
<td>CIP</td>
<td>E7</td>
<td>P2</td>
<td>C1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If a slot is occupied by an EPIC-MV-UCIP, its channels can be defined in the SDNO database, from whence the Name is appended.

SDI channels from EPIC-MV-3G boards are not routed through SDNO and do not support names.

Defined in the PIP Share configuration file. See PIP Share Config File (on page 52).

Designated in SDNO.

The physical PCIe slots on the EPIC™ MV may contain EPIC-MV-UCIP or EPIC-MV-3G boards. If the Input Type is UCIP, you can make a selection from the Source menu. The Source menu is not available for SDI inputs. If a slot is empty, None is indicated for each of the 12 inputs possible for that slot. UCIP modules do not list the Port as part of the PIP name, though Port is included in the SDNO database.

The Source menu is not available for PIP shares. The source of these channels is determined at the originating EPIC™ MV.

CIP stands for compressed video over IP. See Using Compressed Video (on page 54) for details.

Ranges for CIP channels are larger than you should reasonably use. For best results, keep your use of CIP channels to 24 or fewer.

CIP channels permit selection from the Source menu.

---

So if you have a Channel named 15 - SDI - S2 C3, you can tell that it is coming from the third channel on slot 2, which contains an EPIC-MV-3G board.

### Choosing a PIP Display Mode (PIP Sources Only)

When a 16:9 source is displayed on a 16:9 PIP, or when a 4:3 Source is displayed on a 4:3 PIP, no display mode processing is required.

The Display Mode menu offers the following display options:

- **Letterbox/Pillarbox** mode displays all of the video image of a source, even if the source aspect ratio of the source and the pip do not match while maintaining source aspect ratio.
However, when a 16:9 source is displayed on a 4:3 PiP, Letterbox formatting is applied (top and bottom bars), as below:

![Letterbox Example](image)

**16:9 Input (Left) Displayed on a 4:3 PiP (Right) With Letterboxing**

When a 4:3 source displayed on a 16:9 PiP, Pillarbox formatting is applied (left and right bars) as below:

![Pillarbox Example](image)

**4:3 Input (Left) Displayed on a 16:9 PiP (Right) With Pillaring**

- **FullPIP** mode stretches or clips the video image to fill the extents of the PiP if necessary, while maintaining the pixel aspect ratio.
  
  When a 16:9 source is displayed on a 4:3 PiP, the left and right bands of the video are clipped, as below:

![Clipping Example](image)

**16:9 Input (Left) Displayed on a 4:3 PiP (Right) With Clipping**

When a 4:3 source is displayed on a 16:9 PiP, the top and bottom bands of the video are clipped, as below:

![Clipping Example](image)

**4:3 Input (Left) Displayed on a 16:9 PiP (Right) With Clipping**

- **Stretch** mode stretches the video to fit in the PiP container without respecting pixel aspect ratio.
When a 16:9 source is displayed on a 4:3 PiP, the top and bottom of the video are stretched, as below.

16:9 Input (Left) Displayed on a 4:3 PiP (Right) With Horizontal Compression

When a 4:3 source is displayed on a 16:9 PiP, the left and right sides of the video are stretched, as below.

4:3 Input (Left) Displayed on a 16:9 PiP (Right) With Horizontal Stretching

• **Anamorphic Stretch** mode also stretches the video to fit in the PiP container.
  When a 16:9 source is displayed on a 4:3 PiP, the top and bottom of the video are anamorphically stretched, as below.

16:9 Input (Left) Displayed on a 4:3 PiP (Right) With Horizontal Compression

When a 4:3 source is displayed on a 16:9 PiP, the left and right sides of the video are anamorphically stretched, as below.

4:3 Input (Left) Displayed on a 16:9 PiP (Right) With Horizontal Stretching

**Destination Follow**

Follow Destination functionality only applies to systems using SDNO in concert with EPIC™ MV. The destinations to be followed are based on LRC destinations as defined in the SDNO database, with
indications of destination changes being broadcast by SDNO, picked up by EPIC™ MV where PiP changes occur.

To configure Router Follow, follow these steps:

1. Under Options, check **Follow Dest.** and to the right of the **Follow Dest.** checkbox, select a destination from the menu.

2. In the **Level** field, enter the router level for the PiP to follow.

**Selecting a VNC Source**

1. Under **Source**, click **VNC**.

2. Enter the IP address or host name, port number, and the password for the VNC server.

3. Click **Test** to validate the IP address.
   - **Red**—The IP address is invalid.
   - **Grey**—The IP address is valid.

When choosing VNC PiPs, keep in mind the following:

- If one or more VNC PiPs have an inaccessible or invalid IP address, the multiviewer will wait for that/those PiPs to time out before loading the rest of the VNC PiPs.
- Some VNC servers terminate the connection after a period of inactivity.
- Some VNC servers lose connection when a user access control pops up, or when the computer is locked.
- The more frequently a VNC server's desktop updates, the worse the appearance will be. Static graphics will look better than a video clip.
For best results, use UltraVNC, or another VNC server that uses server-side scaling. Imagine Communications multiviewers do not support NT Logon authentication or VNC encryption.

Moving a PiP Using the Properties Pane

You can use the PiP Properties tab to resize/reposition PiP(s) in a layout. Using the Top Position and Left Position controls, you can position a PiP by setting the number of pixels from the top edge and left edge of the layout.

To move a PiP using the Properties pane:

1. In the layout, select the PiP you want to modify, and then select the PIPs tab from the Properties pane.
2. Under Position & Size, in the Left and Top boxes, type or select a new left and top position for the selected PiP.

You can also use your mouse to modify PiP width, height, left position, and top position. For information, see Resizing and Moving Layout Objects Using a Mouse (on page 175).

Defining PiP Names

This option is not available for VNC Source PiPs.

In the Name field, you can change the title that designates the PiP in the Alarms Properties pane, etc.

The dynamic name for the PiP will appear on Magellan Control Panels. Change the PiP’s dynamic name in the CCS-P Dynamic Name Reference section of the dialog box:

<table>
<thead>
<tr>
<th>Tally State Source Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Router Database Source Name</td>
<td>The PiP name will update the router source (as defined in the router database) that is associated with the specified PiP number. If a switch on the router causes a change in the PiP input source, the PiP source will follow. Choose which name in the router database to display (Logical, Status, Long Name, or Alias)</td>
</tr>
<tr>
<td>Tally State Source Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Router Database</strong></td>
<td>The dynamic name is acquired from the router database’s Destination column.</td>
</tr>
<tr>
<td><strong>Destination Name</strong></td>
<td></td>
</tr>
<tr>
<td><strong>UMD/Tally System</strong></td>
<td>Select the <strong>UMD address</strong> that will be the source of the UMD name.</td>
</tr>
<tr>
<td><strong>(Fixed UMD)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>UMD/Tally System (Source UMD)</strong></td>
<td>See the <strong>Source UMD</strong> tab in the Advanced Configuration dialog box for</td>
</tr>
<tr>
<td><em>(Under Monitor Display)</em></td>
<td>mapping. For more information, see [Binding UMD Addresses to Input Sources](on page 113).</td>
</tr>
</tbody>
</table>
On-Screen Data Tools

Layout Designer provides on-screen tools that you can add to layouts to provide data, feedback, and other information. You can create customized audio meters, tally indicators, labels, and clocks for each layout.

Use Layout Designer’s on-screen data tools to monitor your system input signals and set up automatic responses to alarm conditions and operational events. The following figure illustrates Layout Designer’s on-screen data tools in a layout.

1. **Tally indicators** display the monitoring status from UMD protocol, GPI inputs, or alarms/rules. You can apply various colors and behaviors to each tally indicator individually. See Creating Tally Indicators (on page 204).

2. **Audio meters** display the audio levels from Dolby E, discrete audio, or embedded input sources. You can assign up to 16 audio meters to each PiP in a layout. See Creating Audio Meters (on page 201).
3 **Labels** can display static or dynamic information, or display text using alarms/rules. See [About Labels](#) (on page 208).

4 **Clocks** can be either analog or digital, and can display various time zones. See [About Layout Clocks](#) (on page 212).

5 **Up/down counters** are unidirectional. See [About Up/Down Counters](#) (on page 215).

---

**Creating Audio Meters**

You can associate up to 16 individual audio channels (or 8 channel pairs) to each PiP for audio metering purposes. Audio meters for each of these assigned channels can be positioned anywhere in the canvas, including superimposed on their associated PiPs. A router PiP might have two groups of four bar meters on each side, although you can choose any number of channels to monitor (to a maximum of 16). The number of channels displayed depends on the type of audio service to be monitored (i.e., stereo or Dolby 5.1).

Your layout must be in an **unlocked** state to add, move, or delete objects. You can adjust properties of objects on a locked layout. See [Locking and Unlocking Layouts](#) (on page 159).

Audio meters are associated with PiPs by mapping the audio source channels to a source PiP. You can map audio to PiPs, and change other audio meter-related properties using the Audio Meters tab of the Properties pane.

Creating audio meters for layouts can be divided into these tasks:

- Mapping audio meters
- Changing the appearance of audio meters
- Changing the size and position of the audio meters.

The following illustrates the controls available from the Audio Meter tab of the Properties pane that are used to perform these tasks.

1. **Audio Meter Number** - Auto-assigns each audio meter an unique number

2. **DolbyE** - Use this menu to select the Dolby E audio pair to be displayed and monitored. See [Configuring Dolby E Monitoring](#) (on page 254).
3 **Setting audio meter size and position** - Use these controls to set the width and height of your meter and set the meters position in the layout. See [Setting Audio Meter Size and Position](on page 204).

4 **Mapping audio meters** - Use these controls to assign audio source channels to meters as associated meters to source PiPs. See [Mapping Audio Meters](on page 202).

5 **Setting audio meter appearance properties** - Use these controls to set the meter scale, color transition points, and number of channels from the audio source you want to meter. You can also set background and text color. See [Setting Audio Meter Appearance Properties](on page 203).

You can:

- Resize and move audio meters using your mouse. See [Formatting Layout Objects in the Canvas](on page 174).
- Add audio meters to a window. For more information, see [Creating Layout Windows](on page 179).

**Adding Audio Meters to a Layout**

Audio meters that are added to a layout using the Tool palette appear as the default audio meter type.

To add an audio meter:

1. Select **Insert > Audio Meter** or **Insert > 5.1 Audio Meter**.

**Mapping Audio Meters**

Audio mapping is the process of selecting the audio source and audio channels that you want to see metered on the selected PiP. Use the **Audio Meters** tab of the **Properties** pane to map audio channels to source PiPs.

To map audio meters:

1. Select the audio meter that you want to map.
2. Select the **Audio Meter** tab on the **Properties** pane.
3. Choose an audio source.
   - **Use Source** offers two options:
     - **Channel** lists IN 1 to IN 48.
     - **Source** lists SDNO sources.
   - If you select **Track Source of PiP**, you can select a PiP ID.

If the router source of a PiP is changed later, the router source of the associated audio meter will NOT change unless the PiP and audio meter are grouped as a window. For more information, see [Creating Layout Windows](on page 179).

4. In the **Start At Channel** field, select the first audio channel of the audio source that you want to meter.
5. In the **Audio Service** field, use the up/down arrows.
   - The range is 1 - 3.
6. (Optional) Place a check beside **Discrete Audio** to use non-embedded audio.
Discrete audio is not available if your audio source is IP. Discrete audio needs to be configured in CCS Navigator. See your Navigator documentation for more information.

You can configure info panels to indicate the audio channels that are being monitored. For more information, see Configuring Audio Monitoring (on page 254).

Setting Audio Meter Appearance Properties

After you have mapped the audio channels that you want to meter, set the audio meter appearance properties.

Selecting Meter Scale Properties

Choose whether you want to display a scale on your audio meters and select on which side of the meter you want to position the scale.

to set meter scale properties:

1. Select the Audio Meter tab on the Properties pane.
2. To show or hide the meter scales, select or clear Show Scales.
3. If you selected Show Scales, select the position of the meter’s scales.
   ▪ For vertical bars, select either Left or Right.
   ▪ For horizontal bars, select either Top or Bottom.
   This setting is not available on 5.1 audio meters.
4. To select the number of channels you want to meter, enter a value from the Number of channels list. (This setting is not available on 5.1 audio meters.)
5. To show or hide the phase meter, select or clear Show Phase Meter.
   Regardless of the type of meter, phase meters appear in the lower portion of the area taken up by the audio meters.
   When a phase meter is enabled, the meter fully to the right side in the green zone indicates a phase difference of 0 degrees. The meter fully to the left side of the red zone indicates a phase difference of 180 degrees. A properly phased stereo pair produces a phase meter that moves within the green zone, and a reversed channel produces a pointer that moves within the red zone.
6. To modify the opacity of the audio meter, beside Meter Bar Opacity, type or select a percent opacity value for the selected meter(s).
7. Do either of the following:
   ▪ To select the label text color, click Text Color.
   ▪ To select the background color, click BG Color.
   The Select Color dialog box appears.
8. Select a color value.
9. Use the Opacity slider to adjust the color’s opacity value.
10. Click OK to save your color changes.
Setting Meter Transition Points

Each audio meter type has default red-yellow and yellow-green transition points. These transition points can be modified to suit your audio sources. For example, you can customize the transition point, in percentage of the overall meter height, of where the yellow portion of the meter turns to red.

To set meter color transition points:

1. Select the Audio Meter tab on the Properties pane.
2. On the Color Transition Point drop-down list, select the metering transition point style that you want to use.

   Each transition point style in the list corresponds to a standard audio meter type.
3. Use the sliders to do either of the following:
   - Use the Green-Yellow slider to adjust the transition point, in percentage of the overall meter height, where the green portion of the meter turns to yellow.
   - Use the Yellow-Red slider to adjust the transition point, in percentage of the overall meter height, where the yellow portion of the meter turns to red. Typically, the red-yellow transition corresponds with 0 dB on analog audio scales.

Setting Audio Meter Size and Position

There are four control settings that you can use to specify the size and position of the audio meters:

- Width
- Height
- Left Position
- Top Position

To set the audio meter size and position:

1. Select the Audio Meter tab on the Properties pane.
2. In the Size & Position area, enter the value for height in the Height field.

   The width cannot be changed.
3. To move the selected audio meters, enter the left and top position values (in pixels) in the Left Position and Top Position fields.

The Left Position value is the number of pixels from the left edge of the layout. The Top Position value is the number of pixels from the top edge of the layout.

You can also use your mouse to resize and move audio meters in the layout canvas. For more information, see Formatting Layout Objects in the Canvas (on page 174).

Creating Tally Indicators

Add on-screen tally indicators to your layout to indicate alarm conditions or other operational instances such as rule conditions. Use the Tally tab of the Properties pane to change a tally’s shape, color, and
behavior during an alarm state so that you can make each tally’s appearance unique and easy to identify.

Image Video protocol colors map to the alarm states. Other tally systems that do not support color are mapped to the tally system color.

Your layout must be in an unlocked state to add, move, or delete objects. You can adjust properties of objects on a locked layout. See Locking and Unlocking Layouts (on page 159).

Adding Tally Indicators to a Layout

Tally indicators that are added to a layout appear in the default tally style. Once you have added a tally, you can change its appearance.

To add a tally indicator to your layout:

1. Select Insert > Tally.

Modifying Tally Indicator Properties

Each tally that you add to your layout has a set of individual properties that determine its appearance, its behavior, and the alarm or processing rule it indicates in the layout.

To view a tally’s properties, in the layout canvas, select the tally indicator that you want to modify, and then select the Tally tab of the Properties pane.

Naming the Tally Indicator

You can give your new tally indicator a unique name that identifies it in the layout when it is associated with GPIO devices.

To name a tally:

1. Select a tally indicator in the layout.
2. Select the Tally tab on the Properties pane.
3. In the Properties area, type a name for the tally indicator in the Name field.

Selecting a Tally Indicator Shape

You can change the shape of a tally indicator at any time by choosing a new shape from the Tally Style list.
To select a new tally indicator shape:
1. Select a tally indicator in the layout.
2. Select the Tally tab on the Properties pane.
3. In the Properties area, select a new shape from the Tally Style list.

Resizing and Moving a Tally Indicator

Use the Position & Values controls to resize and move your tally.

To modify tally size and position:
1. Select a tally indicator in the layout.
2. Select the Tally tab on the Properties pane.
3. In the Position & Value, do either of the following:
   ▪ To resize the selected tally indicator, enter the width and height values (in pixels) in the Width and Height fields.
   ▪ To move the selected tally, enter the left and top position values (in pixels) in the Left Position and Top Position fields.

   The Left Position value is the number of pixels from the left edge of the layout. The Top Position value is the number of pixels from the top edge of the layout.

You can also use your mouse to resize and move tally indicators in the layout canvas. For more information, see Formatting Layout Objects in the Canvas (on page 174).

Setting Tally States

You can assign different colors, behaviors, and alarm conditions to each tally indicator. There is one Normal state, three Alarm states (Normal, Alarm Low, Alarm Medium, and Alarm High), and the Tally state. You create the following settings for each state:

**Primary color**

The primary color represents the tally color in its primary/initial state. You can set the primary color to Off, Green, Yellow, Amber, or Red. The primary color of the Low level alarm is the tally color On state from an external UMD tally protocol.

**Secondary color**

The secondary color represents the tally color in its secondary state, when it is flashing in animation mode. You can select from Off, Green, Yellow, Amber, and Red for secondary color.

**Animation**

Apply animations to create the tally behavior. You can select None (solid color indicator) or Flashing.

To set a tally indicator state:
1. Select a tally indicator in the layout.
2. Select the Tally tab on the Properties pane.
3. In the States area, click Edit Tally Colors.
The **Layout Editor - Tally States** dialog box appears.

![Layout Editor - Tally States](image)

4. For each state that you want to create for the selected tally indicator, do the following:
   a. From the **Primary Color** list, select a color for the tally indicator’s initial state.
      
      When using TSL v5 protocol, the primary colors for the alarm level should be set up as follows:
      
      - **Alarm Low**—Green
      - **Alarm Medium**—Amber
      - **Alarm High**—Red
   
   b. From the **Secondary Color** list, select a color or the tally indicator’s secondary state.
   
   c. From the **Animation** list, select a behavior for the tally.

### Setting the Tally State Source

In the Tally State Source area, there are three options:

<table>
<thead>
<tr>
<th>Tally State Source Option</th>
<th>Configuration Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>UMD/Tally System (Fixed UMD Addr)</td>
<td>Select the <strong>UMD address</strong> that will be the input source for the tally.</td>
</tr>
<tr>
<td>UMD/Tally System (Source UMD) (Under Monitor Display)</td>
<td>Select the <strong>PiP Number</strong> that will be the input source for the tally.</td>
</tr>
<tr>
<td></td>
<td>See the <strong>Source UMD</strong> tab in the Advanced Configuration dialog box for mapping.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <strong>Binding UMD Addresses to Input Sources</strong> (on page 113).</td>
</tr>
<tr>
<td>Alarm Rule</td>
<td>Select this option if you want the tally indicator to be the target for an alarm,</td>
</tr>
<tr>
<td></td>
<td>and then follow these steps to define the alarm source:</td>
</tr>
<tr>
<td></td>
<td>1. With the tally selected in the layout, select the <strong>Alarms</strong> tab in the <strong>Properties</strong> pane.</td>
</tr>
<tr>
<td></td>
<td>2. Following the instructions in <strong>Defining Alarms for a Layout Object</strong> (on page 223),</td>
</tr>
<tr>
<td></td>
<td>configure the <strong>Detectors</strong> and <strong>Actions</strong> pages of the <strong>Rules</strong> dialog box.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Actions</strong> page, choose <strong>Set Tally Alarm State</strong>, and complete the <strong>Action Parameters</strong> section for that action.</td>
</tr>
</tbody>
</table>

When you use either of the **UMD/Tally System** options, you must set the following items:

- **Tally Number**—the number of the tally within the UMD address that is monitored
- **Program Number**—Enter the correct number in this field if you are using Ross Protocol. If you are using another protocol, the data in this field will be ignored.
About Labels

Labels can be used to display text on your layout. Labels can be added to a layout using the Tool palette or by using the Insert > Label command from the application menu.

Your layout must be in an unlocked state to add, move, or delete objects. You can adjust properties of objects on a locked layout. See Locking and Unlocking Layouts (on page 159).

Labels can be static, dynamic, or alarms/rules based, depending on the label’s text source.

Scrolling properties can be added to both types of labels. On the Label tab of the Properties pane, you can activate and define the scrolling speed of the label text. Label text is set to scroll from right to left and within the defined label area, which is set using the label width and height properties. You can have multiple labels on a layout, each with unique properties.

Labels are modified on the Labels properties pane.

Each label has a unique identifier for the layout, its Label ID. The label ID cannot be modified. All other controls on the Labels properties pane can be edited.

When you modify label properties, the changes only apply to the selected label(s). If you want to make the same property changes to multiple labels, you can use the Copy and Paste commands from the Layout Designer context menu. For more information, see Copying and Pasting Layout Object Properties (on page 174).

Setting the Label Text Source

The Label Text Source Options on the Properties Pane appear as follows:

If your label is a dynamic label, do not type text in the label area.
## Label Text Source Options

<table>
<thead>
<tr>
<th>Label Text Source</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static Text</td>
<td>When a label’s source is static, default text appears in the label area. To edit static label text:</td>
</tr>
<tr>
<td></td>
<td>1. In the layout canvas, double-click the label you want to modify.</td>
</tr>
<tr>
<td></td>
<td>2. Hold down your left mouse button, and then select the default (or previously entered) label text.</td>
</tr>
<tr>
<td></td>
<td>3. Type your new label text into the label area.</td>
</tr>
<tr>
<td>Alarm Rule</td>
<td>If your label is connected to an alarm or rule, it will be triggered at a specific event.</td>
</tr>
<tr>
<td>Program Name</td>
<td>The label derives its name from the metadata associated with that source.</td>
</tr>
<tr>
<td>Salvo Name</td>
<td>Displays the name of a salvo that is associated with the cycling salvo rule and displays the current action associated with the PiP.</td>
</tr>
</tbody>
</table>
| Database Source Name    | • With router sources, the label updates the source from the router database that is associated with the specified **PiP number** or **Audio Source Number** (as chosen from the drop-down menu). If a switch on the router causes a change in the PiP input source, the label associated with the PiP source will follow. You can track one of the following router source names **Logical**, **Source**, **Long Name**, or **Alias**.  
|                         | • With IP sources, select **Static** to display the URL Or **Alias** to display the Alias of a IP source. The **Logical** and **Long Name** options will not display a label. |
| Router Database Dest Name | The label will update the router destination that is associated with the specified **PiP number**. (This is normally used with Router Follow. See Configuring Router Follow for more information.)  
|                         | If a switch on the router causes a change in the PiP output destination, the label associated with the PiP source will follow.             |
| UMD/Tally System (Fixed UMD) (UMD addr) | Select a **UMD address** for the label.                                                                                     |
| UMD/Tally System (Source UMD***)(PiP Num) | Select the **PiP number** of the input source for the label.  
| Browser Update (Label ID) | Allows label text to be updated from the Multiviewer Web interface (see your hardware documentation)                                |
| RSS Update Interval (Min.) | Uses an RSS feed as the source for the label text. Enter the URL to receive data from, and the frequency with which you would like the label to check for updates. |
Label Text Source | Configuration
---|---
Scoreboard | Choose Basketball or Football, and then option from the drop-down menu. Options are described in Using the Scoreboard Option (on page 246). You can also use the Active Color option in the Labels property pane to select a color to indicate the possession of the ball.

Modifying Label Appearance Properties

Label appearance properties can be applied to static and dynamic labels. You can select multiple labels, and then apply the same appearance properties changes to the selected labels.

To modify label text properties:

1. In the layout canvas, select label(s) you want to modify.
   To select multiple labels, hold down the CTRL key as you select each label.
2. On the Properties pane, click the Labels tab.
3. Under Appearance, select a font for your label text from the Font drop-down list.
4. (Optional) Click Fit to Text to set the label size to the total width of the text contained in the label area.
5. Beside the T icon, select a font size from the drop-down list.
6. To select the label text color, click the Color icon to open the Select a Color dialog box, and then do one of the following:
   - Use the slider to select a color.
   - Enter the color values you want to use in one of the ScRGB, sRGB, or Hexadecimal Notation fields.
   Your selected color is previewed below Selected Color. If required, use the Opacity slider to adjust the color's opacity value.
   For more information on completing the Color Selector dialog box, see Setting Default Window Properties (on page 142).
7. To select the label background color, click the the BG Color icon and then use the same tools as above.
8. If you do not want your label to follow the alarm color of any associated alarms, place a check beside Ignore Alarm Color.
9. Beside Justify, select the justification style for your label text from the drop-down list.
10. To get information from a tally:
   ▪ For label text, place a check beside **Tally Text**.
   ▪ For background color on the label from a tally, place a check beside **Tally Background**.
   These options can both be selected.

**Modifying Label Size and Position Properties**

You can select multiple labels, and apply the same size and position properties to the selected labels. You can also use your mouse to move and re-size labels in the layout canvas. For more information, see [Resizing and Moving Layout Objects Using a Mouse](#) (on page 175).

To modify the label size and position properties

1. Under **Size & Position**, select or type values for label width and height in the **Width** and **Height** fields.

<table>
<thead>
<tr>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>217</td>
<td>57</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Left</th>
<th>Top</th>
</tr>
</thead>
<tbody>
<tr>
<td>256</td>
<td>376</td>
</tr>
</tbody>
</table>

   The displayed **Total Width** and **Total Height** values include the label width and height as well as the label’s border width.

2. To set the label position, select or type values in the **Left** and **Top** fields.

   The **Left** value is the number of pixels from the left edge of the canvas, and **Top** is the value is the number of pixels from the top edge of the canvas.

   You can also drag and move the label on the canvas. The position indicators will update as you do this.

**Activating and Modifying Scrolling Properties**

You can activate scrolling properties on static and dynamic labels. You can set the speed the label text scrolls from left to right in the area defined by the label **Width** property. You can select multiple labels, and then apply the same scrolling properties to the selected labels.

To enable and set label scrolling properties:

1. Under **Scrolling Content**, to enabling scrolling of label text, select **Allow Scrolling**.

<table>
<thead>
<tr>
<th>Allow Scrolling</th>
<th>Speed (1-10)</th>
<th>Pause (0-10 sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>0.0</td>
</tr>
</tbody>
</table>

2. Beside **Speed** select or type a speed value (in seconds) for scrolling speed.

   A value of **1** provides the slowest and **10** the fastest scrolling speed.
3. If you want the label text to pause during scrolling, select the **Pause** check box, and then select or type the duration of the pause (in seconds).

The pause will occur before the scroll repeats itself.

---

### About Layout Clocks

You can add clocks to a layout as layout objects, and then define how the time and date information is displayed. Clocks are driven by internal software time source or by an external time reference source from an NTP input. There are several styles and formats of digital and analog clocks. There is no restriction on the number of clocks that you can add to a layout, but clocks have minimum size properties (135×135 pixels for analog and 160×40 for digital).

Your layout must be in an **unlocked** state to add, move, or delete objects. You can adjust properties of objects on a locked layout. See [Locking and Unlocking Layouts](on page 159).

Clock properties, such as time zone settings, size, and position, are modified on the Clock tab of the Properties pane. You can also use your mouse to resize and move clocks in the layout canvas. For more information, see [Formatting Layout Objects in the Canvas](on page 174).

### Adding Clocks to a Layout

To add a clock to your layout:

1. Do one of the following:
   - To add an analog clock, from the Tool palette, click the icon.
   - To add a digital clock, from the Tool palette, click the icon.

Use the **Analog Clock** and **Digital Clock** tabs of the **Properties** pane to change the clock style, resize and move the clock, and set clock time properties. For more information see [Modifying Clock Properties](on page 212).

### Modifying Clock Properties

Each clock in a layout has a set of individual properties that determine the appearance, size and position, and time properties such as its time reference source and time zone settings. You can display clocks that show time from different time zones in the same layout. Some clock properties, such as **Time and Offset** and **Size & Position** properties, are set the same way for both analog and digital clocks.

To view a clock’s properties, select the clock you want to modify, and then click the **Analog Clock** or **Digital Clock** tab of the **Properties** pane.

### Setting Analog Clock Format

After you have added an analog clock to a layout, you can change the clock’s appearance and motion type by selecting a new clock style from the Format section of the **Analog Clock** properties tab.
This table displays the different clock style types that you can choose from the `Format` list.

### Analog Clock Formats

<table>
<thead>
<tr>
<th>Clock Format</th>
<th>Style</th>
<th>Clock Format</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format 1 (default format)</td>
<td><img src="image1.png" alt="Format 1 Style" /></td>
<td>Format 6</td>
<td><img src="image2.png" alt="Format 6 Style" /></td>
</tr>
<tr>
<td>Format 2</td>
<td><img src="image3.png" alt="Format 2 Style" /></td>
<td>Format 7</td>
<td><img src="image4.png" alt="Format 7 Style" /></td>
</tr>
<tr>
<td>Format 3</td>
<td><img src="image5.png" alt="Format 3 Style" /></td>
<td>Format 8</td>
<td><img src="image6.png" alt="Format 8 Style" /></td>
</tr>
<tr>
<td>Format 4</td>
<td><img src="image7.png" alt="Format 4 Style" /></td>
<td>Format 9</td>
<td><img src="image8.png" alt="Format 9 Style" /></td>
</tr>
<tr>
<td>Format 5</td>
<td><img src="image9.png" alt="Format 5 Style" /></td>
<td>Format 10</td>
<td><img src="image10.png" alt="Format 10 Style" /></td>
</tr>
</tbody>
</table>

To set the selected clock's format:

1. Under `Format`, select a clock style.
2. Under **Type**, select **Analog** or **Hybrid**. Hybrid adds a digital clock on the analog clock’s face. The Hybrid option is not available on clock format 1.

3. To change the clock’s motion setting, from the **Motion** list, select one of the following:
   - **Sweep**—Select this option for a sweep clock hand motion.
   - **Quartz**—Select this option for a clock hand motion that pulses in one-second intervals.
   - **Rolex**—Select this option for a smooth clock hand motion.
   - **Swiss**—Select this option for a sweep-stop (in one second intervals) clock hand motion.

**Setting Digital Clock Format and Appearance Properties**

Under **Format**, select a clock layout from the list.

**Digital Clock Options**

1. To customize your selected clock format, make the following selections:
   - **12 or 24** - Sets the clock display to 12 hour format
   - **AM/PM** - Indicates PM or AM in the clock display (does not apply to 24-hour clocks)
   - **Show Seconds** - Displays the second count in the clock display
   - **Show Date** - Displays the date in the clock display (select a date format from the drop-down list)
   - **Show Week** - Displays the days of the week in the clock display
   - **Show Frame** - Displays the frame count (only applies to the last format in the list)

2. Under **Time Font**, select a font that will be used for the time (mostly number) text.
3. Under **Date Font**, select a font that will be used for the date (mostly alphabet, usually smaller) text.
4. Choose the colors for each of the following areas on the digital clock:
   - **Time Color** - The numeric time text in the clock display
   - **Date Color** - The rest of the text on the screen, excluding the day of the week if you have chosen the Show Week display
   - **Active Date** - The current day if you have chosen the Show Week display
   - **Background** - The area inside the border of the digital clock display
Setting Clock Time Reference Source and Time Zone

The controls and method used to set the time reference source is the same for analog and digital clocks. Each clock in a layout can be configured with a different time reference source.

The multiviewer’s internal time or NTP is used as a reference source for the selected clock. To configure Network Time Protocol, see Configuring Network Time Protocol (NTP) (on page 114). If NTP is not configured, EPIC™ MV uses its own internal clock.

Select an appropriate time zone from the Time Zone Offset drop-down list.

Resizing and Moving Clocks

The controls for resizing and moving analog and digital clocks are the same.

To resize and move the selected clock:

1. Under Size & Position, type or select values for the width and height in the Width and Height fields.
2. To move the selected clock, type or select left and top position values (in pixels) in the Left and Top fields.

The Left value is the number of pixels from the left edge of the layout. The Top value is the number of pixels from the top edge of the layout.

You can also use your mouse to resize and move clocks in the layout canvas. For more information, see Formatting Layout Objects in the Canvas (on page 174).

About Up/Down Counters

The up/down counter displays time on your Layout, with accuracy down to a second. You can use a counter as an alarm detector to trigger other events when it completes its count down or count up, or when the counter hits a blink or alert point (see Defining Alarms for a Layout Object for more information). When the end time is reached on that particular counter, an event is triggered. The counter can be the recipient of an alarm action, which can reset, start, or stop the counter.

During normal operation the timer behaves as follows:

1. The counter starts, counting up or down with green font.
2. When it reaches a pre-defined alert time, the counter’s font turns red.
3. When it reaches a pre-defined blink time, the font remains red but then the red down arrow (or up arrow for a count down timer) turns off and on at .5s intervals for the remainder of the count time.

4. When the counter reaches a pre-defined end time (time has expired), the timer remains at the last time value (00:00:00 for a down timer) with a red font until it is reset or a new timer session is started.

Adding Counters to a Layout

To add a counter to your layout:

Do one of the following:

- From the Tool palette, click the ➕ icon.
- From the main menu, select Insert > Up/Down Counter.

Use the Up/Down Counter tab of the Properties pane to change the properties. For more information see Modifying Counter Properties (on page 216).

Modifying Counter Properties

Each counter in a layout has a set of individual properties that determine the appearance, size, position, and time properties. Each counter has a unique counter number. You can configure four different times per counter.

Naming the Counter

A counter’s unique name identifies it in the layout. This is the name the counter is identified by when creating alarm detectors and actions.

To name a counter:

1. Select a counter in the layout.
2. Select the Counter tab on the Properties pane.
3. In the Properties area, type a name for the counter in the Name field.
Modifying Counter Size and Position Properties

You can select multiple counters, and apply the same size and position properties to the selected counters. You can also use your mouse to move and re-size counters in the layout canvas. For more information, see Resizing and Moving Layout Objects Using a Mouse (on page 175).

To modify the counter size and position properties:

1. Under **Size, Position & Opacity**, select or type values for counter width and height in the **Width** and **Height** fields.

![Size, Position & Opacity](image)

The displayed **Width** and **Height** values include the counter width and height as well as the counter’s border width.

2. To set the counter position, select or type values in the **Left** and **Top** fields.

The **Left** value is the number of pixels from the left edge of the canvas, and **Top** is the value is the number of pixels from the top edge of the canvas.

You can also drag and move the counter on the canvas. The position indicators will update as you do this.

3. Drag the **Opacity** slider to the right to make the counter more transparent, or left to make the counter more solid.

Choosing a Counter Style

Click an option in the Styles section of the Up/Down Counter Properties pane to choose a counter appearance.

Configuring Counter Functionality

The counter’s source can be **Internal** (where it calibrates the counter rate from the multiviewer’s internal time) or NTP.

1. Select a counter direction.
   - **Up (incremental)** - the counter increases in value as it counts.
   - **Down (decremental)** - The counter decreases in value as it counts.
   
   The counter indicates its direction in the layout with an up arrow or a down arrow.

2. Configure times as follows:
   a. Beside **Start Time**, enter the initial value that is displayed by the counter.
   b. Beside **Stop Time**, enter a final value to be displayed by the counter.

   When used as a detector to trigger a rule, the stop time will trigger the rule to fire. After firing the time is displayed as red.
c. Beside **Alert Time**, enter the time when the text on the counter will change from green to red (prior to the countdown completing).
d. Beside **Blink Time**, enter the time when the direction indicator will begin to blink.

The maximum number of hours is 99, and the maximum number of minutes and seconds are 59.

**Manually Controlling a Counter**

When a layout is uploaded to a multiviewer, you can operate the counter from Layout Designer.

To control the counter from Layout Designer:

1. If Layout Designer does not have control of the multiviewer, click **Enable Control**.
2. Select a counter in the layout.
3. Select the **Counter** tab on the **Properties** pane.
4. Use the following controls:
   - **Start** - updates the counter to proceed with the linear countdown
   - **Stop** - stops and reports the current countdown time until further notice
   - **Reset** - re-initializes the counter using the original start, stop, blink, and alert times. Any rules that were active in the layout will still trigger the counter the same way as before.

In the Rules engine, the counter can act as an alarm by configuring a rule to fire on a Stop Counter event, when the counter reaches its end time. See **Defining Alarms for a Layout Object** (on page 223). The counter can act as a target through the Reset Counter, Start Counter, and Stop Counter actions. See **Setting Alarm Actions** (on page 229).

**Controlling a Counter Using SNMP or Magellan Control Panel**

The time parameter is global and updates every published timer. Neither CCS nor SNMP is aware of any of the published timers. The only link is through virtual triggers set up with alarms in the layout.

To start a timer:

1. Set the **Initial Counter Time** parameter.
   - The time does not update the counter until a start is triggered. When you set the duration, there is no visual feedback on the display. It retains the original setting of the published layout.
2. Set the trigger that starts the specific counter.

When you start the countdown timer, the display updates to the value set using SNMP or Magellan and starts to decrement or increment.

If the time is not set to zero, any time a start occurs, the counter uses the time as set by Magellan Control Panel or SNMP.
Alarms and Info Panels

This section describes various methods of receiving information about conditions within your monitored video.

Monitoring Tools

Use Layout Designer's on-screen monitoring tools to monitor your system input signals and set up automatic responses to alarm conditions and operational events. The following figure illustrates Layout Designer’s on-screen monitoring tools in a layout.

1. Tally indicators can display alarm conditions if configured to do so. See Creating Tally Indicators (on page 204).
2. Borders (on PiPs and windows) can display three different alarm states and a tally state, in addition to their normal state. See Modifying Border Properties (on page 183).
3 Dynamic labels can be configured to display specific text based on various alarm conditions. For more information, see About Layout Clocks (on page 212).

4 Info Panels can include alarms. For more information, see Info Panels (on page 240).

5 Up/Down Counters can trigger and be the target of alarms. For more information, see About Up/Down Counters (on page 215).

Other alarm monitoring options include:

- E-mails
- Log entries
- Text messages
- Changes to the PiP, such as making it full-screen

Alarms can be assigned to an item within a layout, to a layout, or globally, to the multiviewer device itself.

## Alarms and the Events that Trigger Them

Alarms are triggered by events, and they trigger actions in return.

### Using the Rules Menu

As part of the Layout Designer application toolbar, the Rules menu provides the following options:

- **Global Alarms** - Opens the Global Alarms Editor so you can review and configure alarms that are device-specific and will stay active when triggered even when the layout changes. See Configuring Global Alarms (on page 235).

- **Global Events** - Opens the Events Editor so you can review and configure events that trigger actions and are device-specific, and will stay active when triggered even when the layout changes. See Configuring Layout Events and Global Events (on page 238).

- **Enable/Disable Global Event** - Lists a sub-menu of all global events, so that you can select a specific event to enable or disable.

- **Enable/Disable All Global Events** - Provides a list of two options that affect all defined global events: Enable or Disable.

- **Layout Events** - Opens the Events Editor so you can review and configure events for a specific layout.

- **Clear Layout Alarms** - Deletes all alarms for a specific layout.

- **Component [Component’s name] Alarms** - Opens the Rules Editor so you can review and configure alarms assigned to the selected item. Defining Alarms for a Layout Object (on page 223).

- **Clear Component [Component’s name] Alarms** - Deletes all alarms assigned to the selected item.

Global and Layout alarms and events are only available when Layout Designer is connected to a Multiviewer.
Using the Alarms Property Pane

If you can assign alarm detectors to an object in a layout, when you select that object and then go to the alarms tab of the Properties panel, you can view the alarms assigned to that object. Each alarm consists of two parts:

- Detectors - Conditions that trigger the alarm
- Actions - Notifications that an alarm condition exists

Alarms are defined on the Alarms tab of the Properties pane.

1. **Alarms** lists each sub-item that make up the selected object (including PiPs, counters, info panels, etc.). Sub-entries list the alarms applied to each specific object. See [Defining Alarms for a Layout Object](on page 223).

2. Data field updates when you select an item in the **Alarms** field, so you can edit thresholds and conditions for the selected alarm or alarm detector. See [Setting Alarm Detector Threshold Values](on page 226).

3. **Actions List** displays the actions that will occur when the selected alarm is triggered.
   - Roll the mouse over an action to view tooltips showing details of action parameters.
   For more information, see [Setting Alarm Actions](on page 229).

4. **Available Alarm Templates** allows you to manage your alarm templates and apply them to the selected layout object. See [About Alarm Templates](on page 231).

There are default alarms that you can activate and modify. Each alarm condition has detectors. When the input signals meet or exceed threshold values of the detector, the alarm actions are triggered.

Each alarm is described below.

### Alarm Detectors

<table>
<thead>
<tr>
<th>Detector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video</strong></td>
<td></td>
</tr>
<tr>
<td>Format Change</td>
<td>Indicates that the video input format has deviated from its defined standard</td>
</tr>
<tr>
<td>SD EDH Error</td>
<td>Reports recurring EDH errors in the standard definition video signal</td>
</tr>
<tr>
<td>HD CRC Error</td>
<td>Indicates that the internally calculated CRC value is different from the received CRC value</td>
</tr>
<tr>
<td>Detector</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Loss of Video</td>
<td>Indicates that the multiviewer hardware can no longer detect a video signal from the video channel</td>
</tr>
<tr>
<td>Video Freeze</td>
<td>Indicates that the input video image is frozen (static) according to user-defined frozen picture delay (duration), percent of frozen video in the frame, and amount difference between pixels percent tolerance</td>
</tr>
<tr>
<td>Video Black</td>
<td>Indicates that the input video image is considered a black picture according to user-defined percentage non-black picture, delay (duration), and black level threshold values</td>
</tr>
</tbody>
</table>

**Audio**

<table>
<thead>
<tr>
<th>Audio Channel Missing</th>
<th>Indicates that the audio channel is not present in the signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Channel Peak</td>
<td>Indicates that the input audio level of the audio channel is at or above the set upper threshold dB values for the user-defined period of time</td>
</tr>
<tr>
<td>Audio Channel Low</td>
<td>Indicates that the input audio level of the audio channel is at or below the set lower threshold dB values for the user-defined period of time</td>
</tr>
<tr>
<td>Audio Channel Silence</td>
<td>Indicates that the input audio level of the audio channel is at or below the set silence threshold dB value for the user-defined period of time</td>
</tr>
<tr>
<td>Audio Group (1–4) Missing</td>
<td>Indicates that the specified audio group is not present in the signal</td>
</tr>
<tr>
<td>Audio Format Change</td>
<td>Indicates that the audio format has switched from Dolby D, Dolby E, or PCM, or indicates any format change</td>
</tr>
<tr>
<td>Dolby E Program Change</td>
<td>Indicates that the Dolby program format has deviated from the one specified</td>
</tr>
</tbody>
</table>

**Video Metadata**

<table>
<thead>
<tr>
<th>CC Missing</th>
<th>Indicates that closed captioning (can be HD or SD) is not present in the incoming video stream</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC Not Updating</td>
<td>Indicates that closed captioning is not updating correctly in the incoming video stream</td>
</tr>
<tr>
<td>CC Not Valid</td>
<td>Indicates that the closed captioning data in the incoming video stream is not usable</td>
</tr>
<tr>
<td>VChip Data Missing</td>
<td>Indicates that there is no V-chip data in the incoming video stream</td>
</tr>
<tr>
<td>VChip Mismatch</td>
<td>Indicates that the V-chip data in the incoming video stream does not match the expected rating</td>
</tr>
<tr>
<td>Teletext Missing</td>
<td>Indicates that there is no teletext in the incoming video stream</td>
</tr>
<tr>
<td>Teletext Not Updating</td>
<td>Indicates that the teletext data in the incoming video stream is frozen</td>
</tr>
<tr>
<td>Teletext Not Valid</td>
<td>Indicates that the teletext data in the incoming video stream is not usable</td>
</tr>
<tr>
<td>VITC Missing</td>
<td>Indicates that there is no VITC in the incoming video stream</td>
</tr>
<tr>
<td>WSS Missing</td>
<td>Indicates that WSS is not present in the incoming video (should be present in SD625 only)</td>
</tr>
</tbody>
</table>
### Detector | Description
--- | ---
WSS Format Change | Indicates that the WSS information has changed from the selected format
AFD Missing | Indicates that AFD data is not present in the incoming video
AFD Format Change | Indicates that the AFD information has changed from the selected format

### BBC SCTE 104

<table>
<thead>
<tr>
<th>Detector</th>
<th>Description</th>
</tr>
</thead>
</table>
| BBC SCTE 104 Alarm | Indicates that the expected BBC-style SCTE 104 is missing
\*Note: This alarm will not detect or alert about other forms of SCTE 104 data.|

### Timelines

<table>
<thead>
<tr>
<th>Detector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counter Alert</td>
<td>Indicates that the specified counter has achieved its predefined alert time</td>
</tr>
<tr>
<td>Counter Blink</td>
<td>Indicates that the specified counter has achieved its predefined blink time</td>
</tr>
<tr>
<td>Counter End</td>
<td>Indicates that the specified counter has achieved its end time (this is when the counter stops)</td>
</tr>
</tbody>
</table>

### Miscellaneous

<table>
<thead>
<tr>
<th>Detector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI</td>
<td>Indicates that a GPI input has been triggered</td>
</tr>
<tr>
<td>Specific Source</td>
<td>Indicates that a PiP has been switched to a specific source (requires SDNO and a Magellan control panel)</td>
</tr>
<tr>
<td>SNMP Virtual GPI</td>
<td>Indicates that a GPI trigger has been received through SNMP</td>
</tr>
</tbody>
</table>

### Global

<table>
<thead>
<tr>
<th>Detector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Alarm Triggered</td>
<td>Indicates that any alarm connected to any other alarm has been triggered</td>
</tr>
<tr>
<td>Any Audio Alarm Triggered</td>
<td>Indicates that any of the alarms in the Audio section of the list (above) have been triggered</td>
</tr>
<tr>
<td>Any Video Alarm Triggered</td>
<td>Indicates that any of the alarms in the Video section of the list (above) have been triggered</td>
</tr>
</tbody>
</table>

For information about setting alarm threshold values, see [Setting Alarm Detector Threshold Values](#) (on page 226).

For information about setting video alarms, see [Defining Alarms for a Layout Object](#) (on page 223).

Any changes you make to an alarm setup will not appear on the multiviewer until the layout is published.

### Defining Alarms for a Layout Object

1. Select the appropriate layout object.
   
   Objects that can take alarms include:
   
   - Info panels
   - PiPs
   - Tallies
1. **Windows**
2. **Up/Down Counters**

2. In the toolbar, click **Rules**, and then click **[Component] Alarms** (where [Component] is the selected object).

The **Rules Editor** dialog box opens with the **Select Detectors** panel displayed.

1. Configure threshold settings for selected detector
2. Delete selected alarm from the list
3. Click to configure Alarm actions

3. In the **Alarm Name** field, enter a meaningful name that describes the alarm condition.

4. Select an operator, either **And** or **Or**, and then click **Add**.
   - When **And** is selected, all conditions must be met to trigger an alarm.
   - When **Or** is selected, only one of the conditions must be met to trigger the alarm.

   The alarm appears in the alarms table.

5. In the **Detectors** list, place a check beside each alarm detector you want to have on this layout object.

The drop-down menu at the top of the Detectors list has three viewing options. **All expanded view** shows all available alarms. **All collapsed view** shows only the folders that the alarms are nested in. **Selected view** shows only the alarms that have been selected. You cannot view unselected alarms in this view, so you can remove alarms but not add them to the rule.
Each detector is added with default thresholds and settings. Click on the text of a detector to view its threshold values.

6. To adjust the threshold values for a detector, do one of the following:
   - Click in the value column and then type the new value for the threshold.
   - Drag the slider right and left to increase and decrease the threshold value.
   - Click the incremental step buttons to increase or decrease the threshold value.
   See Setting Alarm Detector Threshold Values (on page 226) for more information.

7. Click **Select Actions**.
   The **Rules Editor** dialog box displays its **Select Actions** panel.

8. Click on an alarm in the **Alarms** column.

9. From the **Actions** list, choose one or more actions from the left panel and click > to move it to the right panel.
   If a target is not available for the alarm action (for example, if you have chosen **Counter Reset** as your action and there is not a counter in the layout), you will see an error message.
   To remove an item from the **Select Actions** list, click <.
   You can move the selected item up in the list by clicking **Up**, or down in the list by clicking **Down**.
   Alarm actions will be executed in the order they appear on the list.
When an item is highlighted in the **Selected Actions** list, you can configure it by completing the **Action Parameters** specific to that action.

10. Click **OK** to close the **Rules Editor** dialog box.

The **Alarms** field of the **Alarms** properties tab lists the alarms you have created. You can view the individual detectors that make up an alarm by clicking +, or hide them by clicking -.

Click on an alarm in the **Alarms** field to view and/or edit that alarm’s name and operator in the space directly to the right of the **Alarms** list, and to view a list of actions for that alarm in the **Actions** field.

Click a detector in the **Alarms** field to adjust the thresholds and settings for that detector.

### Setting Alarm Detector Threshold Values

Alarm threshold values determine the point at which an input is in error and an alarm is triggered. On the **Alarms** tab of the **Properties** pane, you can set the threshold values for each detector used by the multiviewer to determine when an alarm condition exists.

The following describes each options and threshold value. The threshold value varies for each detector.

<table>
<thead>
<tr>
<th>Threshold value</th>
<th>Definition</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Source number or PiP ID of the monitored source signal</td>
<td>Range is 0–512 if Source number was selected; text otherwise</td>
</tr>
</tbody>
</table>
| HD Source       | The HD CC source                                | • Service (1-7)  
• CC (1-4)  
• T (1-4)                                                        |
| SD Source       | The SD CC source                                | • CC (1-4)  
• T (1-4)                                                        |
| Service Option  | The SD CC, V-Chip, VITC, WSS, AFD, or Teletext line | • Line (6-23)  
• Auto  
If you choose the line you expect the service to be on and the service is not on that line, it will not display. If you choose Auto, the metadata will display regardless of the line it is on. |
| Audio Service   | Audio services that are monitored in compressed inputs | This field allows you to select more than one option.  
• Audio Service 1  
• Audio Service 2  
• Audio Service 3 |
| Channel         | Audio stream that is monitored for this alarm   | Channel 1–Channel 16 (by default 1 - 4 are enabled)                   |
| Delay (sec)     | Duration (in seconds) that the threshold(s) on an alarm can be met or exceeded in order to trigger the alarm condition | 0–60 for video, audio, and GPI detectors; 0-600 for metadata detectors  
10 is the default |
### Threshold value

<table>
<thead>
<tr>
<th>Definition</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>% Frame Frozen</strong></td>
<td>0–100 (default: 97)</td>
</tr>
<tr>
<td><strong>% Frame Black</strong></td>
<td>0–100</td>
</tr>
<tr>
<td><strong>Tolerance (%)</strong></td>
<td>0–25</td>
</tr>
<tr>
<td><strong>Tolerance mV</strong></td>
<td>0–700</td>
</tr>
<tr>
<td><strong>Level (dBFS)</strong></td>
<td>-100–0</td>
</tr>
<tr>
<td><strong>Expected Format</strong></td>
<td>The expected format of the input signal</td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td>1080i60 (default)</td>
</tr>
<tr>
<td>• 1080p60</td>
<td>SD525</td>
</tr>
<tr>
<td>• 1080i50</td>
<td>SD625</td>
</tr>
<tr>
<td>• 1080p50</td>
<td>1080p24</td>
</tr>
<tr>
<td>• 1080psf24</td>
<td>1080p25</td>
</tr>
<tr>
<td>• 720p60</td>
<td>1080p30</td>
</tr>
<tr>
<td>• 720p50</td>
<td>Any format change</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>Dolby E</td>
</tr>
<tr>
<td>• Dolby D</td>
<td>PCM (default)</td>
</tr>
<tr>
<td>• Any format change</td>
<td></td>
</tr>
<tr>
<td><strong>WSS</strong></td>
<td>Full Frame 4:3 (default)</td>
</tr>
<tr>
<td>• 14:9 Center</td>
<td>&gt; 16:9</td>
</tr>
<tr>
<td>• 14:9 Top</td>
<td>Full Alt 14:9</td>
</tr>
<tr>
<td>• 16:9 Center</td>
<td>16:9 Anamorphic</td>
</tr>
<tr>
<td>• 16:9 Top</td>
<td>Any Format Change</td>
</tr>
<tr>
<td><strong>AFD</strong></td>
<td>&gt; 16:9</td>
</tr>
<tr>
<td>• Full Frame (default)</td>
<td>4:3 Alt 14:9</td>
</tr>
<tr>
<td>• 4:3 Center</td>
<td>16:9 Alt 14:9</td>
</tr>
<tr>
<td>• 16:9 Protected</td>
<td>16:9 Alt 4:3</td>
</tr>
<tr>
<td>• 14:9 Center</td>
<td>Any Format Change</td>
</tr>
<tr>
<td>Threshold value</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
</tr>
</tbody>
</table>
| DolbyE Pairs    | The Dolby E audio pair that is displayed on the multiviewer | • Disable (default)  
• 1/2  
• 3/4  
• 5/6  
• 7/8  
• 9/10  
• 11/12  
• 13/14  
• 15/16 |
| Audio Pairs     | Selects the audio pair to be monitored | • 1/2 (default)  
• 3/4  
• 5/6  
• 7/8  
• 9/10  
• 11/12  
• 13/14  
• 15/16 |
| Expected Program| Determines the Dolby E program | • 5.1+2 (default)  
• 5.1+2x  
• 4+4  
• 4+2x2  
• 4+2+2x1  
• 4+4x1  
• 4x2  
• 3x2+2x1  
• 2x2+4x1  
• 2+6x1  
• 8x1  
• 5.1  
• 4+2  
• 4+2x1  
• 3x2  
• 2x2+2x1  
• 2+4x1  
• 6x1  
• 4  
• 2+2  
• 2+2x1  
• 4x1  
• 7.1  
• 7.1 screen |
| Rating          | Determines the VChip option that is expected | • G  
• PG  
• PG-13  
• R  
• NC-17  
• X  
• TV-Y  
• TV-Y7  
• TV-G  
• TV-PG  
• TV-14  
• TV-MA  
• E  
• C  
• C8+  
• 14+  
• 18+  
• 8 ans+  
• 13 ans+  
• 16 ans+  
• 18 ans+ |
| Page            | Determines the Teletext page that is expected to be displayed  
Note: the default is for OP-47 closed captioning. | • 0 to 999  
801 is the default |
### Threshold value

<table>
<thead>
<tr>
<th>Counter Name</th>
<th>Definition</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lists all the available counters in the layout</td>
<td>Auto (default) &lt;all counters in layout&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Router Source</th>
<th>Source the router switch should be on (Requires SDNO and a Magellan Control Panel).</th>
<th>1–512</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>1 is the default</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Router Destination</th>
<th>Destination the router switch should be on (Requires SDNO and a Magellan Control Panel).</th>
<th>1–512</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination</td>
<td>1 is the default</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Level</th>
<th>Router level the switch should be on (Requires SDNO and a Magellan Control Panel).</th>
<th>0–100</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0 is the default</td>
<td></td>
</tr>
</tbody>
</table>

### Setting Alarm Actions

Alarm actions are used in the **Rules Editor** and the **Trigger Configuration** dialog box.

<table>
<thead>
<tr>
<th>Alarm Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Layout</td>
<td>Loads a layout.</td>
</tr>
<tr>
<td>Change PiP Source</td>
<td>Changes the input source of the PiP to the selected source. There must be a PiP in the current layout to choose this option. The source can be either a router source or an IP source, regardless of the PiP’s original source prior to the alarm (Requires SDNO and a Magellan Control Panel).</td>
</tr>
<tr>
<td>Change Salvo</td>
<td>Changes a salvo that was created in a salvo editor.</td>
</tr>
<tr>
<td>Counter Reset</td>
<td>Sets the selected counter back to its start time.</td>
</tr>
<tr>
<td>Counter Start</td>
<td>Triggers the counter to start.</td>
</tr>
<tr>
<td>Counter Stop</td>
<td>Stops the counter.</td>
</tr>
<tr>
<td>Fire Global Event</td>
<td>Activates a global event. There must be a global event in the multiviewer system to choose this action. See <strong>Configuring Layout Events and Global Events</strong> (on page 238) for more information.</td>
</tr>
<tr>
<td>Fire GPO</td>
<td>Activates a GPO.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This requires an HV-GPIO-24E connected to the multiviewer.</td>
</tr>
<tr>
<td>Fire Layout Event</td>
<td>Activates a layout event (see <strong>Configuring Layout Events and Global Events</strong> (on page 238) for more information). There must be a layout event in the current layout to choose this action.</td>
</tr>
<tr>
<td>Log Message</td>
<td>Adds a predefined message to the system log, which is located in the alarm section of the logging server. See <strong>Enabling Alarm Logging</strong> (on page 115) to configure alarm logging.</td>
</tr>
<tr>
<td>Make PiP Full Screen</td>
<td>Expands the selected PiP to full-screen. There must be a PiP in the current layout to choose this action.</td>
</tr>
</tbody>
</table>
## Alarm Action

<table>
<thead>
<tr>
<th>Alarm Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Router Switch</td>
<td>This action triggers an input’s switch to a specific router level and destination (Requires SDNO and a Magellan Control Panel).</td>
</tr>
<tr>
<td>Send Email</td>
<td>Sends an email with pre-written text to a specific recipient.</td>
</tr>
<tr>
<td>Send SMS Txt Msg</td>
<td>Sends a text message to a phone.</td>
</tr>
<tr>
<td>Set InfoPanel Alarm State</td>
<td>Changes the text of a label in the layout to pre-configured text. There must be an Alarm/Rule dynamic label in the current layout (a static label in the layout is not sufficient).</td>
</tr>
<tr>
<td>Set Label Text</td>
<td>Changes an background color of alarm indicators on an info panel. There must be an info panel in the current layout to choose this action.</td>
</tr>
<tr>
<td>Set PiP Alarm State</td>
<td>Changes a PiP’s alarm state. There must be a PiP in the current layout to choose this action.</td>
</tr>
<tr>
<td>Set Tally Alarm State</td>
<td>Changes a tally’s alarm state. There must be a tally in the current layout to choose this action.</td>
</tr>
<tr>
<td>Set Window Alarm State</td>
<td>Sets the window border to a pre-defined state. There must be a Window in the current layout to choose this action.</td>
</tr>
</tbody>
</table>

## Parameter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 Digit Phone Number</td>
<td>Type the phone number to be dialed to send the text message.</td>
</tr>
<tr>
<td>Counter</td>
<td>Selects the specific counter to use as a trigger or target of the action.</td>
</tr>
<tr>
<td>Dynamic Label ID</td>
<td>Choose the ID number of the label to send text.</td>
</tr>
<tr>
<td>GPO Number</td>
<td>Type the number of the GPO to activate.</td>
</tr>
<tr>
<td>InfoPanel</td>
<td>Choose the info panel that will display the alarm state</td>
</tr>
<tr>
<td>Input</td>
<td>Enter the router’s input number to switch.</td>
</tr>
<tr>
<td>Layout name</td>
<td>Type the name of the layout to load.</td>
</tr>
<tr>
<td>Level</td>
<td>Enter the router level number to switch.</td>
</tr>
<tr>
<td>Logging Priority</td>
<td>Determines the urgency of the message; choose from Info, Warning, Performance, Error, Critical, or Fatal.</td>
</tr>
<tr>
<td>Message</td>
<td>Enter the text of the message to be sent.</td>
</tr>
<tr>
<td>Message Body</td>
<td>Enter the text of the message to be sent.</td>
</tr>
<tr>
<td>Output</td>
<td>Enter the router’s output number to switch.</td>
</tr>
<tr>
<td>PiP</td>
<td>Choose the PiP that will be the recipient of the action to from the drop-down menu. All PiPs in the current layout are available by name.</td>
</tr>
<tr>
<td>PiP Source</td>
<td>Choose either Router or IP, and then choose the specific source from the drop-down menu.</td>
</tr>
<tr>
<td>Priority</td>
<td>Choose Low, Medium, or High. This affects the display color of tallies and info panels, and PiP and window alarm borders.</td>
</tr>
</tbody>
</table>
### Alarms and Info Panels

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipient Address</td>
<td>Enter an email address to send alarm notifications to.</td>
</tr>
<tr>
<td>Show PiP Information</td>
<td>Displays a PiP information menu on a full-screen PiP.</td>
</tr>
<tr>
<td>Sticky</td>
<td>Choose Yes or No. Actions that are sticky must be acknowledged before they disappear.</td>
</tr>
<tr>
<td>Subject</td>
<td>Enter a subject for the email.</td>
</tr>
<tr>
<td>Tally</td>
<td>Choose the tally to apply the alarm to.</td>
</tr>
<tr>
<td>Text</td>
<td>Enter the content the label will be updated with.</td>
</tr>
<tr>
<td>Trigger</td>
<td>Type the number of the trigger to activate.</td>
</tr>
<tr>
<td>Txt Msg Body</td>
<td>Enter the text of the message to be sent.</td>
</tr>
<tr>
<td>Window Number</td>
<td>Choose the window to apply the alarm to.</td>
</tr>
<tr>
<td>Wireless Carrier</td>
<td>Choose your carrier from the drop-down menu. If your carrier does not appear on the list, you can enter a custom carrier. Choose Add custom from the bottom of the list. A window opens where you can type in your cell phone carrier's email suffix. Click OK. Your cell phone carrier appears at the top of the list.</td>
</tr>
</tbody>
</table>

### About Alarm Templates

Alarm templates are a fast way to apply the same group of alarms and detectors multiple times within the same layout, or within multiple layouts, without having to configure it each time. Once a template has been applied to a layout object, you can adjust the threshold values on that object specifically.

#### Creating an Alarm Template

When you create an alarm template, note the following:

- Each object in a layout can have only one template applied to it.
- A template may consist of many alarms, with many detectors.
- Alarms must have unique names. If you give an alarm an existing name, it will overwrite the previous condition.
- The source that is defined in an object overrides the source that is defined in an alarm.
- You can set default threshold settings for each detector within the template, and adjust those thresholds on an item-by-item basis throughout a layout. Making changes to the threshold values for each layout object does not change the threshold values in the template itself.

To create an alarm template:

1. Select the **Alarms** tab of the **Properties** pane.
2. Under **Available Alarm Templates**, click **New**.
The **Alarm Template Editor** dialog box appears.

3. In the **Alarm Template Name** field, enter a descriptive name for your template.
4. In the **Alarm Name** field, enter a meaningful name that describes the alarm condition.
5. Select an operator, either **And** or **Or**, and then click **Add**.
   - When **And** is selected, all conditions must be met to trigger an alarm.
   - When **Or** is selected, only one of the conditions must be met to trigger the alarm.
   The alarm appears in the alarms table.
6. In the **Detectors** list, choose each alarm detector you want to have on this layout object.
   The drop-down menu at the top of the Detectors list has three viewing options. **All expanded view** shows all available alarms. **All collapsed view** shows only the folders that the alarms are nested in. **Selected view** shows only the alarms that have been selected. You cannot view unselected alarms in this view, so you can remove alarms but not add them to the rule.
   Each detector is added with its default thresholds and settings.
7. Click on the text of each detector to view its threshold values, and then, to adjust its threshold values, select in the value column and type a new value.
   See **Setting Alarm Detector Threshold Values** (on page 226) for more information.
8. Repeat steps 4–7 to add other alarms to the alarm template.
9. Click **Select Actions**.
The **Alarm Template Editor** dialog box displays its **Select Actions** panel.

10. Click on an alarm in the **Alarms** column.
11. From the **Actions** list, choose one or more actions from the left panel and click > to move it to the right panel.

To remove an item from the Select Actions list, click <.

You can move the selected item up in the list by clicking **Up**, or down in the list by clicking **Down**. Alarm actions are executed in the order they appear on the list.

When an item is highlighted in the **Selected Actions** list, you can configure it by completing the **Action Parameters** specific to that action.

12. Click **OK** to close the **Rules Editor** dialog box.
13. Click **OK** to save the new template.

The Alarm Template Editor dialog box closes. The new alarm template appears in the **Available Alarm Templates** list.

**Editing Alarm Templates**

To edit an alarm template, select it in the **Available Alarm Templates** list, and then click **Edit**.

The **Alarm Template Editor** dialog box appears.
1. Do any of the following:
   - Change the name of the template.
   - Select an existing detector in the **Template Alarms** list, and then change any attribute of that detector.
   - Add or remove detectors.
   - Select an existing action in the **Template Actions** list, and then change any attribute of that action.
   - Add or remove actions on the Actions page.
2. Click **OK** to save your changes.

**Applying an Alarm Template to a Layout Object**

Select the layout object to which you want to apply alarm template.

You can select more than one object by holding down the CTRL key on the keyboard and clicking on each object that you want to include.

1. Select the **Alarms** tab on the **Properties** pane.
2. Select the appropriate template from the **Available Alarm Templates** list.
   
   Click the + to expand each template to view the specific alarm conditions that are included in the template.
3. Do either of the following:
   - If you selected one layout object, click **Apply to Selected**.
   - If you selected more than one layout object, click **Apply to All**.

If objects already have alarms assigned to them when you apply an alarm template, the previously assigned alarm template is replaced.

You can only apply entire templates to an object; however, you can remove any conditions once the template is applied.

4. In the **Alarms** list, you can:
   - Select an alarm to view the specific detectors that are included. In the area to the right of the Alarms list, you can change the alarm name and operator between detectors.
   - Select a detector and view or change its threshold values.
   - Add conditions and detectors.
   - Remove conditions and detectors (right click and choose **Remove** or **Remove All**).
   - View alarm actions.
   - Test alarm actions.
   - Add the alarm to the **Available Alarm Templates** list (this is a right-click option).

For more information about alarms and detectors, see [Defining Alarms for a Layout Object](#) (on page 223).

**Testing an Alarm**

After a layout is published, you can test alarms by simulating a failed alarm.

1. Select the alarm that you want to test.
Make sure that you select the alarm and not the detector.

2. Click and hold down the Test Alarm button.

The alarm response appears on the published layout object as long as you hold the Test Alarm button down.

**Testing an Action**

After a layout is published, you can test alarm actions.

1. Select the alarm that you want to test.
2. Select the action you want to test.
   
   Make sure that you select the alarm and not the detector.
3. Click and hold down the Test Action button.

The alarm response appears on the published layout object as long as you hold the Test Action button down.

**Configuring Global Alarms**

Global alarms allow a GPI or periodic trigger to cause an action that is not specific to any particular layout, and therefore stays present even when the multiviewer’s layout is changed. Layout Designer must be connected to a multiviewer to configure and view global alarms.

Global alarms are only available when Layout Designer is connected to a Multiviewer.

To configure global alarms, from the toolbar select Rules > Global Alarms.
The Global Alarm Detectors dialog box opens:

At any time, you can disable or enable an alarm, or delete the alarm from the system, using the buttons in the bottom left corner of the screen.

**Creating an Alarm**

1. Enter a name in the *Alarm Name* field, and then choose *Or* or *And*, and click *Add*.
   The alarm name appears in the *Alarm Name* listing.
2. Choose at least one alarm detector, and define the settings for that detector.
   The available detectors for Global Alarms are as follows:

<table>
<thead>
<tr>
<th>Detector</th>
<th>Configurable Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI</td>
<td><strong>Input number</strong> – The input on which the GPI is connected</td>
</tr>
<tr>
<td>SNMP Virtual GPI</td>
<td><strong>Delay</strong> – Time between the GPI data being received and the action being triggered</td>
</tr>
</tbody>
</table>

3. Click *Select Actions*.
The Global Alarms Action dialog box opens:

4. Select at least one action to be triggered on this detector from the Global Alarm Actions list:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Setting Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change layout</td>
<td>Switches the active layout on the multiviewer, while keeping any other alarms active.</td>
<td>Layout Name - Select the layout to change to.</td>
</tr>
<tr>
<td>Change Salvo</td>
<td>Change to the selected salvo that was created in a salvo editor (Requires SDNO and a Magellan Control Panel).</td>
<td>Salvo Name - Select the salvo to change to.</td>
</tr>
<tr>
<td>Fire GPO</td>
<td>Activates a GPO. (This function requires a HV-GPIO-24E connected to your multiviewer)</td>
<td>GPO number - Choose the GPO that is activated</td>
</tr>
<tr>
<td>Log Message</td>
<td>Adds a predefined message to the system log, which is located in the alarm section of the logging server. See Enabling Alarm Logging (on page 115) for configuration.</td>
<td>Message - a predefined message that is sent to the system log in the alarm section of the logging server Logging Priority - the level of the alarm -- info, warning, performance, error, critical, or fatal</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td>Setting Options</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Router Switch</td>
<td>Triggers an input’s switch to a specific router level and destination (Requires SDNO and a Magellan Control Panel).</td>
<td><strong>Input</strong> - Specific input to be switched&lt;br&gt;<strong>Output</strong> - Destination to be taken&lt;br&gt;<strong>Level</strong> - Level to be taken</td>
</tr>
<tr>
<td>Send email</td>
<td>Sends an Email with pre-written text to a specific recipient.</td>
<td><strong>Recipient Address</strong> - email address that will receive a pre-defined email at this trigger&lt;br&gt;<strong>Subject</strong> - Title of the mail to be sent&lt;br&gt;<strong>Message Body</strong> - contents of the email to be sent</td>
</tr>
<tr>
<td>Send SMS Txt Msg</td>
<td>Sends a text message to a phone.</td>
<td><strong>10 digit phone number</strong> - Phone that will receive automated text message at this trigger&lt;br&gt;<strong>Wireless Carrier</strong> - Cell phone carrier’s email address suffix&lt;br&gt;<strong>Txt Msg Body</strong> - Contents of the text message to be sent</td>
</tr>
</tbody>
</table>

5. Click **OK** to save the alarm and close the **Global Alarms** dialog box.

By default all global alarms are activated.

**Configuring Layout Events and Global Events**

Layout events and global events are not necessarily associated with an alarm action.

- A layout event is configured per layout. When it is created, it is available to the current layout only.
- A global event is configured per multiviewer. It is available to all layouts on the multiviewer.

Global and layout events are only available when Layout Designer is connected to a Multiviewer.

**Creating an Event**

1. From the toolbar, choose Rules > **Layout Events** or Rules > **Global Events**.
An Event Configuration dialog box opens.

You can also open the Layout Event Configuration dialog box from the Layout property pane.

2. Enter a descriptive title for the event in the Event Name field, and then choose either Non-Scheduled or Scheduled.

You can use a Non-scheduled event as an action triggered by an event in an alarm. Scheduled events can be configured to fire one time only or on a periodic basis.

3. Click Add.

The new event is added as a new row in the Layout Events or Global Events table.

4. Add the remaining necessary data in the new event’s row in the Layout Events or Global Events table.

Depending on the type of event, the following data may be necessary:
- If your event is non-scheduled, no more data is necessary in the Layout Events section of the screen.
- If your event is scheduled and one-time, enter a date and time for the event to commence in the Layout Events table.
- If your event is scheduled and periodic, in addition to a start date and start time, enter an end date and an end time, and choose the days of the week for the event to take place on.

For scheduled events, beside Time Zone Offset, choose the time zone the change will take place in.

5. To add actions that will be triggered by the selected event, click on an action in the left field, and then click > to add actions to the event.

You can remove actions from the list on the right by clicking <.

If your event is a global event, in addition to the actions listed in Creating an Alarm (on page 236), the following actions are available:
- **Cycling Layouts** — Select the names of the layouts you want to include in the cycle. Select these layouts in the order you want them to appear. Selected items in the sequence display a number to indicate their position in the sequence. Also select the number of the display the layout will be cycled on.

- **Cycling Salvos** — From the drop-down menu, select the salvo or salvos you want to cycle.

If your event is a layout event, the action list contains all the alarms in [Setting Alarm Actions](#) (on page 229), except for the Set InfoPanel Alarm State action.

6. Complete the **Action Parameters** section for each action added.

   See [Setting Alarm Actions](#) (on page 229) for information on all the actions and their parameters.

7. Click **OK** to save the events and close the **Layout Event Configuration** dialog box.

### Deleting Events

To delete a single event:

In the **Events Configuration** screen, select the row in the Layout Events table that represents the event you want to delete.

1. Click **Remove an Event**.

To delete all events, in the **Events Configuration** screen, click **Remove all Events**.

### Info Panels

An Info Panel is a group of data items that are stored in the library to be added as a block to a PiP or Window. You can add info panels to your layout to display data and/or alarms, and use the **Info Panel** tab of the **Properties** pane to define the data and the data source that will be provided on the info panel.

Your layout must be in an **unlocked** state to add, move, or delete info panels. You can adjust properties of an info panel in a locked layout. See [Locking and Unlocking Layouts](#) (on page 159).

Info panels can be added to the Info Panels tab of the Library panel if they are free-standing. If an info panel is attached to a PiP or a window and that PiP or window is added to the Library panel, the info panel is added as part of that layout object.

### Adding Info Panels to a Layout

Info panels that are added from the toolbar to a layout appear initially with no data. Once you have added an info panel, you can define the specific data to be included.

To add an info panel to your layout:

1. Select **Insert > Info Panel**.
If a PiP is selected, the info panel will appear attached to the PiP. If no PiP is selected, the panel will float free. If the info panel is an independent layout object (not attached to a PiP), you can drag it on top of a PiP.

A Snap to PiP message will appear if the info panel can be attached to the PiP. Each PiP can have one info panel. The Snap to PiP message will not appear if a PiP already has an info panel attached to it. Nor will it appear if the info panel is not hovered over a PiP.

You can also add an info panel by dragging and dropping from the Info Panels library, or by dragging and dropping a window or PiP that contains an info panel from the Windows or PiPs library. Info panels added to a layout in this way bring any configuration with them.

**Modifying Info Panel Properties**

Each info panel has a set of individual properties that define its appearance and behavior, and which PiP it applies to in the layout.

To view an info panel’s properties, select the info panel in the layout canvas, and then select the Info Panel tab of the Properties pane.

**Naming the Info Panel**

Each info panel has a unique name that identifies it in the layout when it is associated with a PiP.

To name an info panel:

1. Select an info panel indicator in the layout.
2. Select the Info Panel tab on the Properties pane.
3. In the Details area, type a name for the info panel in the Name field.

**Resizing and Moving an Info Panel**

The Position & Size area of the Info Panel Properties is for information only.

To modify info panel size and position:

1. If the info panel is attached to a PiP or a window, right-click on the info panel and select Info Panel > Enable Resizing Info Panel.
   
   If the info panel is not attached to a PiP or window, this step is neither available nor necessary.
2. Select and drag the info panel, or a corner or side of the info panel.
Info panels do not have to cover a portion of the PiP to maintain a relationship with the PiP.

**Note:** You can also drag a window or PiP that an info panel is part of. The info panel will move with any object it is attached to.

The **Left Position** value is the number of pixels from the left edge of the layout. The **Top Position** value is the number of pixels from the top edge of the layout.

If the info panel is free-floating (not connected to a PiP), as you drag it over a PiP a message **Snap to PiP x** will appear.

Only one info panel can be attached to a PiP. If the PiP already has an info panel attached, the **Snap to PiP x** message will not appear.

To move an info panel off a PiP:
1. Right-click the PiP that contains an info panel.
2. Select **Info Panel > Move Out.**
3. Click **Ok.**

You can now drag the info panel away from the PiP and drop it on another PiP, or treat it as an independent layout object.

To delete an info panel from a layout:
- If the info panel is attached to a PiP, right-click the PiP and select **Info panel > Remove.**
- If the info panel is part of a locked window, right click on the window and deselect **Lock Window.** Then right-click on the window again and select **Info panel > Remove.** Then right-click on the window again and select **Lock parent window.**
- If the info panel is free-standing, select the info panel and then press the **Delete** key.

**Setting Info Panel States**

You can assign different colors, behaviors, and alarm conditions to the indicators that are part of an info panel. The **Presence** info panel state determines the color of an indicator for CC, Teletext, and VChip rating. There are also three alarm states (**Alarm Low**, **Alarm Medium**, and **Alarm High**). You can create the following settings for each info panel state:

- **Primary color** The primary color represents the color of the indicator for the level of the alarm.

To set info panel indicator states:
1. Select an info panel indicator in the layout.
2. Select the **Info Panel** tab on the **Properties** pane.
3. In the **States** area, click **Edit Info Panel Colors.**
The **Info Panel States** dialog box appears.

4. To select the label text color, click the [ ] icon to open the **Select a Color** dialog box.

5. To select a color, do one of the following:
   - Use the slider to select a color.
   - Enter the color values you want to use in one of the **ScRGB**, **sRGB**, or **Hexadecimal Notation** fields.

   Your selected color is previewed below **Selected Color**. If required, use the **Opacity** slider to adjust the color's opacity value.

   For more information on completing the Color Selector dialog box, see **Setting Default Window Properties** (on page 142).

6. Click **OK**.

**Setting the Info Panel Source**

In the Info Panel Source area, there are two options:

- **Use Source** Select this option if you want the info panel to always display the same source.
- **Track Source of PiP** Select this option if the info panel is assigned to a PiP, and you want it to provide data for the info panel.

   By default, the PiP to which the info panel is snapped (if it is snapped to a PiP) will be the tracked source. To change the source PiP, enter a number in the field.

**Note:** if you move out an info panel from a PiP and assign it to another PiP, the assigned source will automatically be the PiP the info panel is snapped to.

**Setting Info Panel Indicators**

In order for an alarm to appear for a PiP state, you need to do two things:

- Configure an alarm detector for that PiP in the PiP's **Alarms** Property page
- Configure a "Set InfoPanel Alarm State" action for that alarm

The Info Panel Indicators area contains the following options.
### Alarms and Info Panels

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format Change</td>
<td>Alarm</td>
<td>Indicates that the video input format has deviated from its defined standard</td>
</tr>
<tr>
<td>EDH Error</td>
<td>Alarm</td>
<td>Reports recurring EDH errors in the standard definition video signal</td>
</tr>
<tr>
<td>CRC Error</td>
<td>Alarm</td>
<td>Indicates that the internally calculated CRC value is different from the received CRC value</td>
</tr>
<tr>
<td>Video Lost</td>
<td>Alarm</td>
<td>Indicates that the multiviewer hardware can no longer detect a video signal from the video channel</td>
</tr>
<tr>
<td>Video Freeze</td>
<td>Alarm</td>
<td>Indicates that the input video image is frozen (static) according to user-defined frozen picture delay (duration), percent of frozen video in the frame, and amount difference between pixels percent tolerance</td>
</tr>
<tr>
<td>Video Black</td>
<td>Alarm</td>
<td>Indicates that the input video image is considered a black picture according to user-defined percentage non-black picture, delay (duration), and black level threshold values</td>
</tr>
<tr>
<td>A. Ch Missing</td>
<td>Alarm</td>
<td>Indicates that the audio channel is not present in the signal</td>
</tr>
<tr>
<td>A. Ch Peak</td>
<td>Alarm</td>
<td>Indicates that the input audio level of the audio channel is at or above the set upper threshold dB values for the user-defined period of time</td>
</tr>
<tr>
<td>A. Ch Low</td>
<td>Alarm</td>
<td>Indicates that the input audio level of the audio channel is at or below the set lower threshold dB values for the user-defined period of time</td>
</tr>
<tr>
<td>A. Ch Silence</td>
<td>Alarm</td>
<td>Indicates that the input audio level of the audio channel is at or below the set silence threshold dB value for the user-defined period of time</td>
</tr>
<tr>
<td>A. Grp (1–4) Missing</td>
<td>Alarm</td>
<td>Indicates that the specified audio group is not present in the signal</td>
</tr>
<tr>
<td>Audio Format</td>
<td>Alarm</td>
<td>Indicates that the audio format has switched from Dolby D, Dolby E, or PCM, or indicates any format change</td>
</tr>
<tr>
<td>Dolby E Program</td>
<td>Alarm</td>
<td>Indicates that the Dolby program format has deviated from the one specified</td>
</tr>
<tr>
<td>CC Missing</td>
<td>Alarm</td>
<td>Indicates that closed captioning (can be HD or SD) is not present in the incoming video stream</td>
</tr>
<tr>
<td>CC Update</td>
<td>Alarm</td>
<td>Indicates that closed captioning is not updating correctly in the incoming video stream</td>
</tr>
<tr>
<td>CC Invalid</td>
<td>Alarm</td>
<td>Indicates that the closed captioning data in the incoming video stream is not usable</td>
</tr>
<tr>
<td>VChip Missing</td>
<td>Alarm</td>
<td>Indicates that there is no V-chip data in the incoming video stream</td>
</tr>
<tr>
<td>VChip Mismatch</td>
<td>Alarm</td>
<td>Indicates that the V-chip data in the incoming video stream does not match the expected rating</td>
</tr>
<tr>
<td>Teletext Missing</td>
<td>Alarm</td>
<td>Indicates that there is no teletext in the incoming video stream</td>
</tr>
</tbody>
</table>
### Alarms and Info Panels

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teletext Update</td>
<td>Alarm</td>
<td>Indicates that the teletext data in the incoming video stream is frozen</td>
</tr>
<tr>
<td>Teletext Invalid</td>
<td>Alarm</td>
<td>Indicates that the teletext data in the incoming video stream is not usable</td>
</tr>
<tr>
<td>VITC Missing</td>
<td>Alarm</td>
<td>Indicates that there is no VITC in the incoming video stream</td>
</tr>
<tr>
<td>WSS Missing</td>
<td>Alarm</td>
<td>Indicates that WSS is not present in the incoming video (should be present in SD625 only)</td>
</tr>
<tr>
<td>WSS Format</td>
<td>Alarm</td>
<td>Indicates that the WSS information has changed from the selected format</td>
</tr>
<tr>
<td>AFD Missing</td>
<td>Alarm</td>
<td>Indicates that AFD data is not present in the incoming video</td>
</tr>
<tr>
<td>AFD Format</td>
<td>Alarm</td>
<td>Indicates that the AFD information has changed from the selected format</td>
</tr>
<tr>
<td>GPI</td>
<td>Alarm</td>
<td>Indicates that a GPI input has been triggered; requires HV-GPIO24E</td>
</tr>
<tr>
<td>SNMP VGPI</td>
<td>Alarm</td>
<td>Indicates that a GPI trigger has been received through SNMP</td>
</tr>
<tr>
<td>Any Alarm</td>
<td>Alarm</td>
<td>Indicates that any tally connected to any other alarm has been triggered</td>
</tr>
<tr>
<td>Any Video</td>
<td>Alarm</td>
<td>Indicates that any of the alarms in the Video section of the list (above) have been triggered</td>
</tr>
<tr>
<td>Any Audio</td>
<td>Alarm</td>
<td>Indicates that any of the alarms in the Audio section of the list (above) have been triggered</td>
</tr>
<tr>
<td>CC</td>
<td>Indicator</td>
<td>Indicates that closed captioning is present, indicates whether it is 608 or 708 captioning, and indicates, in the case of 708 closed captioning, the service the closed captioning comes from (service 1–7)</td>
</tr>
<tr>
<td>VChip</td>
<td>Indicator</td>
<td>Indicates the V Chip rating</td>
</tr>
<tr>
<td>Teletext</td>
<td>Indicator</td>
<td>Indicates that Teletext data is present</td>
</tr>
<tr>
<td>Audio Mon(1/2 )</td>
<td>Indicator</td>
<td>Indicates which audio pair is being monitored. (Needs to be enabled in the info panel in order for it to be displayed when the audio monitor is enabled.)</td>
</tr>
<tr>
<td>Video Format</td>
<td>Indicator</td>
<td>Indicates the video format currently being input to the PiP.</td>
</tr>
<tr>
<td>Audio Type</td>
<td>Indicator</td>
<td>Shows the type of audio. Options include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PCM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Dolby D</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Dolby E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• No audio</td>
</tr>
<tr>
<td>Last Alarm</td>
<td>Indicator</td>
<td>Shows the name of the last alarm that was triggered.</td>
</tr>
</tbody>
</table>
### Alarms and Info Panels

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Time</td>
<td>Indicator</td>
<td>Shows the date (month/day) and time when the last alarm was triggered. It updates to show a different alarm if a different alarm is triggered, but if the same alarm is triggered more than once in sequence, then it shows the first time that alarm was triggered.</td>
</tr>
</tbody>
</table>

When you add indicators one at a time, they are added in the order you click them, from the top left corner on down, first filling the left side of the panel, and then starting again at the top right corner.

If the info panel is attached to a PiP when you add indicators, the indicators will always size themselves so that all indicators will fit within the boundaries of the PiP.

If the info panel is free-standing, the indicators will appear at the default size, and will fill first the left side of the info panel, then the right side. If the info panel is too small to fit all the indicators, the extras for which there is no space will pile on top of one another in the middle.

**Info Panel Attached to a PiP in a Layout**

If the info panel is free-standing, you can move indicators around by clicking on them and dragging within the borders of the info panel. If the info panel is connected to a PiP, right click on the PiP and choose **Info Panel > Unlock Info Panel Items**. You can now drag indicators within the boundaries of the info panel. Clicking outside the boundaries of the info panel locks the indicators in their new positions. When an info panel is unlocked, each info panel indicator can be resized individually.

When the layout is published to the multiviewer and an indicator is triggered, that indicator will appear on the layout. When no indicator is triggered, no indicators appear on the layout.

**Using the Scoreboard Option**

Imagine Communications Multiviewers can accept one Daktronics RTD input.

Before you can use the scoreboard option, you need to configure the multiviewer to receive the data. See **Setting Up External Devices** (on page 111).

To add a scoreboard to your info panel, first choose an option from the drop-down menu at the top of the InfoPanel Indicators list. Options include:
• **No Scoreboard**—The Indicators list shows no scoreboard options.

• **Football**—The Indicators list displays all normal options, plus the football scoreboard options.

<table>
<thead>
<tr>
<th>Scoreboard Data (Football)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Game Clock Time</td>
</tr>
<tr>
<td>Home Team Name</td>
</tr>
<tr>
<td>Guest Team Name</td>
</tr>
<tr>
<td>Home Team Score</td>
</tr>
<tr>
<td>Guest Team Score</td>
</tr>
<tr>
<td>Quarter</td>
</tr>
<tr>
<td>Ball On</td>
</tr>
</tbody>
</table>

• **Basketball**—The Indicators list displays all normal options, plus the basketball scoreboard options.

<table>
<thead>
<tr>
<th>Scoreboard Data (BasketBall)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Game Clock Time</td>
</tr>
<tr>
<td>Game Clock Status</td>
</tr>
<tr>
<td>Shot Clock Time</td>
</tr>
<tr>
<td>Home Team Score</td>
</tr>
<tr>
<td>Guest Team Score</td>
</tr>
<tr>
<td>Home Team Fouls</td>
</tr>
<tr>
<td>Guest Team Fouls</td>
</tr>
</tbody>
</table>

Scoreboard information can also be displayed as part of a label. See Setting the Label Text Source (on page 208) for more information.

You can only display one sport’s scoreboard data at a time on the multiviewer.

### Setting Info Panel Metadata Options

In the Info Panel Metadata area, there are several options, as described below. To choose an option, click its check box. To configure the metadata information, click the option’s text. Options appear below the Info Panel Metadata.

<table>
<thead>
<tr>
<th>Metadata Option</th>
<th>Function</th>
<th>Options</th>
</tr>
</thead>
</table>
| **CC**          | Displays EIA608 and/or EIA708 closed captioning | **HD Source:** Service 1–7, CC 1–4, T 1–4  
**SD Level:** CC 1–4, T 1–4  
**SD Service Option:** Line 12, 21–22, Auto  
If you choose the line you expect the service to be on and the service is not on that line, it will not display. If you choose Auto, the metadata will display regardless of the line it is on. |
<table>
<thead>
<tr>
<th>Metadata Option</th>
<th>Function</th>
<th>Options</th>
</tr>
</thead>
</table>
| **Teletext**    | Displays WST or OP 47 teletext | Page: 000–999  
Service Option: Line 6–22, Auto  
If you choose the line you expect the service to be on and the service is not on that line, it will not display. If you choose Auto, the metadata will display regardless of the line it is on. |
| **VITC**        | Displays vertical interval timecode from SD sources and DVITC when embedded in the HD source | Type: VITC 1, VITC 2  
Service Option: Line 6–22, Auto  
If you choose the line you expect the service to be on and the service is not on that line, it will not display. If you choose Auto, the metadata will display regardless of the line it is on. |
| **Dolby E**     | Displays the select Dolby E’s program information if Dolby E is present in the audio stream | Display Details: Low, Medium, High; see Configuring Dolby E Monitoring (on page 254)  
Program: Select which program to monitor on the info panel (select from 1–8; you can only display two programs at a time)  
Audio Pairs: The pair that will be displayed; options are 1/2, 3/4, 5/6, 7/8, 9/10, 11/12, 13/14, 15/16, Disable (default) |
| **WSS**         | Displays the embedded WSS (Widescreen Signalling) format | Service Option: The line (ranges from 6-23 or Auto) where WSS data should appear on your incoming video  
If you choose the line you expect the service to be on and the service is not on that line, it will not display. If you choose Auto, the metadata will display regardless of the line it is on. |
<p>| <strong>AFD</strong>         | Displays the embedded AFD (active format description) format | - None - |
| <strong>IP Stream Info</strong> | Displays PIP information for Compressed video over IP (CIP) only. See Adding IP Stream Info (on page 253). | - None - |
| <strong>BBC SCTE 104</strong> | Displays presence of a SCTE 104 | Message: Each option has various sub-options. |</p>
<table>
<thead>
<tr>
<th>Metadata Option</th>
<th>Function</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>trigger</td>
<td></td>
<td>• Sub timing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Control</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Length</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Psp count</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Boundary</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Timescale</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Timestamp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Timeline Id</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Psp flags</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Prog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Psp dog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Active</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Psp info</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• UID length</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• UID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Progname Length</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Progname</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Psp revision</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Count</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Psp ident</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Site</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Infrastructure</td>
</tr>
</tbody>
</table>

Check **Enable Metadata Indicators** when you need to adjust the position of metadata from its default location on the info panel. If the indicator is unchecked, the location of the repositioned indicator is lost since it is removed from the object. When checked, the multiviewer shows the indicators without losing the position of the indicators when they are enabled again.
Setting Metadata Display Options

To adjust the options of a metadata element, click on that element in the Info Panel Metadata area of the Info Panel Properties pane.

You can make the following metadata configurations for each Info Panel.

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Color</td>
<td>The background color for the selected metadata element</td>
</tr>
<tr>
<td>Text Size</td>
<td>• Small</td>
</tr>
<tr>
<td></td>
<td>• Medium</td>
</tr>
<tr>
<td></td>
<td>• Large</td>
</tr>
<tr>
<td>Text Position</td>
<td>• Top - Places the metadata at the top of the screen, regardless of where it will actually appear when broadcast</td>
</tr>
<tr>
<td></td>
<td>• Normal - (CC and Teletext only) Places the metadata as defined in the metadata to display it as it appears when broadcast</td>
</tr>
<tr>
<td></td>
<td>• Middle - (VITC, DolbyE, WSS, and AFD only) Places the metadata in the middle of the screen, regardless of where it will actually appear when broadcast</td>
</tr>
<tr>
<td></td>
<td>• Bottom - Places the metadata at the bottom of the screen, regardless of where it will actually appear when broadcast</td>
</tr>
<tr>
<td>Enable Metadata Display</td>
<td>When enabled, shows the actual metadata on the info panel display</td>
</tr>
</tbody>
</table>

Configuring Closed Captioning as Part of an Info Panel’s Metadata

Various types of closed captioning need to be configured differently in order to display correctly on the multiviewer.

To monitor OP-47 teletext from an SD source:

1. On the info panel, in the Metadata section, select Teletext.
2. In the Teletext settings below the Metadata list, select the page. This is normally 801.
To monitor OP-47 teletext from an HD source:
1. On the info panel, in the Metadata section, select Teletext.
2. In the Teletext settings below the Metadata list, select the page.
   This is normally 801.

Line selection is not used since the OP-47 Teletext data packet is auto detected in the HD VANC using the DID and SDID data identification.

To monitor EIA608 from an SD source:
1. On the info panel, in the Metadata section, select CC.
2. In the CC settings below the Metadata list, beside SD, select the desired closed captioning or text service.

To monitor EIA708 from an HD source:
1. On the info panel, in the Metadata section, select CC.
2. In the CC settings below the Metadata list, beside HD, select the desired service.

The EIA708 data packet is auto detected in the HD VANC using the DID and SDIS data identification.

To monitor EIA608 from an HD source:
1. On the info panel, in the Metadata section, select CC.
2. In the CC settings below the Metadata list, beside HD, select CC 1-4 or text service T 1-4.
### Configuring AFD and WSS Monitoring

The following figure explains how multiviewers display the various AFD and WSS options. WSS is relevant for SD625 only.

<table>
<thead>
<tr>
<th>16:9 Frame</th>
<th>AFD</th>
<th>4:3 Frame</th>
<th>AFD</th>
<th>WSS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&gt;16:9</td>
<td></td>
<td>&gt;16:9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Full Frame</td>
<td></td>
<td>14:9 Top</td>
<td>16:9 Top</td>
</tr>
<tr>
<td></td>
<td>4:3 Center</td>
<td></td>
<td>16:9 Top</td>
<td></td>
</tr>
<tr>
<td></td>
<td>16:9 Protected</td>
<td></td>
<td>14:9 Center</td>
<td></td>
</tr>
<tr>
<td></td>
<td>16:9 Alt 14:9</td>
<td></td>
<td>16:9 Alt 14:9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10:9 Alt 14:9</td>
<td></td>
<td>Full Alt 14:9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>16:9 Alt 4:3</td>
<td></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>16:9 Top</td>
<td></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>14:9 Top</td>
<td></td>
<td>16:9 Anamorphic</td>
<td></td>
</tr>
</tbody>
</table>
Adding IP Stream Info

This release of EPIC MV provides a low-verbosity info panel of IP Stream info for Compressed IP video (CIP).

The text appears overlaid on the video when this metadata option is chosen, and displays the following information:

- **Program number**: Selected MPEG2-TS program number from the PMT table.
  MPEG2-TS elementary PID, "elementary_PID" in decimal format.

- **Video codec**: Options include:
  - MPEG-2
  - AVC/H.264

- **Video Format**: Short form of the format.

- **Audio codec**: Elementary stream codec name, options include:
  - Dolby AC3
  - MPEG4/AAC
  - MPEG-1 Layer-2 Audio

- **Audio**: More verbose elementary stream codec description. Options include:
  - AVC ITU-T H.264 | ISO/IEC 14496-10
  - ISO/IEC 14496-3 Audio with the LAT M transport syntax
  - MPEG-1 Audio Layer II | ISO/IEC 11172-3
Audio Details

Audio Channel Configuration that provides more details of the decoded stream in the following format:

<Number of non-LFE channels>.<Number of LFE channels>

Options include:

- 5.0
- 5.1
- 2.0

The three rows of audio can repeat for primary, secondary audio channels, etc. up to three.

Closed captioning is not available for IP Stream info for this release. To view the status of captioning, use a CC indicator instead. See Using Compressed Video (on page 54) for information on configuring Compressed video, and Channel Numbering and Naming Conventions for PIPs (on page 193) for information on selecting PIP sources.

Configuring Audio Monitoring

Audio monitoring is via embedded audio on EPIC™ MV.

Configuring Dolby E Monitoring

Note: The multiviewer detects and displays the presence of Dolby D audio, but does not show the audio ballistics or program information on info panels.

These figures show the various displays available. The table below describes the items that appear in the different levels of Dolby E display.

|-------------------------|--------------------------|----------------------------------|------------------|----------------------------------------|

Dolby E High Level Detail Display

|-------------------------|--------------------------|----------------------------------|------------------|----------------------------------------|

Dolby E Medium Level Detail Display

|-------------------------|--------------------------|----------------------------------|------------------|----------------------------------------|

Dolby E Low Level Detail Display

<table>
<thead>
<tr>
<th>Dolby E 8 Channels 5.1+2</th>
</tr>
</thead>
</table>

Dolby E Display Description Items and the Detail Levels They Appear In

<table>
<thead>
<tr>
<th>Function</th>
<th>High</th>
<th>Medium</th>
<th>Low</th>
<th>Example Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program description text</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Dolby E 8 channels</td>
</tr>
<tr>
<td>Program configuration</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>5.1+2</td>
</tr>
<tr>
<td>Function</td>
<td>High</td>
<td>Medium</td>
<td>Low</td>
<td>Example Text</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------</td>
<td>--------</td>
<td>-----</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Channel designators</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>• [5.1]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• [2]</td>
</tr>
<tr>
<td>Audio Coding mode</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>3/2 (See <a href="#">Dolby Audio Coding Modes</a> (on page 258))</td>
</tr>
<tr>
<td>Dialogue level</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Dial=-31 dB</td>
</tr>
<tr>
<td>Bitstream mode</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Bit=Voice Over (See <a href="#">Dolby Line Mode and RF Mode Options</a> (on page 259) for a complete list of supported options)</td>
</tr>
<tr>
<td>Low Frequency Effect mode</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>LFE (only displays when enabled)</td>
</tr>
<tr>
<td>Line mode profile</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>LM=FilmS (See <a href="#">Dolby Line Mode and RF Mode Options</a> (on page 259) for a complete list of supported options)</td>
</tr>
<tr>
<td>RF mode profile</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>RF=FilmS (See <a href="#">Dolby Line Mode and RF Mode Options</a> (on page 259) for a complete list of supported options)</td>
</tr>
</tbody>
</table>

### Mapping a Dolby E Program to Audio Meters

The Dolby Program options are as follows:

#### Dolby E Program

<table>
<thead>
<tr>
<th>Dolby E Program Configuration and Description</th>
<th>Mapping of Dolby Program to Audio Meter Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 One 5.1 channel program</td>
<td>Left Front  Right Front  Centre  LFE (Sub)  Left Surround  Right Surround</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1  2  3 4  5  6</td>
</tr>
<tr>
<td>5.1 + 2 One 5.1 channel and one stereo program</td>
<td>Left Front  Right Front  Centre  LFE (Sub)  Left Surround  Right Surround  Left Aux  Right Aux</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1  2  3 4  5  6  7  8</td>
</tr>
<tr>
<td>5.1 + 2 x 1 One 5.1 channel and two mono programs</td>
<td>Left Front  Right Front  Centre  LFE (Sub)  Left Surround  Right Surround  Mono 1  Mono 2</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1  2  3 4  5  6  7  8</td>
</tr>
<tr>
<td>Dolby E Program Configuration and Description</td>
<td>Mapping of Dolby Program to Audio Meter Channel</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>4 + 4 Two four channel programs</td>
<td>Audio Meter Number 1 2 3 4 7 8 5 6</td>
</tr>
<tr>
<td>4 + 2 x 2 One four channel and two stereo programs</td>
<td>Audio Meter Number 1 2 3 4 7 8 5 6</td>
</tr>
<tr>
<td>4 + 2 + 2 x 1 One four channel, one stereo and two mono programs</td>
<td>Audio Meter Number 1 2 3 4 7 8 5 6</td>
</tr>
<tr>
<td>4 + 4 x 1 One four channel and four mono programs</td>
<td>Audio Meter Number 1 2 3 4 7 8 5 6</td>
</tr>
<tr>
<td>4 x 2 Four stereo programs</td>
<td>Audio Meter Number 1 2 7 8 3 4 5 6</td>
</tr>
<tr>
<td>3 x 2 + 2 x 1 Three stereo and two mono programs</td>
<td>Audio Meter Number 1 2 7 8 3 4 5 6</td>
</tr>
<tr>
<td>2 x 2 + 4 x 1 Two stereo and four mono programs</td>
<td>Audio Meter Number 1 2 7 8 3 4 5 6</td>
</tr>
<tr>
<td>2 + 6 x 1 One stereo and six mono channels</td>
<td>Audio Meter Number 1 2 7 8 3 4 5 6</td>
</tr>
<tr>
<td>Dolby E Program Configuration and Description</td>
<td>Mapping of Dolby Program to Audio Meter Channel</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>8 x 1 Eight mono programs</td>
<td>Mono 1  Mono 2  Mono 3  Mono 4  Mono 5  Mono 6  Mono 7  Mono 8</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1    2    3    4    5    6    7    8</td>
</tr>
<tr>
<td>4 + 2 One four channel program and one two channel program</td>
<td>Left  Right  Centre  Surround  Left  Right</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1    2    3    4    7    8</td>
</tr>
<tr>
<td>4 + 2 x 1 One four channel and two mono programs</td>
<td>Left  Right  Centre  Surround  Mono 1  Mono 2</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1    2    3    4    7    8</td>
</tr>
<tr>
<td>3 x 2 Three stereo programs</td>
<td>Left Ch 1  Right Ch 1  Left Ch 2  Right Ch 2  Left Ch 3  Right Ch 3</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1    2    7    8    3    4</td>
</tr>
<tr>
<td>2 x 2 + 2 x 1 Two stereo and two mono programs</td>
<td>Left Ch 1  Right Ch 1  Left Ch 2  Right Ch 2  Mono 1  Mono 2</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1    2    7    8    3    4</td>
</tr>
<tr>
<td>2 + 4 x 1 One stereo and four mono programs</td>
<td>Left Ch 1  Right Ch 1  Mono 1  Mono 2  Mono 3  Mono 4</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1    2    7    8    3    4</td>
</tr>
<tr>
<td>6 x 1 Six mono channel program</td>
<td>Mono 1  Mono 2  Mono 3  Mono 4  Mono 5  Mono 6</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1    2    7    8    3    4</td>
</tr>
<tr>
<td>4 One four channel program</td>
<td>Left  Right  Centre  Surround</td>
</tr>
<tr>
<td>Audio Meter Number</td>
<td>1    2    3    4</td>
</tr>
<tr>
<td>2 + 2 Two stereo programs</td>
<td>Left Ch 1  Right Ch 1  Left Ch 2  Right Ch 2</td>
</tr>
</tbody>
</table>
### Dolby E Program Configuration and Description

<table>
<thead>
<tr>
<th>Audio Meter Number</th>
<th>1</th>
<th>2</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
</table>
| 2 + 2 x 1          | One stereo and two mono programs
| Audio Meter Number | 1 | 2 | 7 | 8 |
| 4 x 1              | Four mono programs
| Audio Meter Number | 1 | 2 | 3 | 4 |
| 7.1 Screen         | One 7.1 screen channel program
| Audio Meter Number | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 |

**Note:** If an info panel calls for a Dolby E program that does not exist on the input, the first Dolby E program information will be displayed instead. For example, if a layout calls for program number 3 and the input has a 2-program Dolby E program configuration of 5.1+2, the multiviewer will display the first program information, program 1.

### Dolby Audio Coding Modes

<table>
<thead>
<tr>
<th>Audio Coding Mode</th>
<th>Channel Ordering</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/0</td>
<td>C</td>
</tr>
<tr>
<td>2/0</td>
<td>L, R</td>
</tr>
<tr>
<td>3/0</td>
<td>L, C, R</td>
</tr>
<tr>
<td>2/1</td>
<td>L, R, S</td>
</tr>
<tr>
<td>3/1</td>
<td>L, C, R, S</td>
</tr>
<tr>
<td>2/2</td>
<td>L, R, Ls, Rs</td>
</tr>
<tr>
<td>3/2</td>
<td>L, C, R, Ls, Rs</td>
</tr>
</tbody>
</table>
Dolby Line Mode and RF Mode Options

Line mode and RF mode are two types of dynamic range control, which determine how the audio is decoded at the playback device.

- Line mode is typically used on decoders with six- or two-channel line-level outputs.
- RF mode is used on decoders that have an RF-remodulated output.

Both Line mode and RF mode have the options listed below:

### Multiviewer Display

<table>
<thead>
<tr>
<th>Dolby Option</th>
<th>Multiviewer Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>FilmS</td>
<td>Film, Standard mode</td>
</tr>
<tr>
<td>FilmL</td>
<td>Film, Light mode</td>
</tr>
<tr>
<td>MusicS</td>
<td>Music, Standard mode</td>
</tr>
<tr>
<td>MusicL</td>
<td>Music, Light mode</td>
</tr>
<tr>
<td>Speech</td>
<td>Speech</td>
</tr>
</tbody>
</table>

### Bitstream Mode Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete Main</td>
<td>Flags the bitstream as the main audio service for the program with all elements to form a complete audio program; may contain from one (mono) to six (5.1) channels</td>
</tr>
<tr>
<td>Music and Effects</td>
<td>Normally the main audio service for the program, minus a dialogue channel (different dialogue services associated with a single ME service can support multiple languages)</td>
</tr>
<tr>
<td>Visually Imp.</td>
<td>• A single-channel containing a narrative description of the picture content to be decoded along with the main audio service or • A complete mix of all program channels, comprising up to six channels</td>
</tr>
<tr>
<td>Hearing Imp.</td>
<td>• A single-channel program containing audio that has been processed for increased intelligibility to be decoded along with the main audio service or • A complete mix of all program channels, comprising up to six channels</td>
</tr>
<tr>
<td>Option</td>
<td>Function</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Dialogue  | Provides a dialogue channel for a Music and Effects service  
  • If the Music and Effects service contains more than two channels, the Dialogue service is limited to one channel  
  • If the Music and Effects service is two channels, the Dialogue service can be a stereo pair  
  The appropriate channels of each service are mixed together (requires special decoders) |
| Commentary| An optional single-channel dialog program intended to convey additional commentary (may also be a complete mix of all program channels, comprising up to six channels)                                        |
| Emergency | A single-channel service that is given priority in the decoder (the main service is muted when this service is present)                                                                                 |
| Voice Over| A single-channel service intended to be decoded and mixed to the Center channel (requires special decoders)                                                                                           |
| Karaoke   | The Left and Right channels contain music, the Center channel has a guide melody, and the Left and Right Surround channels carry optional backing vocals                                           |
FAQs

This section has answers to the following questions:

How Do I Access the Components Within my PiP? .......................................................... 261
Can I Store and Recall PiP Properties? .............................................................................. 261
Why Can’t I Close All the Layouts? .................................................................................... 261
What is the Behavior of the Undo Feature? ......................................................................... 262

How Do I Access the Components Within my PiP?

If you cannot edit or alter the components within a PiP, this is usually because the components are locked.

To unlock the window, do one of the following:

• Right-click on the window and clear Lock Window.
• In the Windows tab of the Properties pane, clear Lock Objects in Window.

Can I Store and Recall PiP Properties?

If you spend a lot of time creating a PiP, you can use it for other PiP windows.

1. After you have created a window, right-click on the window, and then select Add Window to Library.

It will appear at the bottom of the Library panel under the Windows section.

1. Rename a window in the Library by double-clicking on the label under its preview image.
2. To populate more of these windows onto your layout, simply drag and drop them onto the layout page.
3. Set the input source by clicking on the "I" icon in the middle of the window.

Why Can’t I Close All the Layouts?

You cannot close the first layout that opens when Layout Designer starts; it always stays open in Layout Designer.
What is the Behavior of the Undo Feature?

You cannot undo the following functions:

- Saving a layout
- Publishing a layout
- Downloading a layout
- Closing a layout
- Deleting a layout
- Unlocking a window
- Locking and restoring factory default for PiPs, windows, borders, and border styles

All other functions can be undone.
Using the Multiviewer Web Interface

You can use the Multiviewer Web interface to perform the following functions:

- Add users and control their access to aspects of the device
- Choose layouts on a display
- Change the source of PiPs in a layout
- Import and edit labels in a layout
- View a PiP in full screen mode
- Select an audio source for audio monitoring (not available in software release 1.1)

If your browser does not have Silverlight installed, when you enter the IP address for the Multiviewer, a page opens with a link to install Silverlight. Follow this link to download the installer, and then follow the instructions that appear on the screen.

If the PC does not have a valid Internet connection, download the installer from http://silverlight.net/getstarted/silverlight3/.

Starting the Multiviewer Web Interface

To start using the Multiviewer Web interface, follow these steps:

1. Type the Multiviewer’s IP address in your internet browsing software.
   A Login dialog box appears.
2. Enter your login ID and password.
   The default login ID is Admin, and there is no password associated with this login ID.
3. Click OK.
A screen similar to the following appears:

4. In the **Displays** section at the right of the screen, choose the display you would like to view.

The main portion of the screen updates to show the layout that is currently assigned to that screen.

At the top of the screen, drag the slider to the left and the right to make the layout larger and smaller, or click **Fit** to adjust the layout to the available screen area.

You can view any PiP as full-screen on the Multiviewer by clicking **Toggle Full Screen**. Return to the normal layout display by clicking the same button again.

---

### Controlling User Access to the Multiviewer Web Interface

1. In the multiviewer’s Web Access screen, click **Settings**.
   
   It's in the panel on the right of the screen.
The **Settings Dialog** opens.

2. Under **User List**, click **Add**.
   A row is added in the **User List** table.
3. In the **User Name** field, enter a name.
4. In the **Password** field, enter a password for this user, and then enter the same password in the **Confirm Password** field.
5. For each display available at this IP address, place a check if you want this user to have access. (Scroll to the right to see all the displays).
   Two other options are also available on a per-user basis:
   - **Enable Control**—Allows this user to control the selected displays. When unchecked, the user can view displays but not alter labels, PiP sources, etc.
   - **Allow Settings**—Gives this user administrative privileges.
6. Click **OK**.
Choosing a Layout

Under **Layouts** in the right of the screen, click the drop-down menu to choose a layout.

**Display Layout**—Sends the selected layout to the Multiviewer.

**Preview Layout**—displays a preview of the selected layout on the Multiviewer Web interface screen.

Changing PiP Sources in a Layout

You can change the source for any PiP.

1. Click **Select PiP Source** on the PiP.
2. Choose a new source from the menu that appears.
Importing and Editing Label Text

When you select the Label properties pane option External Update (External Number) for a label in Layout Designer, the label can receive data from the Multiviewer Web interface.

1. On the Multiviewer Web interface, click Import File.

   The Label Updates dialog box appears.

   ![Label Updates Dialog Box]

2. Click Import Label File, and then browse to the location of the *.csv file.

   *.csv files can be created in Microsoft Excel. Your Excel file will normally have four columns, with contents to match the above figure, and a row for each label.

3. Click OK to import the label file.

   The table updates to display all label text.

   To make any necessary changes to the content of the label file, you can click in a field and then type new data.

   Data in the table needs to be in the following format:

<table>
<thead>
<tr>
<th>Column</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address</td>
<td>The IP address of the Multiviewer</td>
</tr>
<tr>
<td>Display Number</td>
<td>The number of the display that the label appears on</td>
</tr>
<tr>
<td>Column</td>
<td>Contents</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Label Number</td>
<td>The number set by the label properties</td>
</tr>
<tr>
<td>Message</td>
<td>The text that appears in the label</td>
</tr>
</tbody>
</table>

If you build the data in another program, columns of data should be separated by commas, and each row of data should end in a carriage return.

4. Click **Update All Labels** to update the layout as it is displayed on the Multiviewer Web interface.
5. Click **OK** to close the **Label Updates** dialog box.
6. On the main Multiviewer Web interface, click **Update Labels** to send the changes to the Multiviewer display.

## Editing Label Text Manually

1. On the main Multiviewer Web interface screen, click a label.
2. Enter text using a standard keyboard.

Click **Update Labels** to send the changes to the Multiviewer display.
UMD/Tally Option

The EPIC™ MV offers optional under monitor display (UMD) support. This option provides a protocol interface (via RS-232, RS-422, RS-485, or TCP/IP) to different third-party UMD/tally generator systems in order to display UMD source identification and tally status information. This information automatically updates on-screen when it is changed by the tally system.

Image Video protocol colors map to the alarm states. Other tally systems that do not support color are mapped to the tally system color.

Requirements for Optional UMD Support

The following items and installations are required to implement UMD support:

- A device that can generate UMD/Tally commands, for example, a UMD generator, production switcher, or router. The EPIC™ MV supports TSL V3, V4, and V5 UMD protocol over TCP/IP and UDP, and Ross protocol, D-Series protocol, and a core subset of the Image Video protocol (not full protocol) on TCP/IP.
- One of the following cable connections:
  - RS-232 cable connection between the serial port and a UMD/tally device
  - TCP/IP connection between a multiviewer and a UMD/tally device

See Sample System Configurations for wiring diagrams.

Configuring UMD Data

Regardless of where UMD and tally information comes from, the receiving item must be configured correctly in Layout Designer. Typically, UMD (Under Monitor Display) data contains the address, label and tally information and it is used to identify the PIP source name and the status of current condition. In EPIC™ MV, the UMD data can come from either of the following locations:

- Input source names defined by the Navigator/SDNO application
- An external protocol

With destination UMDs, if the video source to the PIP changes, the label or tally associated with the PIP remains static.
With Source UMDs, the UMD data changes when the video source to the PIP changes. An external UMD device sends the appropriate UMD data to update the EPIC™ MV.

Data Flow for Source UMD Updates

To complete the configuration, you need to set the following:

- **Tally State Source**: UMD/Tally System (Fixed UMD addr)
- **Border State Source**: UMD/Tally System (Fixed UMD)
- **Label Text Source**: UMD/Tally System (Source UMD)

### Configuring TSL ASCII UMD Protocol

EPIC™ MV supports TSL V3, V4, and V5 UMD protocol over TCP/IP and UDP. TSL UMD protocol is configured in the **External Communication** tab of Layout Designer’s **Advanced Configuration** dialog box.

1. Under **Type**, choose **TSL Protocol**.
2. Under **Port**, choose the COM Port that TSL communication will be received through.
3. Under COM, make the following selections:
   - **Baud rate**: 38400 bits/second
   - **Data bits**: 8
   - **Parity**: even
   - **Stop (bits)**: 1

4. Click **Add**.

---

### Configuring Image Video UMD Protocol

The EPIC™ MV supports a core subset of the Image Video Protocol. The TSI-1000 Image Video Tally Controller collects information from signal routing and processing equipment to operate displays and tallies as directed by its internal configuration information.

To activate this option, in the **Advanced Configuration** window of Layout Designer, select the **External Devices** tab.

1. Under **Type**, choose **Image Video Tally**.
2. Under **Port**, choose the COM Port that communication will be received through.
   - For RDU-1000 serial format, those settings should be:
     - **Baud rate**: 9600 bits/second
     - **Data bits**: 7
     - **Parity**: Even
     - **Stop bits**: 2
   - For RDU-1510 serial format:
     - **Baud rate**: programmable to 300, 600, 1200, 2400, 4800, 9600, 19200, or 38400 baud
     - **Data bits**: 7
     - **Parity**: Even
     - **Stop bits**: 2
4. Click **Add**.

To create labels:

Syntax: `%(Addr) D%1S(strings) %Z`

- **#D**: 1~255 (UMD Address)
- **String**: <display string up to 17 characters>
- **%Z**: Terminator

**Color Block Coding**

<table>
<thead>
<tr>
<th>First</th>
<th>Second</th>
<th>Third</th>
<th>Fourth</th>
<th>Fifth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text color</td>
<td>Set tally 0</td>
<td>Set tally 1</td>
<td>Set tally 2</td>
<td>Set tally 3</td>
</tr>
</tbody>
</table>
Configuring TSL v3, v4, and v5 over TCP/IP

TSL V3, V4 and V5 protocol over TCP/IP with the EPIC™ MV being the TCP/IP server.

1. From the main menu, select **Tools > Advanced Configuration**.
2. From the **Type** menu, select **TSL Protocol** for V3, or **TSL V4** or **TSL V5**.
3. From the **Port** menu, select **TCP/IP_S**.
4. Beside **IP Port**, enter the port number.
5. With TSL v5, EPIC™ MV supports following the protocol UMD and tally color information. To configure it, on the **Tally Properties** pane, select **Edit Tally Colors**.
   - On the **Alarm Low** tab, beside **Primary Color**, select **Green**.
   - On the **Alarm Medium** tab, beside **Primary Color**, select **Amber**.
   - On the **Alarm High** tab, beside **Primary Color**, select **Red**.
Troubleshooting

Making a Snapshot of your Outputs

To enable snapshots on your EPIC™ MV, in the Settings file, find the row Enable Snapshot Hotkey. Enable it.

To make a snapshot, on the keyboard attached to EPIC™ MV, click Alt+Shift+S.

It takes a snapshot of each monitor and saves them as discrete files.

This can be useful for troubleshooting with Customer Service.

Network Adapter Shows DHCP

Even after being configured with static IP addresses, when you look at your Network Properties, you may find that some network adapters indicate they are configured using DHCP. This is a false report.

CAUTION

The procedure described on the Microsoft website involves editing the registry. When editing the registry, you can potentially damage your windows install if you make an error, and then you will need to reinstall or repair Windows.

Also, the problem might persist.

After configuring Static IP addresses, to see an accurate representation of what the control, PIP sharing and other streaming NICs have for IPv4 properties, open a command prompt and type

```
ipconfig/all
```

to see the real values.

---

Performance Issues While Remote Monitoring iLO

Remote monitoring of iLO may cause performance issues with EPIC™ MV.

For best results, limit your use of remote iLO access while EPIC™ MV is on-air.

---

Could not Set Process Affinity Mask Error

If Kayak Server fails to start the EPIC™ MV blueprint and exits indicating it could not set process affinity mask, make the following change to your BIOS settings:

Under **Performance Options > Advanced Performance Tuning Options**, set NUMA to Flat processing group.

See [BIOS Settings](#) (on page 62) for more information.
# Environmental Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Temperature range</strong>*</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>10°C to 35°C (50°F to 95°F)</td>
</tr>
<tr>
<td>Non-operating</td>
<td>-30°C to 60°C (-22°F to 140°F)</td>
</tr>
<tr>
<td><strong>Relative humidity (non-condensing)</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>Minimum to be the higher (more moisture) of -12°C (10.4°F) dew point or 8% relative humidity Max to be 24°C (75.2°F) dew point or 90% relative humidity</td>
</tr>
<tr>
<td>Non-operating</td>
<td>5% to 95% 38.7°C (101.7°F), maximum wet bulb temperature</td>
</tr>
</tbody>
</table>

* All temperature ratings shown are for sea level. An altitude derating of 1.0°C per 304.8 m (1.8°F per 1000 ft) to 3048 m (10,000 ft) is applicable. No direct sunlight allowed. Maximum rate of change is 20°C per hour (36°F per hour). The upper limit and rate of change might be limited by the type and number of options installed.

For certain approved hardware configurations, the supported system inlet temperature range is extended:

- 5°C to 10°C (41°F to 50°F) and 35°C to 40°C (95°F to 104°F) at sea level with an altitude derating of 1.0°C per every 175 m (1.8°F per every 574 ft) above 900 m (2953 ft) to a maximum of 3048 m (10,000 ft).
- 40°C to 45°C (104°F to 113°F) at sea level with an altitude derating of 1.0°C per every 410 ft above 900 m (2953 ft) to a maximum of 3048 m (10,000 ft).


**Note:** In order to satisfy the radio interference regulations, a bead (P/N 103-100005Q00) is required on the DisplayPort cable at the Server end close to the connector."
EPIC-MV-DISP Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPU Memory</td>
<td>8 GB GDDR5</td>
</tr>
<tr>
<td>Memory Interface</td>
<td>256-bit</td>
</tr>
<tr>
<td>Memory Bandwidth</td>
<td>192 GB/s</td>
</tr>
<tr>
<td>NVIDIA CUDA® Cores</td>
<td>1664</td>
</tr>
<tr>
<td>System Interface</td>
<td>PCI Express 3.0 x16</td>
</tr>
<tr>
<td>Max Power Consumption</td>
<td>120 W</td>
</tr>
<tr>
<td>Thermal Solution</td>
<td>Active</td>
</tr>
<tr>
<td>Form Factor</td>
<td>4.4” H × 9.5” L, Single Slot, Full Height</td>
</tr>
<tr>
<td>Display Connectors</td>
<td>4x DP 1.2</td>
</tr>
<tr>
<td>Max Simultaneous Displays</td>
<td>4 direct, 4 DP 1.2 Multi-Stream</td>
</tr>
<tr>
<td>Max DP 1.2 Resolution</td>
<td>4096 × 2160 at 60 Hz</td>
</tr>
<tr>
<td>Max VGA Resolution</td>
<td>2048 × 1536 at 85 Hz</td>
</tr>
</tbody>
</table>

Server Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>8.73 cm (3.44 in)</td>
</tr>
<tr>
<td>Depth (chassis with SFF drive cage)</td>
<td>67.94 cm (26.75 in)</td>
</tr>
<tr>
<td>Width</td>
<td>44.54 cm (17.54 in)</td>
</tr>
<tr>
<td>Weight (maximum—all SFF drives)*</td>
<td>14.7 kg (32.6 lb)</td>
</tr>
</tbody>
</table>

* The SFF configuration includes the following components:
  • SDD drive (2)
  • Drive blanks (6)
  • Drive bay blanks for bays 1 and 2 (2)
  • Fan assemblies (4)
  • Fan blanks (2)
  • Low-profile heatsink with extra fans and increased airflow (1)
  • 1P air baffle (1)
  • X8 HP Flexible Smart Array Controller (1)
  • Primary riser cage (1)
  • Secondary riser cage (1)
  • Power supply (1)
  • Power supply blank (1)
  • Cables for the above components
## Power Supply Specifications

- **HPE 800W Flex Slot Platinum Hot-plug Power Supply**

For detailed power supply specifications, see the Quick Specs on the HPE website (http://www8.hp.com/us/en/products/power-supplies/index.html#view=column&page=1).

### HPE 800W Flex Slot Platinum Hot-plug Power Supply

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input requirements</strong></td>
<td></td>
</tr>
<tr>
<td>Rated input voltage</td>
<td>100 to 120 VAC</td>
</tr>
<tr>
<td></td>
<td>200 to 240 VAC</td>
</tr>
<tr>
<td></td>
<td>240 VDC for China only</td>
</tr>
<tr>
<td>Rated input frequency</td>
<td>50 Hz to 60 Hz</td>
</tr>
<tr>
<td>Rated input current</td>
<td>9.4 A at 100 VAC</td>
</tr>
<tr>
<td></td>
<td>4.5 A at 200 VAC</td>
</tr>
<tr>
<td></td>
<td>3.8 A at 240 VDC</td>
</tr>
<tr>
<td>Maximum rated input power</td>
<td>940 W at 100 VAC</td>
</tr>
<tr>
<td></td>
<td>900 W at 200 VAC</td>
</tr>
<tr>
<td>BTUs per hour</td>
<td>3207 at 100 VAC</td>
</tr>
<tr>
<td></td>
<td>3071 at 200 VAC</td>
</tr>
<tr>
<td><strong>Power supply output</strong></td>
<td></td>
</tr>
<tr>
<td>Rated steady-state power</td>
<td>800 W at 100 VAC to 120 VAC input</td>
</tr>
<tr>
<td></td>
<td>800 W at 200 VAC to 240 VAC input</td>
</tr>
<tr>
<td>Maximum peak power</td>
<td>800 W at 100 VAC to 120 VAC input</td>
</tr>
<tr>
<td></td>
<td>800 W at 200 VAC to 240 VAC input</td>
</tr>
</tbody>
</table>

### Hot-plug Power Supply Calculations

For hot-plug power supply specifications and calculators in order to determine system electrical and heat loading, see the HPE Power Advisor section at https://www.hpe.com/us/en/integrated-systems/rack-power-cooling.html#Portfolio.
EPIC-MV-UCIP Specifications

SFP Interfaces

10GbE Fiber Interface

<table>
<thead>
<tr>
<th>Item</th>
<th>LR Specification</th>
<th>SR Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>LC</td>
<td>LC</td>
</tr>
<tr>
<td>Standard</td>
<td>10GBASE-LR</td>
<td>10GBASE-SR</td>
</tr>
<tr>
<td>Wave-length</td>
<td>1310 nm</td>
<td>850nm</td>
</tr>
<tr>
<td>Signal reach</td>
<td>10 km</td>
<td>400 m</td>
</tr>
<tr>
<td>Data Rate</td>
<td>10.3125Gbps</td>
<td>10.3125Gbps</td>
</tr>
</tbody>
</table>

10GbE Electrical Interface

<table>
<thead>
<tr>
<th>Item</th>
<th>Published Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>SFP+ Direct Attach</td>
</tr>
<tr>
<td>Standard</td>
<td>10GBase-CR</td>
</tr>
<tr>
<td>Signal reach</td>
<td>7 m</td>
</tr>
<tr>
<td>Data Rate</td>
<td>10.3125Gbps</td>
</tr>
</tbody>
</table>

SFI Electrical Interface

SFI Electrical Interface should meet SFF-8431 "Specifications for Enhanced Small Form Factor Pluggable Module SFP+".

PCle Interface

PCle electrical interface should meet "PCI_Express_Base_Specification_Revision_3.0.pdf".

OP+SFP+TRSM+10G

Specifications for OP+SFP+TRSM+10G Single Mode Optical Transceiver

<table>
<thead>
<tr>
<th>Transmitter</th>
<th>Minimum</th>
<th>Typical</th>
<th>Maximum</th>
<th>Unit</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laser OMA Output Power</td>
<td>-5.2</td>
<td></td>
<td></td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Laser Mean Output Power</td>
<td>-8.2</td>
<td>+0.5</td>
<td></td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Laser Off Power</td>
<td></td>
<td>-30</td>
<td></td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Extinction Ratio</td>
<td>3.5</td>
<td></td>
<td></td>
<td>dB</td>
<td>1</td>
</tr>
<tr>
<td>Transmitter and Dispersion Penalty (TDP)</td>
<td>3.2</td>
<td>dB</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Center Wavelength | 1260 | 1355 | nm | 1
Optical Return Loss Tolerance | 12 | dB | 1

### Receiver

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Minimum</th>
<th>Typical</th>
<th>Maximum</th>
<th>Unit</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiver Sensitivity (OMA)</td>
<td></td>
<td></td>
<td>-12.6</td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Stressed Receiver Sensitivity (OMA)</td>
<td></td>
<td></td>
<td>-10.3</td>
<td>dBm</td>
<td>1,2</td>
</tr>
<tr>
<td>Receiver Power Overload</td>
<td></td>
<td></td>
<td>+0.5</td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Receiver Reflectance</td>
<td></td>
<td></td>
<td>-12</td>
<td>dB</td>
<td>1</td>
</tr>
<tr>
<td>Center Wavelength</td>
<td>1260</td>
<td>1355</td>
<td>nm</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Vertical Eye Closure Penalty</td>
<td>2.2</td>
<td></td>
<td>dB</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Stressed Eye Jitter</td>
<td>0.3</td>
<td></td>
<td>Ulp-p</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>RX_LOS (OMA) Assert</td>
<td>-17</td>
<td></td>
<td>dBm</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>RX_LOS (OMA) De-Assert</td>
<td>-30</td>
<td></td>
<td>dBm</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>RX_LOS (OMA) Hysteresis</td>
<td>0.5</td>
<td></td>
<td>dB</td>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

1. IEEE 802.3ae Clause 52 compliant
2. Measured with worst ER; BER<1E-12; 2E31-1 PRBS
3. Vertical eye closure and stressed eye jitter are test conditions for stressed sensitivity (OMA) measurement.
4. Loss of Signal (LOS) detection responds only to OMA and the indicator will respond unpredictably with the application of unmodulated optical power.

---

### OP+SFP+TRMM+10G

**Specifications for OP+SFP+TRMM+10G Multi Mode Optical Transceiver**

#### Transmitter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Minimum</th>
<th>Typical</th>
<th>Maximum</th>
<th>Unit</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laser OMA Output Power</td>
<td>-4.3</td>
<td></td>
<td></td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Laser Mean Output Power</td>
<td>-1.0</td>
<td></td>
<td></td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Laser Off Power</td>
<td>-30</td>
<td></td>
<td></td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Extinction Ratio</td>
<td>3.0</td>
<td></td>
<td></td>
<td>dB</td>
<td>1</td>
</tr>
<tr>
<td>Transmitter and Dispersion Penalty (TDP)</td>
<td>3.9</td>
<td></td>
<td></td>
<td>dB</td>
<td>1</td>
</tr>
<tr>
<td>Center Wavelength</td>
<td>840</td>
<td>860</td>
<td>nm</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Optical Return Loss Tolerance</td>
<td>12</td>
<td></td>
<td>dB</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
### Receiver Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Minimum</th>
<th>Typical</th>
<th>Maximum</th>
<th>Unit</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiver Sensitivity (OMA)</td>
<td>-11.1</td>
<td>-</td>
<td>-</td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Stressed Receiver Sensitivity (OMA)</td>
<td>-7.5</td>
<td>-</td>
<td>-</td>
<td>dBm</td>
<td>1,2</td>
</tr>
<tr>
<td>Receiver Power Overload</td>
<td>-1.0</td>
<td>-</td>
<td>-</td>
<td>dBm</td>
<td>1</td>
</tr>
<tr>
<td>Receiver Reflectance</td>
<td>-12</td>
<td>-</td>
<td>-</td>
<td>dB</td>
<td>1</td>
</tr>
<tr>
<td>Center Wavelength</td>
<td>840</td>
<td>860</td>
<td>860</td>
<td>nm</td>
<td>1</td>
</tr>
<tr>
<td>Vertical Eye Closure Penalty</td>
<td>3.5</td>
<td>-</td>
<td>-</td>
<td>dB</td>
<td>3</td>
</tr>
<tr>
<td>Stressed Eye Jitter</td>
<td>0.3</td>
<td>-</td>
<td>-</td>
<td>Ulp-p</td>
<td>3</td>
</tr>
<tr>
<td>RX_LOS (OMA) Assert</td>
<td>-12</td>
<td>-</td>
<td>-</td>
<td>dBm</td>
<td>4</td>
</tr>
<tr>
<td>RX_LOS (OMA) De-Assert</td>
<td>-30</td>
<td>-</td>
<td>-</td>
<td>dBm</td>
<td>4</td>
</tr>
<tr>
<td>RX_LOS (OMA) Hysteresis</td>
<td>0.5</td>
<td>-</td>
<td>-</td>
<td>dB</td>
<td>4</td>
</tr>
</tbody>
</table>

1. IEEE 802.3ae Clause 52 compliant
2. Measured with worst ER; BER<1E-12; 2E31-1 PRBS
3. Vertical eye closure and stressed eye jitter are test conditions for stressed sensitivity (OMA) measurement.
4. Loss of Signal (LOS) detection responds only to OMA and the indicator will respond unpredictably with the application of unmodulated optical power.

### SEL+AOC+10G Specifications

#### Specifications for SEL+AOC+10G Optical Direct Attach Cable

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>SFF-8431, SFF-8472</td>
</tr>
<tr>
<td>Connector</td>
<td>SFF-8432, SFP+ card-edge</td>
</tr>
<tr>
<td>Cable length</td>
<td>10 meters</td>
</tr>
<tr>
<td>Bit Error Ratio (BER)</td>
<td>1E-15, tested with 2E31 – 1 PRBS</td>
</tr>
<tr>
<td>Power</td>
<td>3.3V</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>&lt; 1 Watt each cable end</td>
</tr>
<tr>
<td>Case Operating Temperature Range</td>
<td>0°C to 70°C</td>
</tr>
<tr>
<td>Compliance</td>
<td>RoHS-6 compliant (lead-free)</td>
</tr>
</tbody>
</table>
### Table 1: Video Input Specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector type</td>
<td>HD-BNC</td>
</tr>
<tr>
<td>Number of inputs</td>
<td>12</td>
</tr>
<tr>
<td>Number of outputs</td>
<td>0¹</td>
</tr>
<tr>
<td>Supported video standards</td>
<td>720x576i25 1920x1080p50</td>
</tr>
<tr>
<td></td>
<td>720x480i29 1280x720p60</td>
</tr>
<tr>
<td></td>
<td>1280x720p50 1920x1080p30</td>
</tr>
<tr>
<td></td>
<td>1280x720p59 1920x1080p29</td>
</tr>
<tr>
<td></td>
<td>1920x1080p23 1920x1080p59</td>
</tr>
<tr>
<td></td>
<td>1920x1080i25 1920x1080p24</td>
</tr>
<tr>
<td></td>
<td>1920x1080p25 1920x1080i30</td>
</tr>
<tr>
<td></td>
<td>1920x1080i29 1920x1080p60</td>
</tr>
<tr>
<td>Impedance</td>
<td>75 Ohms</td>
</tr>
<tr>
<td>Return loss</td>
<td>-15dB (0 ~ 1.5GHz) -10dB (1.5GHz ~ 3GHz)</td>
</tr>
<tr>
<td>Signal level</td>
<td>800 mV ± 10%</td>
</tr>
<tr>
<td>Max input cable</td>
<td>400 meters up to 270Mbps</td>
</tr>
<tr>
<td></td>
<td>150 meters up to 1.5Gbps</td>
</tr>
<tr>
<td></td>
<td>100 meters up to 3Gbps</td>
</tr>
</tbody>
</table>

¹ For current release.
# Index

## A

- About Alarm Templates • 231
- About Labels • 207
- About Layout Clocks • 211
- About Layout Objects • 130
- About Up/Down Counters • 214
- Activating and Modifying Scrolling Properties • 210
- Active Sessions Overview • 65
- Adding a Switch as a Device • 81
- Adding and Removing Hardware Components • 34
- Adding Audio Meters to a Layout • 201
- Adding Clocks to a Layout • 211
- Adding Counters to a Layout • 215
- Adding Destinations • 82
- Adding Devices Manually • 106
- Adding External Devices • 110
- Adding Info Panels to a Layout • 239
- Adding IP Stream Info • 252
- Adding Layout Objects from the Library Panel to a Layout • 147
- Adding Layout Objects to a Layout • 170
- Adding Layout Objects to the Library Panel • 146
- Adding Multiviewers to a Router Database • 86
- Adding Objects to the Library Panel • 146
- Adding Output Modules by Polling • 86
- Adding PiPs to a Layout • 188
- Adding Sources for your Channels • 83
- Adding Tally Indicators to a Layout • 204
- Adding the Multiviewer to the Layout Designer Devices List • 90
- Advanced Configuration • 107
- Alarms and Info Panels • 218
- Alarms and the Events that Trigger Them • 219
- Aligning and Distributing Objects in a Layout • 176
- Anti-Virus, Monitoring, & Third-Party Software • 59
- Application Menus • 116
- Applying an Alarm Template to a Layout Object • 233
- Applying Borders Using the Properties Pane • 183
- Assembly Kit Required • 38
- Assigning Input and Output Triggers in Layout Designer • 100
- Audience • 10
- Automatic Updates • 60

## B

- Back Panel • 19
- Back Panel LEDs • 20
- Back View • 19
- Binding UMD Addresses to Input Sources • 112
- BIOS Settings • 61
- Breaking Apart a Window • 180

## C

- Can I Store and Recall PiP Properties? • 260
- Capture the WIM Image • 58
- CCS Navigator and Magellan Remote Control Systems • 28
- Center Riser Assembly • 43
- Changing PiP Sources in a Layout • 265
- Channel Numbering and Naming Conventions for PiPs • 192
- Choosing a Counter Style • 216
- Choosing a Layout • 265
- Choosing a PiP Display Mode (PiP Sources Only) • 193
- CIP Share Config File • 53
- Cloning Layout Objects • 174
- Closing Layout Designer • 103
- Configuring AFD and WSS Monitoring • 251
- Configuring Audio Monitoring • 253
- Configuring Closed Captioning as Part of an Info Panel's Metadata • 249
- Configuring Counter Functionality • 216
- Configuring Dolby E Monitoring • 253
- Configuring E-Mail Settings • 141
- Configuring EPIC MV Output Display Devices • 108
- Configuring General Layout Properties • 140
- Configuring Global Alarms • 234
- Configuring Image Video UMD Protocol • 270
- Configuring JLCooper eBOX in Layout Designer • 98
- Configuring Layout Events and Global Events • 237
Configuring Multiple Multiviewers to Multiple JLCooper eBoxes • 100
Configuring Multiviewers in a Local Area Network • 89
Configuring Multiviewers in Database Editor • 87
Configuring Network Time Protocol (NTP) • 113
Configuring Salvos for use in Layout Designer • 88
Configuring the Multiviewer to share JLCooper eBoxes • 99
Configuring TSL ASCII UMD Protocol • 269
Configuring TSL v3, v4, and v5 over TCP/IP • 271
Configuring UMD Data • 268
Configuring UMD names • 88
Connecting Layout Designer to a Multiviewer • 161
Connecting Multiple EPIC™ MVs • 50
Connecting to SDNO • 91
Connecting to SDNO Controller • 110
Connecting to the PIP Sharing Network • 50
Consolidating a Window • 180
Contact Information • 2
Controlling a Counter Using SNMP or Magellan Control Panel • 217
Controlling User Access to the Multiviewer Web Interface • 263
Controlling Your Multiviewer on a Network • 92
Copying and Pasting Layout Object Properties • 173
Could not Set Process Affinity Mask Error • 273
Creating a New Layout from a Blank Layout • 157
Creating a New Layout Using the Layout Creation Wizard • 151
Creating an Alarm • 235
Creating an Alarm Template • 231
Creating an Event • 237
Creating Audio Meters • 200
Creating Destinations Representing EPIC™ MV Inputs • 88
Creating Layout Windows • 178
Creating New Border Styles • 184
Creating New Layouts • 150
Creating New Windows • 179
Creating Tally Indicators • 203
Customizing the Layout Designer Workspace • 135

D
Defining Alarms for a Layout Object • 222
Defining PiP Names • 197
Deleting Events • 239
Destination Follow • 195
Determining Auto Placement • 139
Determining Software and Firmware Versions • 76
Device Manager Dialog Box • 105
Disconnecting Layout Designer from a Multiviewer • 161
Discovering EPIC™ MV Using Layout Designer • 89
Display Cloning • 110
Display Orientations • 109
Displaying and Opening Layouts Stored on the Multiviewer • 162
Displaying and Publishing Layouts • 162
Dolby Audio Coding Modes • 257
Dolby Line Mode and RF Mode Options • 258
Drawing Grid • 166
Dual 10 GBE LOM with SFP+ Cages • 26

E
Editing Alarm Templates • 233
Editing Label Text Manually • 267
Electrical Grounding Requirements • 31
Electrical Safety Guidelines • 13
Electrostatic Discharge • 14
Enabling Alarm Logging • 113
Environmental Specifications • 274
EPIC-MV-3G • 24
EPIC-MV-3G Specification • 280
EPIC-MV-DISP Display Output Card • 26
EPIC-MV-DISP Specifications • 275
EPIC-MV-UCIP • 23
EPIC-MV-UCIP Specifications • 277
EPIC™ MV Configuration and Control • 75
Ethernet Connections • 26
Extend the Server from the Rack • 33

F
FAQs • 260
Features • 16
Forcing VGA on EPIC™ MV with no VGA Cable Connected • 79
Formatting Layout Objects in the Canvas • 173
Front LEDs and Buttons • 18
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Riser Cage Assembly</td>
<td>37</td>
</tr>
<tr>
<td>SEL+AOC+10G</td>
<td>279</td>
</tr>
<tr>
<td>Selecting a Border for Modification Within a Window</td>
<td>182</td>
</tr>
<tr>
<td>Selecting a Channel for Display on the PIP</td>
<td>192</td>
</tr>
<tr>
<td>Selecting a PiP’s Input Source</td>
<td>191</td>
</tr>
<tr>
<td>Selecting a Tally Indicator Shape</td>
<td>204</td>
</tr>
<tr>
<td>Selecting a VNC Source</td>
<td>196</td>
</tr>
<tr>
<td>Selecting Meter Scale Properties</td>
<td>202</td>
</tr>
<tr>
<td>Server Management Network</td>
<td>62</td>
</tr>
<tr>
<td>Server Specifications</td>
<td>275</td>
</tr>
<tr>
<td>Setting Alarm Actions</td>
<td>228</td>
</tr>
<tr>
<td>Setting Alarm Detector Threshold Values</td>
<td>225</td>
</tr>
<tr>
<td>Setting Analog Clock Format</td>
<td>211</td>
</tr>
<tr>
<td>Setting Audio Meter Appearance Properties</td>
<td>202</td>
</tr>
<tr>
<td>Setting Audio Meter Size and Position</td>
<td>203</td>
</tr>
<tr>
<td>Setting Border Colors</td>
<td>185</td>
</tr>
<tr>
<td>Setting Border Size</td>
<td>185</td>
</tr>
<tr>
<td>Setting Clock Time Reference Source and Time Zone</td>
<td>214</td>
</tr>
<tr>
<td>Setting Default Label Properties</td>
<td>145</td>
</tr>
<tr>
<td>Setting Default Layout Properties</td>
<td>139</td>
</tr>
<tr>
<td>Setting Default PiP Properties</td>
<td>142</td>
</tr>
<tr>
<td>Setting Default Window Properties</td>
<td>141</td>
</tr>
<tr>
<td>Setting Digital Clock Format and Appearance Properties</td>
<td>213</td>
</tr>
<tr>
<td>Setting Factory Default Recall Preferences</td>
<td>138</td>
</tr>
<tr>
<td>Setting General Preferences</td>
<td>138</td>
</tr>
<tr>
<td>Setting Info Panel Indicators</td>
<td>242</td>
</tr>
<tr>
<td>Setting Info Panel Metadata Options</td>
<td>246</td>
</tr>
<tr>
<td>Setting Info Panel States</td>
<td>241</td>
</tr>
<tr>
<td>Setting Like Objects’ Properties</td>
<td>176</td>
</tr>
<tr>
<td>Setting Metadata Display Options</td>
<td>249</td>
</tr>
<tr>
<td>Setting Meter Transition Points</td>
<td>203</td>
</tr>
<tr>
<td>Setting Multiviewer Connection Preferences</td>
<td>138</td>
</tr>
<tr>
<td>Setting Panels and Panes Viewing Options</td>
<td>135</td>
</tr>
<tr>
<td>Setting PiP Cropping Values</td>
<td>191</td>
</tr>
<tr>
<td>Setting Tally States</td>
<td>205</td>
</tr>
<tr>
<td>Setting the Background to the Foreground</td>
<td>166</td>
</tr>
<tr>
<td>Setting the Border State Source</td>
<td>185</td>
</tr>
<tr>
<td>Setting the Default View</td>
<td>139</td>
</tr>
<tr>
<td>Setting the Info Panel Source</td>
<td>242</td>
</tr>
<tr>
<td>Setting the Label Text Source</td>
<td>207</td>
</tr>
<tr>
<td>Setting the Tally State Source</td>
<td>206</td>
</tr>
<tr>
<td>Setting Undo and Redo Levels</td>
<td>138</td>
</tr>
<tr>
<td>Setting Up External Devices</td>
<td>110</td>
</tr>
<tr>
<td>Setting Your Layout Designer Preferences</td>
<td>137</td>
</tr>
<tr>
<td>SFP Interfaces</td>
<td>277</td>
</tr>
<tr>
<td>SFP Removal</td>
<td>48</td>
</tr>
<tr>
<td>Side Riser Assembly</td>
<td>40</td>
</tr>
<tr>
<td>Smart Storage Battery</td>
<td>71</td>
</tr>
<tr>
<td>Software Installation</td>
<td>102</td>
</tr>
<tr>
<td>Space and Airflow Requirements</td>
<td>29</td>
</tr>
<tr>
<td>Specifications</td>
<td>274</td>
</tr>
<tr>
<td>Starting and Stopping the EPIC MV</td>
<td>75</td>
</tr>
<tr>
<td>Starting the Multiviewer Web Interface</td>
<td>262</td>
</tr>
<tr>
<td>Status Overview</td>
<td>65</td>
</tr>
<tr>
<td>Subsystem and device status</td>
<td>66</td>
</tr>
<tr>
<td>Subsystem and device status values</td>
<td>67</td>
</tr>
<tr>
<td>Support Contact Information</td>
<td>2</td>
</tr>
<tr>
<td>Switching Sources to Destination PIPs</td>
<td>84</td>
</tr>
<tr>
<td>System Recovery</td>
<td>58</td>
</tr>
<tr>
<td>System Setup</td>
<td>29</td>
</tr>
<tr>
<td>T</td>
<td></td>
</tr>
<tr>
<td>Temperature Requirements</td>
<td>30</td>
</tr>
<tr>
<td>Testing an Action</td>
<td>234</td>
</tr>
<tr>
<td>Testing an Alarm</td>
<td>234</td>
</tr>
<tr>
<td>To install the Layout Designer software</td>
<td>102</td>
</tr>
<tr>
<td>Tools and Materials Required</td>
<td>39</td>
</tr>
<tr>
<td>Tools Palette</td>
<td>124</td>
</tr>
<tr>
<td>Trademarks</td>
<td>2</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>272</td>
</tr>
<tr>
<td>U</td>
<td></td>
</tr>
<tr>
<td>UMD/Tally Option</td>
<td>268</td>
</tr>
<tr>
<td>Unpacking/Shipping Information</td>
<td>10</td>
</tr>
<tr>
<td>Updating Layout Designer Software</td>
<td>77</td>
</tr>
<tr>
<td>Updating Multiviewer Software and Firmware</td>
<td>76</td>
</tr>
<tr>
<td>Updating nVidia Drivers</td>
<td>78</td>
</tr>
<tr>
<td>Updating Software and Firmware</td>
<td>76</td>
</tr>
<tr>
<td>Using a Blank Layout</td>
<td>158</td>
</tr>
<tr>
<td>Using Compressed Video</td>
<td>53</td>
</tr>
<tr>
<td>Using Objects from the Library Panel</td>
<td>147</td>
</tr>
<tr>
<td>Using the Alarms Property Pane</td>
<td>220</td>
</tr>
<tr>
<td>Using the iLO Web Interface</td>
<td>63</td>
</tr>
<tr>
<td>Using the Layout Creation Wizard</td>
<td>152</td>
</tr>
<tr>
<td>Using the Layout Designer Library Panel</td>
<td>146</td>
</tr>
<tr>
<td>Using the Multiviewer Web Interface</td>
<td>262</td>
</tr>
<tr>
<td>Using the Rules Menu</td>
<td>219</td>
</tr>
<tr>
<td>Using the Scoreboard Option</td>
<td>245</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Video Input Specification</td>
<td>280</td>
</tr>
</tbody>
</table>
Viewing Fan Information • 67
Viewing Firmware Information • 73
Viewing Health Summary Information • 66
Viewing Layout Properties • 164
Viewing Layouts • 159
Viewing Memory Information • 72
Viewing Network Information • 72
Viewing Power Information • 68
Viewing Processor Details • 71
Viewing Software Information • 74
Viewing Storage Information • 73
Viewing System Information • 65
Viewing Temperature Information • 68
Viewing the Device Inventory • 72
Viewing Window Properties • 180

W
Waste from Electrical and Electronic Equipment (WEEE) Directive • 12
What is the Behavior of the Undo Feature? • 261
When No Multiviewers are Connected • 105
Why Can’t I Close All the Layouts? • 260
Working With Groups of Objects • 175
Working with Layout Objects • 168
Working with Layouts • 149
Working with PiPs • 187